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Overview

Introduction

About this manual

This manual is primarily designed for System Administrators and users with victor configuration 
privileges. Only suitably trained personnel should attempt victor installation and configuration 
tasks.

For basic user functionality, refer to the separate victor User Guide.

victor 

victor is part of a powerful NVMS that includes advanced policy management, health monitoring, 
Smart Search, instant playback, and more, ensuring the security and safety of your entire 
organization whether a single site, or a multi-location, globally dispersed enterprise. Use the victor 
site manager to store data, operator profiles, roles, and camera/recorder information.

victor Express

As part of the victor unified client portfolio, victor Express offers the ability to manage video from 
multiple Intellex DVRs, and VideoEdge NVR/Hybrids from a single intuitive interface. By removing 
the site manager requirement which provides more enterprise functionality such as command 
center, access control unification and integrated policy management which is available with victor 
Professional, this Express version of victor provides single site applications a powerful way to 
manage multiple recorders.

Unified Solution

Unification with Software House C·CURE 9000 access control system provides single-point event 
management.
1



Overview  
victor - Key Features
• Advanced integrated policy management to control user level access to all object types

• Robust motion based smart search (Including Thumbnail) uses meta-data to provide fast video 
searching and analysis

• Powerful Edge Analytic Search features (VideoEdge 4.4) includes Face Recognition and Blur 
Detection

• Video Surveillance - H264, ACC, MJPEG and MPEG-4 video simultaneously, De-warping 
support and virtual PTZ

• Maps allow a real time visual representation of physical locations and Alarms

• Control Security Objects directly from Maps

• Conduct Time and Date Searches on up to 10 cameras across multiple recorders

• Built in Analog and Virtual Matrix capability

• Mix Live and recorded video within the same window for real time response

• Intelligent Switch Layout feature enables multiple monitors to quickly change screen layout for 
fast response to situations

• Built in Windows Presentation Foundation (WPF)

• Video Wall allows client workstations to share layout components

• Monitor and Manage system Events and Alarms

• Interface with 3rd Party Devices via the General Purpose Interface

• Configure Bandwidth at system and User level

• Still Image capture with E-Mail/Print/Edit features

• Database Configuration including Journal Filtering, Input Management and Archiving options

• Sites enable logical grouping of victor objects, allowing for a more intuitive management system

• Point of Sale (POS) support (4.4)

• Health Monitoring Dashboard displays the health of all of the devices and associated children 
that are connected to victor. Extends to Maps to enable a full visual overview of system level 
health (4.4)

• C·Cure 9000 Integration provides powerful Events management capability across 2 platforms 
from a single client (4.2)

• Tyco Update Utility allows ‘Push’ software updates from site manager to VideoEdge NVR (4.4)

• Archiving allows for long term storage of media on dedicated NAS devices (4.4)

• Customize Icons within the GUI to more suit your environment (4.4)

• Powerful reporting tools include canned reports, Ad Hoc and graphic visualization of report data 
(4.4)
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Overview
Components

victor client

victor unifies security, surveillance, and event management. From a single interface, you can 
manage live/recorded video from Intellex DVRs, VideoEdge NVRs, and HDVR hybrid recorders.

Unified with Software House C·CURE 9000 access control system, victor provides single-point 
event management across both systems.

victor is designed to handle the high throughput of HD and megapixel cameras and manage real-
time alarms and events. The victor solution scales from a single site to multi-location global 
deployments and simplifies management of large, geographically dispersed security operations.

The victor solution includes advanced policy management, health monitoring, Smart Search, 
instant playback, and more, ensuring the security and safety of your entire organization. Analog 
and IP video and cameras can be displayed simultaneously, all with a common feature set, no 
matter what the codec (H.264, ACC, MJPEG, MPEG-4) allowing you to mix and match 
technologies without toggling between separate client applications.

The intuitive design includes advanced features such as tear off, snap, auto hide, tab, and dock 
windows, providing an easy and customizable operator experience.

An easy-to-use tree structure puts everything at your fingertips. Create and organize camera lists 
from multiple Intellex, HDVR, and VideoEdge recorders (any camera from any recorder) to meet 
the needs of different operators. Build video tours, salvos, and saved views, then organize them 
into victor's customizable and easy-to-use site lists for rapid response.

Motion-based Smart Searches are run on a database of meta-data instead of searching through 
hours or weeks of video. This makes incident investigations incredibly fast and easy. Add 
advanced video analytics to your VideoEdge NVRs to increase situational awareness with alarms 
for trip wire, linger, object removed/abandoned and more.

victor site manager

victor site manager is the brains of the operation - storing data, operator profiles, roles, 
camera/recorder information and access controls.

Dual modes of user authentication allows users to log in using Active Directory credentials or via a 
‘Basic’ method which does not require a domain controller.

Also, using Microsoft Active Directory, operator profiles can be tied to are portable which allows 
users to move from one victor client to another as their credentials follow them, regardless of the 
PC.

Restrict what devices and features an operator can access by assigning roles using victor's 
included policy management. Permissions can be set system wide for a specific camera.

Any feature can be limited and updated as situations warrant. victor also journals and tracks what 
has happened on your systems, such as operator activities, search and export history, creating an 
audit trail.

victor player

victor player is the standalone video player application which can be exported along with digitally-
verified video clips to enable the playback of exported video clips in native format without requiring 
the full installation of the client.
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victor Command Center

The victor Command Center lets you build your own security operation center (SOC). You can 
manage thousands of cameras and multiple locations, creating video walls using standard PCs. 
Video walls are a key component to monitoring large camera counts. Share and communicate 
information between operators and pushing live or recorded video from one monitor to another - to 
ensure rapid response to critical events. You can expand your system by adding victor client and 
agent licenses, to meet the needs of your organization.

victor/C·Cure Integration

The victor/C·CURE 9000 unification provides advanced, seamless integration between victor and 
C·CURE 9000 standalone platforms, allowing users of victor unified client to monitor C·CURE 
devices and events from within the victor interface.

Note

1. The unified solution does not support C·CURE 9000 Enterprise
2. Version Compatibility - C·Cure 9000 Integration requires: C·Cure 9000 v2.1+ and victor v4.2+ 
Refer to the victor and C·CURE Unification Guide for further information.
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Installation

Introduction

Each victor installation is unique. You should therefore carefully plan and design how your system 
is to be implemented. Relationships and dependencies between various elements of the system 
often require specific sequences for configuration and implementation.

Typical tasks are outlined in this document but your AD Integrator should adapt the details and 
sequence of your implementation to suit your needs.

victor site manager, victor client and victor Express are all available from the same DVD.

Client software is freely available and can be installed on as many machines as a site requires. 
Licensing is managed by victor site manager based on the number of concurrent users of victor 
client.

Client software must be installed on every machine on the system. For smaller installations, site 
manager can be hosted on a client PC, for larger installations, it is recommended site manager is 
hosted on a dedicated machine.

If upgrading from a previous version, a new license is required.

The installer program installs all necessary third party software (prerequisites) first then installs the 
selected victor software.

Note

1. Refer to product datasheet for minimum and recommended system requirements.
2. When performing an upgrade, the installation steps may vary from those detailed in the 
following procedures.
3. Upgrades must be performed using the original installer account.
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victor professional

victor professional is the full featured product requiring installation of client and site manager 
software.

victor Express

victor Express is a single computer version of unified client which does not require a separate site 
manager install. It allows operation only over a single computer (No Command Center 
functionality) however it can connect to any number of recorders.

In addition, victor Express client can connect to existing site managers enabling full victor 
functionality.

Note

Note: 
victor Express is supported on Windows XP, Windows 7 and Windows 8.

Change Windows Local Security Policy (Win 7)

You may be required to change the Windows local security settings on the site manager server. 
The following procedure is for the recommended OS - Windows 7, the procedure may vary for 
other operating systems.

Procedure 2-1  
Change Windows Local Security Policy (Win 7)

Step     Action

1 Select Start on the Windows Taskbar.

2 Select Control Panel. The Control Panel displays.

3 Select System and Security.

4 Select Administrative Tools.

5 Select Local Security Policy.

6 Select Local Policies.

7 Select Security options. The Local Security Settings folder displays.

8 Select Network Access: Sharing and Security model for local accounts.

9 Select Classic - Local users authenticate as themselves from the dropdown menu.

10 Select OK.

11 Close open windows.

- End -
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Change Windows Local Security Policy (Win XP)

You may be required to change the Windows local security settings on the site manager server. 
The following procedure is for Windows XP, the procedure may vary for other operating systems.

Procedure 2-2  
Change Windows Local Security Policy (Win XP)

Step     Action

1 Select Start on the Windows Taskbar.

2 Select Control Panel. The Control Panel displays.

3 Select Administrative Tools.

4 Select Local Security Policy.

5 Select Local Policies.

6 Select Security Options. The Local Security Settings folder displays.

7 Select Network Access: Sharing and Security model for local accounts.

8 Select Classic - Local users authenticate as themselves from the dropdown menu.

9 Select OK.

10 Close open windows.

- End -

Installing .NET

If running Windows XP, Microsoft .NET 3.5 or higher must be installed prior to victor installation.

Procedure 2-3  
Installing .NET

Step     Action

1 Insert the victor DVD. If .NET software is not installed, the following dialog will display. 
‘.NET is required to run this software.’

2 Select Yes to install or No to exit. If you select Yes Please wait while Setup configures 
the components dialog displays.

3 Select OK when Install completes.

- End -
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Installation DVD - Overview

The installation disc will autorun when inserted in the DVD drive and the victor install window will 
display.

Procedure 2-4  
Using the Installation DVD

Step     Action

1 Close any Programs currently running.

2 Insert the victor DVD. The victor splash screen displays.

If the DVD does not Autorun:

a Select Start on the Windows taskbar

b Select Computer

c Explore the DVD Drive

d Right click the InstallerSetup.exe file. 

e Select Run as Administrator. The Welcome victor install window displays

3 Select Review Hardware and Software requirements in the Prepare section to view this 
information.

4 The Install section offers the following options:

• victor Express

• victor Professional - site manager to install site manager software

• victor Professional - unified client to install client software
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Note

If installing the client and site manager software on the same machine, it is 
recommended to install site manager first.

5 Select Other Information options to browse DVD and view User Guides.

6 Select Exit to close the window.

- End -

Installing victor Professional - site manager

Note

Ensure your user account has administrator privileges before beginning installation.
Ensure the client and site manager are both installed using the same O/S credentials.
After installing site manager, client software needs to be installed on the machine. This allows 
victor to create an installer account which can then be used to create other victor operators.

For Laptop installations only:
1. Ensure only 1 standard LAN card is enabled.
2. Restart the system
3. Adapters may be re-enabled after installation is complete

victor site manager Professional - prerequisites

Refer to victor site manager prerequisites in  Appendix A: Software Prerequisites for a full list of 
software included in the installation.

CautionCaution

Consult your Information Systems personnel before connecting workstations to your network. 
Ensure you read and understand all of the following instructions before installing site manager. If 
you have any difficulties or questions, contact your dealer or AD technical support.

Procedure 2-5  
Installing victor Professional - site manager

Step     Action

1 Close any programs currently running

2 Insert the victor dvd. The Welcome to victor install window displays
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3 Select victor Professional - site manager in the Install section. Language selector 
dialog displays

Note

Depending on security settings, you may be prompted to allow the installer 
system access.

4 Select the required language from drop down menu

Note

If required, the language pack for the selected language will be automatically 
installed.

5 Select OK. The victor site manager - Installshield Wizard dialog opens displaying 
required prerequisite software

6 Select Install. Prerequisite software will be installed. Once complete, the Welcome to 
victor site manager Setup Wizard dialog displays

7 Select Next. The End User License Agreement (EULA) dialog displays. Read the 
license carefully and select I accept... or I do not accept... as applicable

8 Select Next. The Destination Folder dialog displays. If you wish to change the 
destination folder, select Change and navigate to the required folder

9 Select Next. The Setup Type dialog displays. Select either:

• Typical (All program default features will be installed)

Or

• Custom (To choose which program features you want installed and where they 
will be installed)

Note

Driver services and components not installed or requiring changes at this point 
can later be installed or modified by re-running the site manager installer and 
making different selections. Also driver services which are selected but later are 
no longer required, can be removed by re-running the installer.

10 Select Next. The Database Server dialog displays

11 Select either:

• Use an existing local or remote SQL Server 2008 instance

or

• Install Microsoft SQL Server 2008 R2 Express Edition

12 Select Next. If you chose to use an existing supported SQL instance you will be prompted 
to select the required instance and enter login credentials. If you chose to install a new 
instance of SQL, this will be installed alongside site manager

13 Select Next. The Ready to Install dialog displays

14 Select Install. victor site manager installation begins
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15 On completion, the Setup Wizard Completed dialog displays. Select Finish to exit

Note

The site manager installer automatically starts all services relevant to your 
installation which are licensed and installed

- End -

Installing victor Professional - unified client software

victor Professional - unified client prerequisites

Refer to victor site manager prerequisites for a full list of software included in the installation. As 
well as the listed prerequisites, JAVA and QuickTime are required to view video from VideoEdge 
recorders.

Note

1. It is recommended that you install site manager before installing the client software.
2. The workstation/server you select for the installation of the client software must be connected to 
the same network and using IP addresses in the same range as those chosen for the installation of 
site manager.
3. Install the client software with the same O/S credentials as those used to install site manager.

CautionCaution

Consult your Information Systems personnel before connecting workstations to your network. 
Ensure you read and understand all of the following instructions before installing victor unified 
client. If you have any difficulties or questions, contact your dealer or AD technical support.

Procedure 2-6  
Installing victor Professional - unified client software

Step     Action

Note

Ensure your user account has administrator privileges before beginning 
installation.

1 Close any programs currently running.

2 Insert the victor DVD. The Welcome to victor install window displays

3 Select the victor client software appropriate for your installation in the Install section. The 
Language selector dialog displays
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4 Select the required language from the dropdown menu. Select Yes for UAC if required.

Note

If required, the language pack for the selected language will be automatically 
installed.

5 Select OK. The victor unified client - Installshield Wizard dialog opens displaying 
required prerequisite software

6 Select Install. Prerequisite software will be installed. Once complete, the Welcome to 
victor client Setup Wizard dialog displays

7 Select Next. The End User License Agreement (EULA) dialog displays. Read the 
license carefully and select I accept... or I do not accept... as applicable

8 Select Next. The Destination Folder dialog displays. If you wish to change the 
destination folder, select Change and navigate to the required folder

9 Select Next. The Installation Options dialog displays. To edit whether a component is 
installed or not, select  next to the component and choose the appropriate option

Note

If you wish to install C·Cure 9000 either now or in the future, it is recommended 
that you install the C·Cure component. This can be added later, if required. Refer 
to the C·Cure 9000 Integration Guide for more information.

10 Select Next. The Database Location dialog displays

11 Select Database Location. If the database is remote, provide a server name or IP address 
in the textbox

12 Select Next. The Ready to Install dialog displays

13 Select Install. victor unified client installation begins

14 On completion, the Setup Wizard Completed dialog displays. Select Finish to exit

- End -
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Installing victor Express

victor Express is a single computer version of unified client which does not require a separate site 
manager install. It allows operation only over a single computer (No Command Center 
functionality) however it can connect to any number of recorders.

In addition, victor Express client can connect to existing site managers enabling full victor 
functionality.

Note

You can upgrade victor Express to victor Professional at any time by applying an appropriate 
license.

CautionCaution

victor Express will install successfully only if there are no instances of victor client, victor site 
manager, CCURE, SQL or ADSDK installed
victor Express will upgrade successfully only if a previous version is detected

Procedure 2-7  Installing victor Express

Step     Action

1 Close any programs currently running

2 Insert the victor DVD. The Welcome to victor install window displays

3 Select victor Express in the Install section. Setup Window displays.

4 Select the language for the installation from the dropdown menu.

5 Select Next. Setup Wizard displays.

6 Select Next. The End User License Agreement (EULA) dialog displays. Read the 
license carefully and select I accept... or I do not accept... as applicable

7 Select Next. Ready to Install Window displays.

8 Select Install. Selected Features and prerequisites Install.

9 On completion, the Setup Wizard Completed dialog displays. Select Finish to exit

- End -
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Add a new Windows User Account (Win7)

When using victor in a workgroup environment, each victor user must also have identical Windows 
accounts on both the site manager and client machines. The account must contain both username 
and password, blank passwords are not accepted by victor. The following procedure is for the 
recommended OS Windows 7, the procedure may vary for other operating systems.

Note

When a new Windows OS user has been created, the user should logon to Windows to ensure the 
required folder structures are in place for exporting clips.

Procedure 2-8  
Add a new Windows User account (Win7)

Step     Action

1 Select Start on the Windows Taskbar.

2 Right Click Computer.

3 Select Manage. Computer Management window displays.

4 Select Local Users and Groups.

5 Double click Users. User list displays.

6 Select More Actions.

7 Select New User. New User dialog displays.

8 Enter Credentials as required (Password required).

9 Select Create. New user is created.

- End -
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Licensing 

Introduction

victor Licensing is managed via the License Manager application. The Application allows licenses 
to be updated and applied. It also displays license status, information and lists all licensed 
components.

The following table details victor’s Standard and Licensable features.

Note

Owners of a victor license who wish to run a unified system with C·CURE 9000 on the same host 
machine must purchase a victor license with the unified component.

Standard Features Add-On Options

Support for unlimited Intellex Recorders Option for additional concurrent victor unified 
clients for any base model (Purchase)

Support for unlimited VideoEdge Recorders Option for additional concurrent victor Agents for 
any base model (Purchase)

Support for unlimited HDVR Recorders Option for Bosch Integration (Purchase)

Support for unlimited ADTVR Recorders Option for C·CURE 9000 unified install (No Charge)

Maps Option for Point of Sale (POS) (Purchase)

Simplex Grinnell 4100U Fire Detection Integration 
(C·CURE dependent)

Option for Sur-Gard Integration (No Charge)

MZX Fire Detection Integration (C·CURE 
dependent)

Option for victor MultiView (Purchase)
15
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License Application

By default, you will receive a trial period of 60 days from the date of installation. After 60 days you 
must license the product to continue using it.

Note

To Register you require:
1. Internet Connection
2. Valid email account
3. For Laptop installs only:
Ensure only 1 standard LAN card is enabled
Restart the system
Adapters can be re-enabled after the installation is complete

CautionCaution

The System Information file must be generated on the machine for which the license is intended. 
The XML file contains information specific to the machine on which it was generated and therefore 
the license created is exclusive to that machine and will not work on any other.

Procedure 3-1  
Apply for victor License

Step     Action

1 Right Click on the License Manager icon on the Desktop.

2 Select Run as Administrator. The License Manager window displays.

3 Select Generate System Information. Save As dialog displays.

4 Enter a File name in the text box. (Default filename is available if required)

5 Browse to a suitable folder to which the file will be saved.

6 Select Save. An .xml file is generated and saved to the location specified.

7 Visit http://www.americandynamics.net/Support.RegisterDefault.aspx and complete the 
registration form.

Note

It may take one business day to receive your license.

- End -
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Licensing
Add new License

When the .LIC license file has been received and applied, the 60 day trial period will no longer 
apply and all licensed features will be available.

Procedure 3-2  
Add new License

Step     Action

1 Save the .LIC file to a local directory.

2 Right click the License Manager icon on the desktop.

3 Select Run as Administrator. The Server License Manager window displays.

4 Select Add New License. The Open window displays.

5 Browse to the .LIC license file and select Open.

Note

License update will restart services if they are running. This may take a few 
minutes.

6 The victor unified client will no longer run on a trial basis

Note

If any issues are encountered, please refer to the licensing instructions .pdf 
included with the license E-mail.

- End -
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 Updates

Introduction

victor allows updating of the client and VideoEdge NVR 4.4+ recorders from within victor unified 
client. Updates files are hosted in a repository on the victor Site Manager machine and can be 
downloaded by connected clients and pushed to eligible recorders.

Tyco Update Utility

During install, the Tyco Update Utility is installed alongside victor client. This component 
communicates with an update repository which is hosted on the site manager providing a means 
to update Tyco software.

The update application lists all available updates that can be installed on the user’s system along 
with the location of the site manager machine hosting the update repository.

Tyco Update Utility can be launched by navigating to ‘C:\Program Files (x86)\Tyco\UpdateClient’ 
and launching TycoUpdateUI.exe. Once launched  will display in the system tray. Double click 
to relaunch the Tyco Update Utility.

Note

In order to download and install updates using the Tyco Update Utility, you must have Windows 
administrator rights.
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victor

victor client checks for available updates:

• Daily if run for more than 24 hours without a restart

• Automatically on client startup

• Automatically when the client connects to a new site manager

• Manually from the ‘About’ page

Note

Automatic and manual update checks can only be carried out if the current victor user has the 
'Administrator' role in victor. 
The ability to check for updates can be added to roles other than ‘Administrator’ by using the Type 
Exception Workstation - Update victor client.

Only victor client users who have the Administrator or Power User role are allowed to perform 
updates to the victor client. If the current victor user does not have one of these roles then the 
update options will be disabled.

Hosting victor Client Updates

In order for victor unified client to update, the update files must be hosted on the Site Manager 
machine in the update repository.

Procedure 4-1  
Hosting victor Client Updates

Step     Action

1 Double click update executable to launch. Installer dialog opens

2 Select Next. End User License Agreement (EULA) dialog displays

3 Select I accept... or I do not accept... as applicable

4 Select Next. Ready to Install the Program dialog displays

5 Select Install. Tyco Update Repository begins to install. Once complete, InstallShield 
Wizard Complete dialog displays

6 Select Finish. A new folder called “Repository” is created in the location ‘C:\Program Files 
(x86)\Tyco\Update Server Repository’ which hosts update files for victor unified client

- End -
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Updates
Updating victor Client

Automatic Updates

If an update is available, launching victor unified client, the client being open for 24 hours or 
connecting to a new site manager will display a dialog stating:

“The victor site manager system you are connected to has an update available. Installing 
this update will cause victor client to be closed. Would you like to automatically download 
and install this update?”

Follow the procedure below to install the update. To skip the update, select Remind Me Later.

Procedure 4-2  
Install Automatic Update

Step     Action

1 Select Install. The victor unified client license agreement dialog opens

2 Read the license carefully and select Accept or Decline as applicable

3 If Accept is selected, victor client will close and a dialog will display showing progress of 
downloading and installing updates. The update can be cancelled by selecting Cancel 
during the download of update files

Note

During the upgrade, if the Tyco Update application is running, the user is informed 
of progress via a system tray status display.

4 Once update is complete, select OK

- End -

Manual Updates

Users with appropriate permissions can manually check for and install updates from within victor 
unified client.

Procedure 4-3  
Install Manual Update

Step     Action

1 Select  then About. The about tab opens

2 Select Check for Updates

3 If no update is available, dialog will display “Software is up to date”. If there is an update 
available, dialog will display:

“The victor site manager system you are connected to has an update available. Installing 
this update will cause victor client to be closed. Would you like to automatically download 
and install this update?”
21
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4 Select Install. The victor unified client license agreement dialog opens

5 Read the license carefully and select Accept or Decline as applicable

6 If Accept is selected, victor client will close and a dialog will display showing progress of 
downloading and installing updates. The update can be cancelled by selecting Cancel 
during the download of update files

Note

1. Progress dialog will not display if User Account Control (UAC) is enabled.
2. During the upgrade, if the Tyco Update application is running, the user is 
informed of progress via a system tray status display.

7 Once update is complete, select OK

- End -

VideoEdge NVR

Updates can be applied to VideoEdge NVRs from the client via the recorder’s context menu.

Before performing the update, the NVR checks the current version installed against the version to 
be installed. If it is not a higher version, an alert is posted to the client, informing it that the update 
failed and the reason for failure.

If security is enabled on the NVR, the user is prompted for credentials before the update is applied.

After successful update and restart of NVR services, an alert is sent to the victor client indicating to 
it that the installation was a success.

CautionCaution

1. When a software update is applied either via a push update or applied manually using the 
Administration Interface, NVR services will restart. Temporary NVR service outage should 
therefore be expected when an update is applied.
2. It is recommended that you should schedule when NVR upgrades are applied and expect a loss 
of video when services restart. When upgrading NVRs which are being monitored by a secondary 
(Failover) NVR you need to stop Server Monitoring to prevent the secondary NVR taking over 
when the upgraded primary NVR's services stop.

Note

VideoEdge NVR updates can only be carried out if the current user has ‘Edit’ permissions on the 
applicable VideoEdge NVR recorder.
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Update VideoEdge NVR

VideoEdge NVR software update bundles can be hosted on the site server update repository and 
pushed down to individual recorders via the client GUI.

Procedure 4-4  
Update VideoEdge NVR

Step     Action

1 Right click the recorder to be updated

2 Select Check for Updates. If updates are available, Do you want to install upgrade 
dialog displays

Note

If no updates are available, dialog displays - No Update available

3 Select Yes. Dialog advises that the recorder will be offline for a period of time

4 Accept EULA. Recorder goes offline during upgrade

Note

During upgrade, any alerts related to success or failure of updating display in 
victor’s activity list

- End -
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Getting Started

Introduction

This section describes the basic steps on involved in how to start site manager services (victor 
Professional only), launch the client after installation and provides an overview of the main 
Graphical User Interface (GUI).

It is important to read this section as it provides useful user information on a number of 
basic/common tasks which are not repeated throughout the manual and are not related to specific 
object types or scenarios.

Server Configuration Application (victor Professional)

The Server Configuration Application provides a management interface for administration of 
various server settings. It is accessible directly from the desktop via the Server Configuration 
Application icon or via the Windows Start Menu (All Programs > Tyco > victor > Server 
Configuration)

The Application comprises the following tabs:

• Services - Allows Framework and Extension services to be manually started and stopped

• Server Components - Allows manual start/stop of Bidirectional server components

• Database - Displays database connections

• Settings - Allows Enable/Disable of Application and Network settings

Restarting services (victor Professional)

After initial installation, all applicable services will be running. However, site manager services may 
need to be restarted when new licenses are added to ensure full functionality is available.

Note

1. Crossfire Framework Services must be started first to allow Extension services to run
2. victor Express does not require services to be started manually
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Procedure 5-1  
Restarting site manager Services

Step     Action

1 Double click the Server Configuration Icon on the desktop. The Server Configuration 
Application displays.

Note

Depending upon security settings, you may need to right click the icon and select 
Run as Administrator.

2 Select the Services tab.

3 Select Stop for all Framework Services. Status changes to Stopped.

4 Select Stop for Extension services as required.

5 Select Start Service for Crossfire Framework Service in the Framework Services 
section. Wait until Status:Running displays in Green.

6 Select Start Service for Crossfire Server Component Framework Service in the 
Framework Services section. Wait until Status:Running displays in Green.

Note

All extension services should start automatically. If you need to manually start 
them, continue to Step 7.

7 Select Start checkbox for all required extension services.

8 Select Start Service for all required extension services. The status changes to Running.

9 Confirm that all Services have changed state to Running.

10 Exit the Server Configuration Application.

- End -
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Getting Started
Launch the Client

Note

1. Before starting the client, ensure all site manager services are running (victor Professional only)
2. Initial sign-in must be from the windows user account under which the client was installed. 
(During installation, a client user is created called Installer Account. Because this is the only user 
which exists at this time and victor uses Windows authentication, it is important that this user is 
logged in to Windows.)

Procedure 5-2  
Starting the client

Step     Action

1 Double click the victor unified client icon on the desktop. The client sign in dialog 
displays (Unless this is the first sign on in which case the client will connect automatically).

2 Select Authentication Method the operator uses from the dropdown - Windows or Basic

3 Enter Username (Windows Username of the installer account if this is the first login)

4 Enter Password (Password of the Installer Account)

Note

Blank Password are not accepted

5 Select Domain and site manager as required

6 Select OK to Login or Cancel to Exit

- End -
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Exploring the Default Workspace

The default layout for the client is made up of a ribbon control comprising Home, Build and Setup 
tabs. The tools and buttons available on each tab is dependent on the components installed, 
licenses applied and the role of the logged in user.

Below the Ribbon, The Device List, Surveillance window and status bar make up the rest of the 
default layout.

Home Tab - User Controls

The Home tab contains typical user/viewer controls. No configuration or setup options are 
available.

Build Tab - Configuration Tools

The Build tab contains administrative tools to configure non hardware objects e.g. Operators, 
Roles, Video Actions and Events

Setup Tab - Configuration Tools

The Setup tab contains administrative tools to configure system hardware e.g. General Purpose 
Devices, Recorders and Keyboards
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Status Bar

The Status bar is a static display of System level Information which includes:

• Number of Active Alerts

• Server Name (site manager)

• Client Messages

• Active Operator

• Active Layout

• Bandwidth Configuration (Configurable from the status bar)

• Name of the Active Virtual Matrix

• Workstation Status (CPU Usage/Memory Free/Disk Space Free)

• Current Date and Time

• Any Error Messages detected by the client will also be displayed. For example ‘Recorder has 
reached its maximum number of clients’.

Device List

The Device list displays a list of all hardware configured in the system in a single window. It is 
primarily used to interact with hardware via object Icons’ context menus.

The device list forms part of the default layout but can be hidden or viewed as required.
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Save and Close Options

Save and Close options are displayed and used in all object editors when creating or editing any 
object types. It is important to understand the differences between the various options as proper 
use can save time and effort when configuring objects.

Switch Language/Culture

You can change the language/culture of the text displayed on the application Graphical User 
Interface (GUI)

Procedure 5-3  
Switch Language/Culture

Step     Action

1 Select the victor menu  button on top left of GUI. Dropdown menu displays

2 Select Languages  button. Language Selection dialog displays

3 Select the Dropdown menu in the language dialog

4 Select the required language

5 Click Select. Dialog displays informing you the next time you run the program, the User 
Interface will be in the selected language

6 Close the victor program

7 Launch victor. GUI displays in the new language

- End -

Close Editor - 
Do not Save

Save and Create
New Object type

Save and Close

Save (Apply)
Keep Editor Open)
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Reposition the Quick Access Toolbar

You can reposition the Quick Access Toolbar below or above the ribbon.

Note

The ribbon is minimized by default

Procedure 5-4  
Reposition the Quick Access Toolbar

Step     Action

1 Select  from the top left of the client window.

2 Select Show Below the Ribbon or Minimize the Ribbon as required.

3 Select  to reverse the selection.

- End -

Common Tasks

There are certain tasks within the client which are identical for all object types and therefore are 
not repeated in each chapter. This section gives an overview of some of the tasks and explains 
how to perform them.

• Show All (Dynamic Views)

• Delete (Objects)

• Refresh Hardware

• Object Editors

• Object Selector

Show All Objects (Dynamic Views)

Object lists (Dynamic Views) are generally displayed using the Show All option from an object 
type’s dropdown menu.

These lists will generally contain at a minimum Names and Descriptions of available objects. 
Depending on the type of object being displayed, more information may be available by right 
clicking the column headers and displaying extra detail.

Procedure 5-5  
Show All Objects (Dynamic Views)

Step     Action

1 Select the Object Icon from the Build or Setup Tab.
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2 Select Show All from the dropdown menu. A List of all selected object types displays.

- End -

Delete Objects

The procedure to delete objects is identical for all object types.

Procedure 5-6  
Delete Objects

Step     Action

1 Select the Object Icon from the Build or Setup Tab.

2 Select Show All from the dropdown menu. A List of all selected object types displays.

3 Right Click on the object to be deleted.

4 Select Delete. A warning dialog displays.

5 Select Yes to Delete or No to Cancel.

- End -

Refresh Hardware

The procedure to refresh hardware is identical for all object types.

Procedure 5-7  
Refresh Hardware

Step     Action

1 Select Devices from the Home Tab. Device list displays.

2 To refresh ALL objects of a single type:

a Right Click the Parent object.

b Select Refresh. All objects of that type refresh.

3 To refresh individual objects:

a Select  next to object type to expand the selection.

b Right click the object to be refreshed.

c Select Refresh. The object refreshes.

- End -
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Object Editors

Object editors are used to make changes to existing system objects. They are generally 
accessible from the Object’s context menu.

Procedure 5-8  
Edit Objects (General)

Step     Action

1 Select the object type from the Build or Setup tab.

1 Select Show all to display object list.

2 Right click the object

3 Select Edit to enter the object’s editor page

4 Make changes as required

5 Select Save.

- End -

Object Selector

The Object Selector is used throughout the client to select objects or assign actions. It is mainly 
used for Administration E.G when selecting role exceptions or Event Actions.

Procedure 5-9  
Select an Object

Step     Action

1 Select . Object Selector displays

2 Select the object type from the Type column. Object column will be filtered based on type

3 Select object from the Object column

4 Select OK

- End -

Cycle Active Tool Windows and Files

For easy navigation between open victor tabs, you can cycle between active tool windows and 
files.

Hold CTRL and Press Tab to open a dialog displaying active Windows and files. Cycle the active 
items by pressing Tab until the required item has focus in the dialog.

Release CTRL to focus on the required item.
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Device List

Introduction

The Device list provides a means of displaying all hardware configured in the system in a single 
window. It is primarily used to interact with system hardware via object Icons’ context menus.

Display/Navigate Device List

The Device list displays a tree view of all hardware devices configured on the system which are 
available to the current user.

Root Node for each
Object Type

Right Click to
access object’s
Context Menu

victor object

Use Icons to filter
view by device
 type
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Procedure 6-1  
Display/Navigate Device List

Step     Action

1 Select Devices from the Home Tab. The device list displays.

2 The Device List window displays showing all devices configured within the system.

3 Use Object Icons to filter view and Context menus to interact.

- End -

Object Status

An object’s Online/Offline Status is visually represented by a graphical ‘light bulb’ associated with 
the object icon in the device list.

Note

1. For analog cameras, Online and Offline status refers to the physical connection between the 
camera and recorder.
2. Cameras displaying  (Offline status) may still be streaming video as the system may take 
some time to refresh the icon to Online.
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Recorder Configuration

Introduction

Recorders can be added to the system manually or multiple recorders may be added using the 
Recorder Import function. Recorders can be added from Local Area Networks (LANs) or from 
across Wide area Networks (WANs)

Supported Recorders

CautionCaution

Ensure time is synchronized between client machines and network recorders. Recorders which 
are out of time synchronization with client machines cause incorrect video retrieval. It is 
recommended that an NTP server is used to synchronize machines.

Recorder Type Supported Version

Intellex 4.0+

Intellex IP 4.0+

VideoEdge NVR 4.2+

VideoEdge Hybrid Appliance 4.21+

American Dynamics HDVR 1.5+

American Dynamics TVR 2.2,2.5,2.6
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Add new Recorder (LAN)

You can add supported LAN recorders to the site manager.

Procedure 7-1  
Add new Recorder

Step     Action

1 Select Recorders from the Setup Tab.

2 Select New from the dropdown menu. Recorder editor displays.

3 Enter the IP Address/Domain Name of the recorder.

Note

1. If adding a VideoEdge NVR 4.4+ recorder with failover set up, enter the virtual 
IP address of the recorder. It is also recommended that the secondary (failover) 
NVR 4.4+ recorder is added to victor separately using its static IP address to 
ensure that all alerts are received. 
2. If using a domain name, then it is recommended that a DNS server is used to 
allow both the client and the site manager to resolve the device name. It is NOT 
recommended to use local host files to resolve device names.

4 Enter the Communication Port. This can be left blank of default ports have not been 
changed.

5 Enter the User Name, if required.

6 Enter the Password, if required.

Note

1. A Username and Password is required when adding VideoEdge NVR units.
2. If adding Intellex 5 recorders with Remote Access Authorization enabled, a 
Username and Password is required.
3. It is recommended that an Administrator account is used when adding 
Recorders to ensure that full access is available via the client.

7 Enter the Streaming Port, if required.

8 Select Save.

- End -
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Recorder Configuration
Add new Recorder (WAN)

You can add supported WAN recorders to the site manager.

Procedure 7-2  
Add new Recorder (WAN)

Step     Action

1 Select Recorders from the Setup Tab.

2 Select New from the dropdown menu.

3 Enter the IP Address/Domain Name of the recorder.

Note

1. If adding a VideoEdge NVR 4.4+ recorder with failover set up, enter the virtual 
IP address of the recorder. It is also recommended that the secondary (failover) 
NVR 4.4+ recorder is added to victor separately using its static IP address to 
ensure that all alerts are received. 
2. If using a domain name, then it is recommended that a DNS server is used to 
allow both the client and the site manager to resolve the device name. It is NOT 
recommended to use local host files to resolve device names.Enter the 
Communication Port. This can be left blank of default ports have not been 
changed.

4 Enter the User Name, if required.

5 Enter the Password, if required.

Note

1. A Username and Password is required when adding VideoEdge NVR units.
2. If adding Intellex 5 recorders with Remote Access Authorization enabled, a 
Username and Password is required.
3. It is recommended that an Administrator account is used when adding 
Recorders to ensure that full access is available via the client.

6 Enter the Streaming Port, if required.

7 Expand the WAN Configuration section.

8 Enter the Enter the IP Address/Domain Name of the recorder.

9 Enter the Communication Port. 

10 Enter the Streaming Port.

11 Select Save.

- End -
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Add Multiple Recorders

You can add multiple recorders simultaneously using the Import Recorders function. This feature 
enables you to import recorder information (Minimum IP Address/Hostname) using information 
previously entered into a .txt or .csv file. See example below:

Note

1. Lists are not case sensitive.
2. Each Recorder must have a separate row on the list.

Procedure 7-3  
Add Multiple Recorders

Step     Action

1 Create a .txt or .csv file, listing at a minimum the IP Addresses or Hostnames of each 
recorder to be imported. Create each new entry on a new line. Additional field information 
may be entered, separate information relating to each field with a comma.

2 Save the .txt or .csv file.

3 Select Recorders from the Setup Tab.

4 Select Import Recorders from the dropdown menu. Please select a file to import dialog 
displays.

5 Navigate to the saved file.

6 Select Open. Reading Recorders file dialog displays informing of progress. When 
complete, imported recorders display in device list.

7 Select Close on the Reading Recorders file dialog.

- End -
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Recorder Configuration
Edit Recorders

You can edit properties of existing recorders.

Procedure 7-4  
Edit Recorders

Step     Action

1 Select Recorders from the Setup Tab.

2 Select Show All. All recorders are listed.

3 Right Click on the recorder to be edited.

4 Select Edit. The Recorder editor displays.

5 Make edits as required.

Note

Properties which can be edited vary depending upon recorder type.

6 Select Save.

- End -

Configure VideoEdge NVR

victor client supports full configuration of VideoEdge NVR (4.2+).

Procedure 7-5  
Configure VideoEdge NVR

Step     Action

1 Select Recorders from the Setup Tab.

2 Select Show All. All available recorders are listed.

3 Right Click the recorder to be configured.

4 Select Configure. The recorder’s configuration page opens.

5 Refer to the recorders User/Administrator guide for configuration help.

- End -
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Recorders - General

Alarm Persistence

VideoEdge NVR constantly caches alarms from the previous 2 weeks data. This means if an NVR 
loses connection to the site manager, alarms are resent upon reconnection in Recovery Mode.

Upon Reconnection, notification is sent to victor that Alarm recovery is in progress and also 
informs whether it has been successful.

Users must run a Video Alarm report to access the alarms triggered during the lost connection.

Alarm Persistence can be disabled from the Server Configuration Application.

Procedure 7-6  
Disable Alarm Persistence

Step     Action

1 Right Click the Server Configuration Application on the desktop

2 Select Run as Administrator. Application opens

3 Select the Settings Tab

4 Select Skip Recovered Events Checkbox in the Application Settings section

Note

If the status of the Skip Recovered Events is changed while the VideoEdge 
Driver service is running, it must be stopped and restarted before changes take 
effect.

- End -
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Recorder Configuration
Change Bandwidth Configuration Settings

Current bandwidth and CPU usage is displayed on the status bar.

You can configure bandwidth to reflect the capabilities of your network.

Bandwidth is selected from a list of network types which define a maximum bit-rate value to be 
received from video servers.

The client allocates a bandwidth limit to each individual active stream by intelligently distributing 
the total bandwidth limit associated with the chosen network type.

The ability to change bandwidth type is based on the role allocated to the active user.

Note

Bandwidth throttling may degrade video quality.

Procedure 7-7  
Change Bandwidth Configuration Settings

Step     Action

1 Select the current Bandwidth Configuration from the Status Bar. Bandwidth settings 
display as a popup menu.

2 Select the required Bandwidth Setting. Options are:

The selected Bandwidth cap is applied and will display on the taskbar.

Note

1. When Bandwidth throttling is being applied, the  symbol displays on the video stream.
2. When a stream has stopped due to client bandwidth configuration, the  symbol displays.

- End -

Virtual Private Network (VPN)

When using a VPN connection, selecting the VPN option informs the NVR that the client machine 
is on a WAN. This selection makes transcoding resources available if configured and/or free.

Bandwidth Configuration Bandwidth Cap

VPN * See Below

Local Are Network (LAN) Capped by Network Capability

High Speed Broadband 10 Mbps

Broadband 5 Mbps

Low Speed Broadband 1 Mbps

Fractional T1 512 Kbps

Narrowband 256Kbps

Modem 128 Kbps
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Cameras

Introduction

After adding recorders, their associated cameras are automatically available to view and 
configure. Names and descriptions of cameras can be edited and alerts can be assigned to 
cameras from the client. Other camera attributes can generally be viewed but not edited.

Edit Cameras

Camera Names and Descriptions can be edited, and Alerts and Associations can be assigned.

Procedure 8-1  
Edit Cameras

Step     Action

1 Select Devices from the Home tab. The Device list displays.

2 Navigate to the camera to be edited.

3 Right click on the camera.

4 Select Edit. Camera Editor displays.

5 Expand the General Section.

a Edit the name, if required in the Name textbox.

Note

Changing the camera name assigns a Pseudo Name recognized within the client 
only. The change is not recognized on the camera’s recorder(s).

b Enter/Change the description, if required in the Description textbox.

c Select the Enabled checkbox to enable or deselect to disable. Default is enabled.

6 Expand the Alerts section. Depending upon camera type, you can select from a range of 
alerts to assign to the camera.

7 Use Object selector Icons  and  to add or remove alerts.
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8 Expand the Associations section. You can use the Object selector to associate a camera 
with up to 5 objects.

9 Select Save.

- End -

Reset Camera Name

When a camera name is changed within the client, it can be reset back to the original name 
assigned at the recorder.

Procedure 8-2  
Reset Camera Name

Step     Action

1 Select Devices from the Home Tab. The Device List displays.

2 Navigate to the camera to be reset.

3 Right Click the camera.

4 Select Reset Name. Name reverts to original.

Note

All Camera names can be reset from the Setup Tab by selecting Reset All 
Name(s) under the Cameras Icon

- End -
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Surveillance 

Introduction

Surveillance allows users to view live or recorded video from recording devices. Video can be 
viewed from within the predefined layouts available in the surveillance window or by using Call ups 
to display video from existing Tours and Salvos.

PTZ Control

When viewing a video stream, Pan, Tilt and Zoom (PTZ) control is available using an On screen 
display. 

There are 2 types of PTZ command that the client will determine to use, depending on camera 
type:

Real PTZ

This can be used on live video streams to control supported dome cameras.

Virtual PTZ

This type is used with fixed cameras for live and recorded video. Virtual PTZ is achieved by 
capturing a specific area of the camera’s view, cropping a smaller area and zooming that to a 
larger view.
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View video from all cameras on a recorder

You can view live video from all cameras connected to a single recorder.

Note

The maximum number of supported live video feeds is 16 H.264 @ 30 ips

Procedure 9-1  
View video from all cameras on a recorder

Step     Action

1 Select Devices from the Home tab. The device list displays.

2 Select  next to recorders to expand the selection.

3 Select  next to the recorder’s folder to expand the selection.

4 Right click the recorder.

5 Select View. A new surveillance tab opens displaying all available video streams.

- End -

Display video from selected cameras

As well as displaying all available video from a recorder, you can select specific cameras to view in 
the surveillance window.

Procedure 9-2  
Display video from selected cameras

Step     Action

1 Select Surveillance from the Home tab.

2 Selected appropriate Video Pane layout using the layout selector icon . Default 
view is 1X1.

Note

You can configure which video layouts are available from System Values > Video 
Layout Preferences

3 Select Devices from the Home tab. The device list window displays.

4 Select  next to recorders to expand the selection.

5 Expand recorders as required. Camera icons display.
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6 Drag and drop camera(s) from the device list into the surveillance pane(s).

- End -

Change Surveillance Overlay Settings

Video Overlay settings can be enabled or disabled within the video window.

Video overlays can be displayed or hidden as required:

• Display Grid

• Camera, Recorder, Names and Time

• Dome Control

• Region of Interest

• Audio

Note

Changes to overlay options affects the whole window in which the changes are made. Overlay 
options cannot be set for individual panes.

Procedure 9-3  
Change Surveillance Overlay Settings

Step     Action

1 Select Surveillance from the Home Tab. The surveillance window displays.

2 Right Click in the surveillance window.

3 Select Overlay.
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4 Select or Deselect options as required.

Note

Dome Control overlay must be enabled to allow camera control from within 
specific panes.

- End -

Using Virtual Controls (PTZ)

You can use Virtual controls to crop and magnify the view of fixed cameras (virtual Zoom). Virtual 
controls also allows users to move and set Picture in Picture views and to set virtual presets.

Note

Virtual Control overlay must be enabled to allow camera control from within specific panes.

Procedure 9-4  
Using Virtual Controls

Step     Action

1 Select Surveillance from the Home Tab.

2 Select the Camera Control symbol  within the video pane of the fixed camera you want 
to control. Virtual PTZ controls display.

Close PTZ Controls

Pan/Tilt Controls

Zoom In

Zoom Out

Reset Zoom

Move Picture in Picture

Toggle Picture

Presets

in Picture

Focus Auto

Focus Near

Focus Far
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3 Use the controls by selecting the areas of the controls as required. When in use, a picture 
in picture view is displayed in the main video pane. Use the Move Picture in Picture icon 
to reposition the view.

Note

Picture in Picture behavior can be configured in System Values > Surveillance 
Preferences

4 Select Close to close the controls.

- End -

Virtual Controls (Presets)

You can set virtual presets on a fixed camera. This allows you to view multiple areas of interest 
quickly without the need to manually control the camera’s PTZ.

Note

The maximum number of presets that can be configured is 255

Procedure 9-5  
Virtual Presets (Presets)

Step     Action

1 Select the Camera Control symbol  within the video pane.

2 Use Virtual PTZ to display the view to be added as a preset.

3 Select Preset . Preset controls display.

4 Select next sequential preset number from the dropdown.

5 Select  to add preset.

6 Select  to exit back to PTZ controls.

7 Repeat as required for further presets.

Note

To view presets, select the preset number and click  Go to Preset.

- End -
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Dome Camera Controls

Where available, you can use real Pan Tilt and Zoom controls from within the client surveillance 
windows.

Procedure 9-6  
Dome Camera Controls

Step     Action

1 Select Surveillance form the Home tab. The surveillance window displays.

2 Select  within the video pane of the dome camera to be controlled. Dome Controls 
display.

3 Use the controls by selecting the areas of the controls as required.

Note

Depending upon the type of dome and recorder being used, the available controls 
may vary. For example, the sequence function is not available when using 
Intellex.

- End -

Mouse Control

Depending on the current surveillance mode, the mouse can be used to navigate video streams 
and Pan, Tilt and Zoom cameras:

• In playback mode you can instantly toggle between X1 forward and X1 reverse by scrolling up or 
down

• In Live and Playback modes, you can use the scroll wheel to Zoom by clicking and scrolling the 
wheel

• In Live and Playback modes, you can use the mouse for Pan and Tilt operation by locating the 
cursor centrally and clicking and dragging when the  symbol displays

• In Paused mode, the mouse can be used to step forward and back frame by frame

• In Live and Playback modes, holding down the mouse wheel while scrolling zooms the camera 
view in or out (Both in vPTZ or Real Dome control)

Sequence

Close

Flip

Pattern

Preset

Focus NearPan/Tilt

Zoom In

Zoom Out

Iris Close

Iris Open

Focus Far
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Clear Video

You can clear video from surveillance windows and panes.

Procedure 9-7  
Clear Video

Step     Action

1 Right Click on the Surveillance Pane

2 Select Clear. Then select from:

a Clear Video - To clear video from that pane only

b Clear All Videos - To Clear video from all panes within the window

c Clear all Pane Selections - To clear all selected panes

d Clear Region of Interest

- End -

Change Video Layout

Video Layouts can be changed to accommodate different video pane configurations. The video 
layouts available from the surveillance window can be controlled from System Values.

Procedure 9-8  
Change Video Layout

Step     Action

1 Select Surveillance from the Home tab. Surveillance window displays.

2 Select . A list of available layouts displays. The Layouts are split into sections:

• Standard

• Widescreen

• Portrait

3 Select Layout as required. Video window switches to the selected configuration.

Note

When changing layouts, the three most recently used layouts are displayed in a 
recently used list next to the pulldown list for convenient retrieval.

- End -
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Still Image Capture

You can capture all or part of a paused video stream as a still image in .bmp or .jpg format. After 
capture, various options are available including Save, Email, Print or Copy to clipboard. You can 
also launch a third party application for image editing.

Still Image capture is available from any surveillance mode, the method for capture is identical in 
all modes.

Procedure 9-9  
Still Image Capture

Step     Action

1 Pause a video stream.

2 Select  to enable the Still Image feature.

3 Right Click the surveillance pane.

Note

To capture a partial still image, instead of right clicking, select and drag across the 
area to be captured.

4 Select Still Image. A new floating window displays from where the following options are 
available:

• Select  to browse to a storage location and Save the still image.

• Select  to Email the still image (Requires Email to be configured in System 
Values).

• Select  to Open the image in a third party application (Requires third party 
application to be configured in System values)

• Select  to copy the image to clipboard.

• Select  to print still image (Requires Windows Printer to be configured)

- End -
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Fisheye Cameras

De-Warping

Fisheye cameras use very wide angle lenses to capture hemispherical images - 180° panoramic 
view (wall mount) or 360° surround view (ceiling/floor/wall mount) without blind spots.

victor allows hemispherical images captured from fisheye cameras to be converted into 
conventional rectilinear or panoramic projections for viewing and analysis. This process is known 
as De-Warping.

The option to De-warp is available via the context menu of supported fisheye camera views. This 
can be done in Playback and Live modes as well as from within victor Player. It is also available in 
Video Search Results player and Investigator windows.

It is also worth noting that sending an image to another display or InstantView etc. will open the 
Fisheye camera in whichever view is set by default in Setup -System Values- Video Preferences.

Note

Exported video can be de-warped within victor player but if exported footage is played back in 
alternative players, there is no option to de-warp the video.

De-Warping preferences are available in System Values. Here you can configure the default de-
warp mode from the following:

VideoEdge NVR 4.4+ also offers the option of selecting a default camera mounting for fisheye 
cameras.

Procedure 9-10  
Warp/De-Warp images

Step     Action

1 Right Click a video stream from a fisheye camera.

2 Select De-Warp Options. De-warping options display.

3 Select from:

Warped View Default View from a fisheye camera displaying a 
hemispherical image with barrel distortion.

Rectilinear View De-Warped view of a fisheye stream. This view is 
designed to display a section of the fisheye view 
with minimal barrel distortion.

Panoramic View De-Warped view of a fisheye stream. This view is 
designed to display the full fisheye view in a single 
elongated pane.
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• Warped - Maintains Fisheye view

• Rectilinear

• Panoramic

Note

De-warping algorithms are designed to give optimal de-warped views depending 
on camera orientation. Each mounting option therefore uses a different algorithm.

- End -

Fisheye Camera Controls (Warped)

Fisheye camera views have various click and drag OSD controls you can use to manipulate 
camera views.

Note

Virtual presets created on a Fisheye camera will also store the warped or de-warped view which 
was being viewed at the time of creation 

Warped View Mouse Control

In warped views, pressing Shift displays a target box on screen. This box can be moved by 
dragging the mouse around the warped view. Clicking the mouse on a particular area displays a 
new rectilinear (de-warped) view of that area.

Rectilinear View Mouse Control

In Rectilinear views, hovering the mouse in the centre of the view displays a  symbol. You can 
Click and Drag the symbol in any direction to effectively enable Pan and Tilt control. (PTZ control 
must be open)

Panoramic View Mouse Control

In Panoramic views, similar to Rectilinear, you can use to Pan and Tilt the camera view. (Zoom 
mode only)

Close Surveillance Window

You can close the surveillance window when no longer required.

Procedure 9-11  
Close Surveillance Window

Step     Action

1 Right Click on the tab of the window to be closed.
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2 Select Close.

Or

3 Select  on the top right corner of the surveillance window.

- End -

InstantView

InstantView enables users to view video in instant playback (paused) mode alongside the live 
view.

You can launch instant playback from any surveillance view from the video context menu or by 
selecting the InstantView Icon.

Procedure 9-12  
Launch InstantView

Step     Action

1 From Live video mode, select a video pane. Selected pane highlights dashed yellow.

2 Select  . Dropdown menu displays.

3 Select from: 

• Side By Side - to open the new paused view beside the live view

• Send To - to send the paused view to a separate display

- End -

Audio Devices

General

Audio devices are exposed in victor client only via VideoEdge 4.4+ NVRs where all audio object 
settings are configured. Refer to VideoEdge User Manual for more details.

Within victor, audio devices generally mirror the behavior of cameras; they are standard victor 
hardware objects which are displayed as child objects of NVRs and can be interacted with via the 
device list.

Audio device editor

As with cameras, victor’s Audio device editor allows you to add alerts and associations, assign 
descriptions and rename devices. Associating devices within victor client pushes the changes 
back to the NVR only if the new association is with an object within that NVR.
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Search and Retrieve

You can drag audio devices into the Search and Retrieve object selection alongside cameras to 
return audio and video streams which are not necessarily associated outside of the wizard.

You can also perform Search and Retrieve on audio devices only, this return audio only streams 
for the parameters selected.

Audio Associations

General

Audio associations are limited to one per device. each association made in victor client is 
automatically replicated on the NVR, likewise each association made on NVR is mirrored within 
victor (when the audio device and camera are connected to the same recorder).

If multiple audio associations are attempted, only the first selected will be added, the other 
selections are ignored.

Clip Export and Retrieval

There are some considerations which should be noted concerning clip export and audio 
associations:

Clips with default audio

Clip and audio are exported together and playback as separate streams within a single clip

Clips with default audio and audio associations

Clip and default audio are exported as a single clip, the associated audio is exported as a separate 
clip
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Playback Controls

Introduction

victor’s video Playback Controls provide all the standard VCR operations as well as Jump forward, 
and Back by intervals and Date Selection options..

Note

1. Audio is disabled when in Playback mode unless the video stream is running at X1 forward. 
Only one source can be running at a time. For example, enabling audio on camera 2 will disable it 
on camera 1.
2. Live and streaming audio is unavailable on Intellex playback, it is only available on downloaded 
clips.
3. To enable audio when playing back retrieved video, select  on the surveillance pane.
4. During playback, if there are gaps in the recorded video stream, Intellex will skip to the next 
available video. VideoEdge NVR will return blank frames at the requested framerate across the 
gap in recording.
5. Instant Playback and Audio is not supported on HDVR units.

Exit 

Jump
Reverse (Fast)

Toggle 

Play 
Play Forward
Fast

Jump Forward 

Select 
Date

Play/ PausePlayback

Backwards
Forward

Play in
Reverse
59



Playback Controls  
Instant Playback

When in Live mode, you can switch to Instant Playback mode, enabling user control of recorded 
video streams.

Procedure 10-1  
Switch between Live Video and Instant Playback

Step     Action

1 From Live video mode, select a video pane. (Select multiple panes by clicking on more 
than one) The Playback controls become active.

Note

When a surveillance pane is selected, a border displays around the pane:
Yellow Dashed - Instant Playback is available
Yellow Solid - Video stream is in instant playback mode
Blue Flashing - Instant Playback is not available on the selected stream

2 Select the required function from playback controls. The selected pane(s) enter playback 
mode.

3 Navigate video stream(s) as required.

4 Select Exit Instant Playback to exit to revert to Live Video.

- End -

Mouse Control

Depending on the current surveillance mode, the mouse can be used to navigate video streams 
and Pan, Tilt and Zoom cameras:

• In playback mode you can instantly toggle between X1 forward and X1 reverse by scrolling up or 
down

• In Live and Playback modes, you can use the scroll wheel to Zoom by clicking and scrolling the 
wheel

• In Live and Playback modes, you can use the mouse for Pan and Tilt operation by locating the 
cursor centrally and clicking and dragging when the  symbol displays

• In Paused mode, the mouse can be used to step forward and back frame by frame
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Clear all pane selections

When multiple panes are selected, you can quickly deselect them all with one action.

Procedure 10-2  
Clear all pane selections

Step     Action

1 Right click a selected video pane. Context menu displays.

2 Select Clear all pane selections. Borders are removed indicating they are no longer 
selected.

- End -
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Call Up Configuration

Introduction

‘Call up’ is the collective name for Tours, Salvos and Saved Views.

Tours

A tour is a collection of different camera views, displayed in predefined sequences for specified 
durations.

Salvos

A Salvo is a display of multiple, simultaneous video streams which provides an effective way to 
monitor multiple areas of interest.

Saved Views

A Saved View is a standard Salvo which is associated with a specific video layout E.G Guard 
layout.

Create Tours

You can define criteria for a new tour and add it to the system.

Procedure 11-1  
Create Tours

Step     Action

1 Select Tours from the Build tab.

2 Select New from the dropdown menu.

3 Enter a Name for the tour in the Name textbox.

4 Enter a description for the tour in the Description textbox.
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5 The Enabled checkbox is selected by default, to deactivate the tour, deselect the 
checkbox.

6 If required change the Default dwell time in the Defaults section. This is the dwell time 
used for each camera added.

Note

Dwell times may be changed for individual cameras within a tour by changing the 
dwell time in the Tour section.

7 Select the tab in which the cameras to be added are located.

8 Select the camera to be added.

9 Drag the camera to be added into the right hand pane.

10 Repeat steps 8-9 as required.

11 Modify dwell times as required for individual cameras by double clicking the dwell value 
and changing it.

Note

Presets and Patterns are only available to add if they are already configured on 
the Recorder. They cannot be configured via the client. If available, they can be 
added by selecting them from the Pattern or Preset textboxes and selecting from 
the dropdown list.

12 If required, use  to remove items from the camera list.

13 If required, use  and  to change the step position of cameras.

14 Select Save.

- End -

Edit Tours

You can edit the properties of existing tours.

Procedure 11-2  
Edit Tours

Step     Action

1 Select Tours from the Build tab.

2 Select Show all from the dropdown menu.

3 Right Click the Tour to be edited.

4 Select Edit. Tour editor displays.

5 Edit Name and Description in the General section.
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6 The Enabled checkbox is selected by default, to deactivate the tour, deselect the 
checkbox.

7 If required change the Default dwell time in the Defaults section. This is the dwell time 
used for each camera added.

8 Within the Tour section, use  to remove cameras, and use  and  to change the 
step position of cameras.

9 Edit existing camera’s attributes by changing Preset, Pattern or dwell settings for each 
camera.

10 Add more cameras by dragging them from the Sites or Recorders list as required.

11 Select Save.

- End -

Create Salvos/Saved Views

Tours, Cameras and Recorders can all be added to Salvos. Presets and Patterns may be assigned 
to cameras if they have already been defined on the recorder.

Procedure 11-3  
Create Salvo/Saved View

Step     Action

1 Select Salvos from the Build tab.

2 Select New from the dropdown menu.

3 Enter a Name in the Name textbox.

4 Enter a description in the Description textbox.

5 The Enabled checkbox is selected by default, to deactivate the tour, deselect the 
checkbox.

6 Select a Layout from the Layout dropdown if the Salvo is to be a Saved View.

Note

1. The selected layout must contain enough video panes to accommodate the 
number of video streams you intend to add to the Salvo.
2. Saved view can also be created directly from current surveillance views by 
selecting Save as Saved View .

7 Navigate to the required objects to be added to the salvo.

8 Select and drag Recorders/Cameras/Tours into the right hand pane.

9 If required, use  to remove items from the camera list.
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10 If required, use  and  to change the step position of cameras.

Note

Presets and Patterns are only available to add if they are already configured on 
the Recorder. They cannot be configured via the client. If available, they can be 
added by selecting them from the Pattern or Preset textboxes and selecting from 
the dropdown list.

11 Change the default Pane number by selecting the Pane dropdown for each Camera/Tour.

- End -

Edit Salvos/Saved Views

You can make various changes to salvos and Saved Views. They can be edited to change 
attributes including Name, Description, Dwell Times, Add/Remove objects and Layouts (Saved 
Views only)

Procedure 11-4  
Edit Salvos/Saved Views

Step     Action

1 Select Salvos from the Build tab.

2 Select Show All from the dropdown menu.

3 Right click the Salvo/Saved view to be edited.

4 Select Edit. The Salvos editor displays.

5 Edit the Name and Description in the General Section.

Note

The Enabled checkbox is selected by default, to deactivate the tour, deselect the 
checkbox.

6 Edit Cameras and Layouts as required in the Salvo section.

7 Select Save.

- End -
66 victor 4.4 Installation and Configuration Guide



Call Up Configuration
Launch Call ups

Tours, Salvos and Saved views can be launched from any surveillance window.

Procedure 11-5  
Launch Call ups

Step     Action

1 Right click on any surveillance window.

2 Select Salvo/Saved View or Tour as required.

3 Select the required Call up. Call up displays.

- End -
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Search and Retrieve

Introduction

The Search and Retrieve feature allows users to search a recorder’s stored video or metadata 
using time or motion criteria to filter results. Search results can be reviewed, vaulted, saved as 
clips, stored on the client workstation or exported to remote storage.

CautionCaution

Ensure time is synchronized between client machines and network recorders. Recorders which 
are out of time synchronization with client machines cause incorrect video retrieval.

Supported Search Types

All searches are performed using the Video Search and Retrieval Wizard. The wizard comprises of 
a maximum of 3 screens, through which the user defines search criteria.

Three main search types are supported:

Basic Search

Basic search covers the following options in the Type of Search dropdown menu:

• Date and Time - Searches specific time ranges using only time related 
parameters

• Thumbnail Search - A date and time search which displays results as 
thumbnail images

All basic searches allow searching by date and time and enable the user to define the search 
period (Start and End Date/Time) and streams to retrieve (Video or Video and Audio). 

Thumbnail Search 

Thumbnail Searches display results in the form of 16 images representative of the selected time 
range.

Selecting '+' on a single image opens a new set of thumbnails at an increased granularity with the 
time range determined by the timestamp of the thumbnails adjacent to the original '+' selected.
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Thumbnail search is supported on VideoEdge NVR 4.4+, Intellex and HDVR recorders only.

Motion Detection Search

Motion detection search allows users to search for motion in a specific cameras field of view. This 
allows the user to skip directly to areas that may be of interest, rather than having to search 
through hours of video in order to search for a particular event. 

Note

1. Motion detection based searches and motion based alarms are handled differently within the 
client. Motion detection based searches are independent of motion alarm regions set up on a 
recorder.

2. Motion detection based searches performed on the client from a VideoEdge NVR do not search 
actual video footage, but rather metadata generated by the NVR. Search results are therefore 
dependent on the sensitivity level settings when the video was processed. If no motion metadata is 
generated for a particular time period, no results will be returned when searching on that time 
period.

3. Motion detection searches performed on the client from Intellex units search actual video 
footage so results depend on sensitivity settings set in the client.

4. Motion detection searches are not available on HDVR or ADTVR units.

Video Intelligence Search

Video Intelligence Search is supported on VideoEdge NVR 4.2+ recorders. This gives users the 
ability to detect, track and analyze moving objects using a variety of criteria. The Video Intelligence 
engine is licensable on a per-channel basis. Supported Video Intelligence searches are:

• Detection

• Direction

• Linger

• Enter

• Exit

• Abandoned/Detected

• Face Detection (4.4+)
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Perform Searches

Perform a Basic Search

You can use the Search and Retrieve Wizard to specify parameters in order to perform a Basic 
Search. Basic Searches only consider Time and Date parameters.

Procedure 12-1  
Perform a Basic Search

Step     Action

1 Select Search and Retrieve from the Home tab

2 Select Execute Search Wizard. The Search and Retrieval Wizard launches

3 Select the search type required from the Type of Search drop down menu. Available 
options are:

•Date and Time

•Thumbnail Search

•Motion Detection

Note

On VideoEdge NVR 4.2+ recorders, available options will vary if Video 
Intelligence is enabled on the camera selected. Refer to Perform a Video 
Intelligence Search.

4 If required, select the Download Audio button to download associated audio stream(s)

5 Drag and drop camera(s) from the Device, Site or Vault list onto the Camera Selector 
Pane

Note

If selecting cameras from the Vault List, Date and Time parameters are 
automatically populated

6 Specify Date and Time parameters in the Date and Time Pane

Note

Selecting Specific Range also allows selection of Time Filter options. Time Filter 
options can be used to specify a sub-set of time to search. For example, only 
search between 9am and 5pm. Select the Time Filter checkbox to enable

7 Select Next. The Confirmation screen displays. Confirm your search criteria are correct. 
Select Previous to return to the previous screen to make changes. Select Finish to 
execute the search
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8 Search and Retrieval Wizard closes and the Date and Time Based Search Results tab 
opens displaying search results. Double click on a search result to view associated video

- End -

Perform a Thumbnail Search

You can use the Search and Retrieval Wizard to search video footage and display results in 
Thumbnail view. Thumbnail search results are represented graphically as a series of snapshots 
representing the duration of the search period.

Note

Thumbnail Search is available for VideoEdge NVR 4.4+, Intellex and ADHDVR recorders only.

Procedure 12-2  
Perform a Thumbnail Search

Step     Action

1 Select Search and Retrieve from the Home tab

2 Select Execute Search Wizard. The Search and Retrieval Wizard launches

3 Select Thumbnail Search from the Type of Search drop down menu

4 Drag and drop a camera from the Device, Site or Vault list onto the Camera Selector 
Pane. 

Note

If selecting a camera from the Vault List, Date and Time parameters are 
automatically populated

5 Specify Date and Time parameters in the Date and Time Pane

Note

Specific Time Filter options cannot be used with Thumbnail Search.

6 Select Next. The Confirmation screen displays. Confirm your search criteria are correct. 
Select Previous to return to the previous screen to make changes. Select Finish to 
execute the search

7 Search and Retrieval Wizard closes and Video Thumbnail Search window opens 
displaying search result as 16 thumbnails
Selecting a thumbnail image will zoom in the time period to create 16 new thumbnail 
images using the thumbnails adjacent to the (+) thumbnail as the time range for the next 
16 images. Selecting a thumbnail will zoom out to the previous 16 thumbnails.

Double clicking a thumbnail will open that section of video in Investigator Mode.

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Toolbar buttons, as outlined below, can also be used to manipulate thumbnail search 
results: 

- End -

Perform a Motion Detection Search

You can use the Search and Retrieval Wizard to search video footage using a motion filter to look 
for movement in specific areas within a camera view. Specific areas may also be searched by 
exception.

Note

When searching on VideoEdge NVR 4.2+ recorders, motion detection search is only enabled 
when Motion Detection is enabled in the camera setup. For cameras with Video Intelligence 
enabled, refer to Perform a Video Intelligence Search.

Procedure 12-3  
Perform a Motion Detection Search

Step     Action/

1 Select Search and Retrieve from the Home tab

2 Select Execute Search Wizard. The Search and Retrieval Wizard launches

3 Select Motion Detection from the Type of Search drop down menu

Save image - select a thumbnail then select 
this button to save the image

Email image - select a thumbnail then select 
this button to email the image

Open in third party application - Select a 
thumbnail then select this button to open the 
image in a third party application. A third 
party application must be configured in 
System Values

Copy to Clipboard - Select a thumbnail then 
select this button to copy the image to your 
clipboard

Print - Select a thumbnail then select this 
button to print

Investigator mode - select a thumbnail then 
select this button to open associated video in 
investigator mode

Clip creation tools - select a thumbnail to 
be the start time of a clip, then select Clip 
Start Time. Select a thumbnail to be the end 
time of a clip, then select Clip End Time. 
Select Clip Export to export or vault the clip

Open Search and Retrieval Wizard - Select 
to reopen Video Search and Retrieval 
Wizard

Clip
start 
time

Clip
End 
Time

Clip
Export 
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4 Drag and drop a camera from the Device, Site or Vault list onto the Camera Selector Pane

Note

If selecting a camera from the Vault List, Date and Time parameters are 
automatically populated

5 Specify Date and Time parameters in the Date and Time Pane

Note

Selecting Specific Range also allows selection of Time Filter options. Time Filter 
options can be used to specify a sub-set of time to search. For example, only 
search between 9am and 5pm. Select the Time Filter checkbox to enable

6 Select Next. The Search Parameters screen displays

Note

The video stream reverts to the start time selected for the search. To view live 
video, select 

7 Select the required Draw Style and draw a Region of Interest (ROI):

• Polygon: Draw a polygon by clicking once on the image and dragging the 
cursor to form a line. Complete a line by clicking again. Repeat to form the ROI.
Double click when the shape is complete to finalize the search area. Use Clear 
to restart drawing and Erase to correct errors.

• Rectangle: Highlight the ROI by clicking and dragging the cursor over the 
camera view to form a rectangle. Use Clear to restart drawing and Erase to 
correct errors.

• Free Draw: Draw the ROI freehand on the camera view. Use Clear to restart 
drawing and Erase to correct errors.

Note

1. By default the ROI drawn is the Active Region, this can be inverted by 
selecting Invert Selection.
2. The full camera view can be selected as the Active Region by selecting Select 
All.
3. Load Alarm Rule allows you to load a previously configured rule from a 
VideoEdge NVR 4.2+ recorder. victor uses information from the NVR rule to apply 
search criteria to the victor client search. Search parameters are populated from 
the rule but can be edited if required. Refer to  Alarm Rules for more information 
on alarm rules

8 Adjust Parameters as required to suit your search type. Available Parameters are 
dependent on recorder type

9 Select Next. The Confirmation screen displays. Confirm your search criteria are correct. 
Select Previous to return to the previous screen to make changes. Select Finish to 
execute the search
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10 Search and Retrieval Wizard closes and the Advanced Search Results tab opens 
displaying search results. Double click on a search result to view associated video

- End -

Perform a Video Intelligence Search

VideoEdge NVR recorders support Search Analytics. This gives users the ability to detect, track 
and analyze moving objects using a variety of criteria. Refer to the table below for further 
information on the various types of Video Intelligence searches and which versions of VideoEdge 
NVR support them.

In order to perform Video Intelligence searches, this must be enabled on the recorder and in some 
cases, on the specific camera required. Refer to the VideoEdge NVR User Manual for further 
information.

Advanced 
Search 
Type

Description Search Parameter(s) VideoEdge 
Version 

Supported

Object 
Detection

Find objects that move into a 
region of interest. This is similar 
to a normal motion detection 
search except that it only finds 
objects the first time they enter 
the region.
If the objects leave the camera 
view and return, the search will 
find them again.
Draw a region that covers the 
area to be searched for objects.
Use a higher overlap setting to 
find objects that are mostly within 
the region, use a lower setting to 
find objects that just brush the 
edge of the region.

Overlap (Sensitivity Level) - A 
lower value will return more 
results.

4.2+

Direction Find objects moving in a certain 
direction through a region of 
interest. 
Set the general direction of 
motion to search for, and the 
maximum amount of time the 
object can take to traverse most 
of the region (this excludes 
objects which move too slowly).
Draw a thin region in the 
direction of motion required. Use 
a lower overlap setting to find 
objects moving in the general 
direction but not necessarily in 
the region.

Overlap (Sensitivity level) - A 
lower value will return more 
results.

Traversal Time - Maximum time 
an object can take to traverse the 
region.

Direction of Motion - The 
direction, North, South, East or 
West which the object is moving.

4.2+
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Linger Find objects lingering in a region 
of interest. An object is lingering 
if it is mostly stationary.
Set the minimum amount of time 
an object must linger before 
being included in the results.
Draw a region in the area to be 
searched for lingering objects.
Use a higher overlap setting to 
avoid finding objects lingering 
nearby.

Overlap (Sensitivity level) - A 
lower value will return more 
results
Linger Time - Minimum amount 
of time an object lingers before 
being included in results.

4.2+

Enter Find objects entering a camera 
view through a doorway or 
threshold. 
Draw a region containing the 
doorway or threshold and any 
area around it through which 
objects can be seen (like glass). 
Also include any area through 
which the door (if there is one) 
might move. This search 
excludes objects that can be 
seen through the doorway or 
threshold but do not pass 
through it.

Overlap (Sensitivity level) - Use 
a higher overlap setting for best 
results.

4.2+

Exit Find objects exiting a camera 
view through a doorway or 
threshold.
Draw a region containing the 
doorway or threshold and any 
area around it through which 
objects can be seen (like glass). 
Also include any area through 
which the door (if there is one) 
might move. This search 
excludes objects that walk up to 
the doorway but do not pass 
through it.

Overlap (Sensitivity level) - Use 
a higher setting to avoid finding 
nearby changes or changes 
which are not completely within 
the region

4.2+

Abandoned/
Removed

Use this search to find when a 
stationary object was placed, 
moved or removed. The amount 
changed lets you search for 
larger or smaller changes in the 
region. 
The within setting specifies over 
what time period changes can 
occur (0 seconds = 
instantaneous change).
Draw a region that contains all of 
the area that you wish to search 
for changes, and use a higher 
overlap setting to avoid finding 
nearby changes or changes that 
are not completely in the region.

Overlap (Sensitivity level) - Use 
a higher overlap to avoid finding 
nearby changes or changes that 
are not completely in the region

Amount Changed - Adjust to 
look for a larger or smaller 
change in the region.

Within - Timeframe within which 
the change occurs.

4.2+

Face 
Detection

Use this search to find when a 
face is present in video.
Draw a region that contains all of 
the area that you wish to search 
for faces and use higher overlap 
settings to avoid finding faces 
nearby.

Overlap (Sensitivity level) - Use 
a higher overlap to avoid finding 
nearby faces or faces that are 
not completely in the region

4.4+

Advanced 
Search 
Type

Description Search Parameter(s) VideoEdge 
Version 

Supported
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Procedure 12-4  
Perform a Video Intelligence Search

Step     Action

1 Select Search and Retrieve from the Home tab

2 Select Execute Search Wizard. The Search and Retrieval Wizard launches

3 Select required Video Intelligence search type from the Type of Search drop down menu

4 Drag and drop camera(s) from the Device, Site or Vault list onto the Camera Selector 
Pane

Note

If selecting cameras from the Vault List, Date and Time parameters are 
automatically populated

5 Specify Date and Time parameters in the Date and Time Pane

Note

Selecting Specific Range also allows selection of Time Filter options. Time Filter 
options can be used to specify a sub-set of time to search. For example, only 
search between 9am and 5pm. Select the Time Filter checkbox to enable

6 Select Next. The Search Parameters screen displays

Note

The video stream reverts to the start time selected for the search. To view live 
video, select 

7 Select the required Draw Style and draw a Region of Interest (ROI):

• Polygon: Draw a polygon by clicking once on the image and dragging the 
cursor to form a line. Complete a line by clicking again. Repeat to form the ROI.
Double click when the shape is complete to finalize the search area. Use Clear 
to restart drawing and Erase to correct errors.

• Rectangle: Highlight the ROI by clicking and dragging the cursor over the 
camera view to form a rectangle. Use Clear to restart drawing and Erase to 
correct errors.
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• Free Draw: Draw the ROI freehand on the camera view. Use Clear to restart 
drawing and Erase to correct errors.

Note

1. By default the ROI drawn is the Active Region, this can be inverted by 
selecting Invert Selection.
2. The full camera view can be selected as the Active Region by selecting Select 
All.
3. Load Alarm Rule allows you to load a previously configured rule from a 
VideoEdge NVR 4.2+ recorder (Not available on Face detection and edge 
analytics searches). victor uses information from the NVR rule to apply search 
criteria to the victor client search. Search parameters are populated from the rule 
but can be edited if required. Refer to Alarm Rules for more information on alarm 
rules.

8 Adjust Parameters as required to suit your search type. Available Parameters are 
dependent on Video Intelligence search type selected

9 Select Next. The Confirmation screen displays. Confirm your search criteria are correct. 
Select Previous to return to the previous screen to make changes. Select Finish to 
execute the search

10 Search and Retrieval Wizard closes and the Advanced Search Results tab opens 
displaying search results. Double click on a search result to view associated video

- End -

Alarm Rules

Alarm Rules allow users to load previously configured searches into victor Search and Retrieval 
Wizard. When loaded, Alarm Rules will automatically populate the Region of Interest along with 
additional Search Parameters. This feature enables users to store commonly used searches in 
order to speed up repeated searching. 

Alarm Rules are only supported on VideoEdge 4.2+ recorders.

Save Search as Alarm Rule

As well as using alarm rules defined within the NVR, you can also create new alarm rules using 
criteria defined in specific victor searches. These alarm rules display in the Load from Alert Rules 
list in the Search and Retrieval wizard when the camera they have been saved against is selected.

Procedure 12-5  
Save Search as Alarm Rule

Step     Action

1 Perform a Motion Detection or Video Intelligence search.

2 Select . Save Search as Alert dialog displays.

3 Enter a name for the saved search in the Alert Name textbox.
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4 Select OK. The search is saved as an alarm rule and will be available for selection on 
Motion Detection or Video Intelligence searches.

- End -

Load Alarm Rule

Load Alarm Rule allows you to load a previously configured alarm rule from a VideoEdge NVR 
4.2+ recorder. victor uses information from the NVR rule to apply search criteria to the victor client 
search. Search parameters are populated from the rule but can be edited if required.

Note

Load Alarm Rule feature is not available on Face Detection or Edge Analytic searches

Procedure 12-6  
Load Alarm Rule

Step     Action

1 Select Search and Retrieve from the Home tab

2 Select Execute Search Wizard. The Search and Retrieval Wizard launches

3 Select Motion Detection or required Video Intelligence search type from the Type of 
Search drop down menu

4 Drag and drop camera(s) from the Device, Site or Vault list onto the Camera Selector 
Pane

Note

If selecting cameras from the Vault List, Date and Time parameters are 
automatically populated

5 Specify Date and Time parameters in the Date and Time Pane

Note

Selecting Specific Range also allows selection of Time Filter options. Time Filter 
options can be used to specify a sub-set of time to search. For example, only 
search between 9am and 5pm. Select the Time Filter checkbox to enable

6 Select Next. The Search Parameters screen displays

7 Select required Alarm Rule from the Load from Alert Rules list

8 Search parameters are populated with Alarm Rule parameters. If required, edit search 
parameters

9 Select Next. The Confirmation screen displays. Confirm your search criteria are correct. 
Select Previous to return to the previous screen to make changes. Select Finish to 
execute the search
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10 Search and Retrieval Wizard closes and the Advanced Search Results tab opens 
displaying search results. Double click on a search result to view associated video

- End -

Investigator Mode

Launching Investigator Mode opens a new Guard window with the selected, main video stream in 
paused mode occupying the upper left pane

This mode allows you to drag in up to 5 other streams, each will automatically pause at the same 
time as the selected stream, enabling a time synchronized view of all cameras.

Note

Investigator mode can be launched from any surveillance view and is also available from the 
Search Results window.

Procedure 12-7  
Launch Investigator Mode

Step     Action

1 Select the main video stream from which to launch Investigator mode. Yellow border 
displays around pane indicating instant playback is available.

2 Select . Investigator mode launches in a new window.

3 Drag in other cameras as required. These video streams are paused at the same point as 
the main video stream.

4 Select Playback controls as required to navigate the video streams simultaneously.

- End -

Export Search Results

You can export search results as a grid in Microsoft Excel (.xlsx) or .xps formats.

Procedure 12-8  
Export Search Results

Step     Action

1 Perform a search using the Search and Retrieve Wizard. Results display in the Search 
Results window.

2 To export the search results:
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• In Excel format select .

• In .xps format select 

3 Navigate to the Save in folder as required.

4 Select Save.

- End -

Quick Search and Retrieve

Quick Search and Retrieve can be used to retrieve recent footage from a single camera. Quick 
Search and Retrieve can jump backwards 30 seconds, 1, 5, 10, 30 or 60 minutes. To perform a 
search with more defined time parameters, refer to Perform a Basic Search.

Procedure 12-9  
Quick Search and Retrieve

Step     Action

1 Navigate to the camera on the device list and right click
or
Right click the surveillance pane for that camera.

2 Select Search and Retrieve. Available time intervals display.

3 Select required time interval. Search results window displays.

4 Search result displays when download is complete.

- End -
81



Search and Retrieve  
Jump to Next/Previous Alerts or Results

The Jump to Next/Previous results buttons allow for navigating alerts and video search results.

This feature is available for alerts when in instant playback mode, the required alert types are 
enabled and alerts are available. It is available for search results whenever there are multiple 
results available.

Search results and Alert types are selectable via the combo box . 

Search results are only enabled when results of a previous advanced search are available.

If viewing multiple video streams and alarms are triggered on more than one camera, Jump To 
actions mirror the order of alarms in the journal.

Procedure 12-10  
Jump to Next/Previous Alerts or Results

Step     Action

1 If viewing Alerts, Use  to select the Alert type.

2 Select  to Jump to the Next Result/Alert

3 Select  to Jump to the Previous Result/Alert

- End -
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Introduction

Clips are segments of video and audio that are stored remotely from their original recorder.

Clip Creation

Clip creation tools can be used to define start and end times for video clips from any surveillance 
window. After creation, you can then choose to Export (locally or remotely), Save, Archive or Vault 
the video clip.

Procedure 13-1  
Create a Clip

Step     Action

1 Select the video pane from which to create the clip.

2 Navigate to the start time from which to create the clip.

3 Select . Clip Start time is set.

4 Select  when the video stream reaches the end time of the clip to be created.

5 Select . Direct Clip Action dialog displays. From the Direct Clip Action dialog, the 
clip can be vaulted, saved or exported. For more information, refer to Vault, Save and 
Export Clips

- End -

Clip Start Time Clip Export

Clip Stop Time
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Vault, Save and Export Clips

Once a clip has been created, it can then be vaulted, saved, exported or archived from the Direct 
Clip Action dialog. For more information on creating a clip, refer to Clip Creation. Additionally, 
clips that have previously been created and saved can then be exported.

Vault Clips

Vaulting a clip tags it as protected, preventing it from data culling. 

Note

Vaulting is only supported on VideoEdge NVR 4.2+ recorders.

Procedure 13-2  
Vaulting a Clip

Step     Action

1 Create a clip using Procedure 13-1 Create a Clip. Direct Clip Action dialog displays

2 Select Vault. Progress bar displays showing progress of vaulting

3 Vaulting Complete message displays

- End -

Save Clips

By default, clips are saved locally to C:\ProgramData\American Dynamics\victorclips. This location 
can be changed in System Values where Remote Directories can also be specified.

Procedure 13-3  
Saving a Clip

Step     Action

1 Create a clip using Procedure 13-1 Create a Clip. Direct Clip Action dialog displays

2 Select Save. Saving location options display

3 Edit the clip name by selecting the Clip Name textbox and entering text as required

4 If required, enter notes in the Notes textbox

5 Select Local or Remote as Clip Saving Location

6 Select a clip folder to save to

7 Select Save. Progress bar displays showing progress of saving

8 Saving Complete message displays

- End -
84 victor 4.4 Installation and Configuration Guide



Clips
Export Clips

Clips can be exported to external media. Clips can be exported in .img, .iso (playable through 
victorPlayer) and .avi/.mp4 formats. Clips can be exported as part of the creation process or they 
can be exported from a previously saved clip.

Note

Exporting Clips is only available in Live Mode for HDVR recorders

Procedure 13-4  
Exporting a Clip

Step     Action

1 Create a clip using Procedure 13-1 Create a Clip. Direct Clip Action dialog displays

2 Select Export. Export location options display

3 Select export location(s):

• Select  to add more export location(s)

• Select  to select the export location(s)

• Select  to remove the export location(s)

4 If prompted, enter and confirm a Passphrase

5 If required, select the Download Audio checkbox

6 If required, select the Export victorPlayer checkbox. For more information on 
victorPlayer, refer to victorPlayer

7 If required, select the Specify Filenames checkbox

8 Select Native or AVI/MP4 as file format

9 If required, select the Notes tab and enter notes

10 Select Export. If Specify Filenames was selected at Step 7, proceed to Step 11. If 
Specify Filenames was not selected at Step 7, proceed to Step 12

11 Enter filename as required in the Filename textbox. Use  to insert Start Time, End Time 
or Camera Name. Select Export

12 Progress bar displays showing progress of exporting

13 Exporting Complete message displays

- End -

Procedure 13-5  
Export a Previously Saved Clip

Step     Action

1 Select Clips from the Home tab.

2 Select Show All. Clip folders are displayed.
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3 Expand the required clip folder.

4 Right click the clip to export.

5 Select Export Clips. Direct Clip Action dialog displays.

6 Select Export

7 Select export location(s):

• Select  to add more export location(s)

• Select  to select the export location(s)

• Select  to remove the export location(s)

8 If prompted, enter and confirm a Passphrase

9 If required, select the Download Audio checkbox

10 If required, select the Export victorPlayer checkbox. For more information on 
victorPlayer, refer to victorPlayer

11 If required, select the Specify Filenames checkbox

12 Select Native or AVI/MP4 as file format

13 If required, select the Notes tab and enter notes

14 Select Export. If Specify Filenames was selected at Step 11, proceed to Step 15. If 
Specify Filenames was not selected at Step 11, proceed to Step 16

15 Enter filename as required in the Filename textbox. Use  to insert Start Time, End Time 
or Camera Name. Select Export

16 Progress bar displays showing progress of exporting

17 Exporting Complete message displays

- End -

Archive Clips

Clips from VideoEdge NVR 4.4+ recorders can be archived for long term storage. For more 
information on archiving and how to set it up on your VideoEdge NVR recorder, refer to the 
VideoEdge NVR 4.4 Installation and User Manual.

Procedure 13-6  
Archiving a Clip

Step     Action

1 Create a clip using Procedure 13-1 Create a Clip. Direct Clip Action dialog displays

2 Select Archive. Progress bar displays showing progress of archiving

3 Archiving Complete message displays

- End -
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Clip Storage

Saved Clips are displayed and selectable from the Clips window.

Procedure 13-7  
Organize Clip Folders

You can create, rename and build folder structures for clip storage. This allows you to meaningfully 
organize local clip storage

Step     Action

1 Select Clips from the Home tab

2 Select Show all from the dropdown menu. Clips window displays in device list tab group, 
displaying all saved clips 

3 The following right click options are available:

• Refresh Folder

• Rename Folder

• Delete Folder

• Export Folder

• New Folder

4 Use right click options as required to organize folders

- End -

Procedure 13-8  
View/Edit Saved Clip Notes 

Notes can be stored against clips when they are saved or exported. These notes can be viewed 
and/or edited from the Clips window for saved clips.

victorPlayer supports note viewing for exported clips

Step     Action

1 Select Clips from the Home tab

2 Select Show all from the dropdown menu. Clips window displays in device list tab group, 
displaying all saved clips

3 Select required clip. Notes for selected clip are displayed in the Notes textbox

4 If required, select Notes textbox and edit notes

5 Select  to save

- End -
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View and Delete Saved Clips

Saved clips can be viewed and deleted as required.

View Saved Clips

Procedure 13-9  
View Saved Clips

Step     Action

1 Select Clips from the Home tab

2 Select Show all from the dropdown menu. Clip folders are displayed

3 Right click the clip to be played

4 Select Playback Clips. The clip displays in a new window

5 Select  to enable audio. Use playback controls to navigate clip

- End -

Delete Saved Clips

When saved clips are no longer required, they can be deleted.

Procedure 13-10  
Delete Saved Clips

Step     Action

1 Select Clips from the Home tab

2 Select Show all from the dropdown menu. Clip folders are displayed

3 Expand the required clip folder

4 Right click the folder to be deleted

5 Select Delete Clips. A Warning dialog displays. Select Yes to delete the clip or No to 
cancel

- End -
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victorPlayer

victorPlayer is a proprietary media player developed by American Dynamics. It is a portable 
application and is required to play .img files from Intellex recorders. victorPlayer can also be used 
to playback clips in the following formats:

• .ISO (from VideoEdge NVR recorders)

• .ZIP (from HDVR recorders)

• .IMG (From Intellex Recorders)

victorPlayer can also be included with exported clips.

Playing Clips

The primary purpose of victorPlayer is to facilitate clip playback.

Note

victorPlayer has various options during clip playback. In addition to the standard surveillance 
playback controls, you can also: Toggle Full Screen, Clear Video, Restart Playback, Verify 
Clips (Standard and using Key files) and perform Still Image Capture by right clicking the 
playback window.

Procedure 13-11  
Play Saved Clip with victorPlayer

The following steps assume that victorPlayer is available on the local machine. If it is not 
available, it can be exported as part of victor’s clip export feature. For more information on 
exporting clips, refer to Procedure 13-4 Exporting a Clip.

Step     Action

1 Launch victorPlayer, select required language then select OK

2 Saved clips are displayed in the clip list

3 Drag and drop the required clip into the surveillance window. The clip will begin playback

Note

To view more than one clip at one time, select View Surveillance from the View 
menu to open additional surveillance panes

- End -
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Procedure 13-12  
Play External Clips with victorPlayer

In addition to using victorPlayer to play clips from the clip list, victorPlayer can also play external 
video clips.

Step     Action

1 Launch victorPlayer select required language then select OK

2 Select File

3 Select Open. Select clip file to open dialog displays

4 Browse to the clip to be opened

5 Select Open

6 Drag and drop the required clip into the surveillance window. Clip will begin playback

Note

To view more than one clip at one time, select View Surveillance from the View 
menu to open an additional surveillance pane

- End -

Configuring victorPlayer

victorPlayer’s Overlay and Layout settings can be configured as required. 

Overlay settings can be configured by selecting Overlay Settings from the View menu, selecting 
required elements then selecting OK.

To save your current layout, select  then choose a location and select Save. To load a 
previously saved layout select Load from the Layout menu, locate the saved layout and select 
Open.
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Verifying Clips

Exported clips can be checked for authenticity by using the Verify Clip tool. The tool checks 
whether the clip has been tampered with. In addition to verifying exported clips in victor client, clips 
can also be verified in victorPlayer.

Note

Only exported clips can be verified.

Procedure 13-13  
Verify Exported Clip

Step     Action

1 Select Clips from the Home tab

2 Select Verify. Browse dialog displays

3 Browse for and select the clip to be validated

4 Select Open

5 If prompted, enter the passphrase associated with the clip. This is the passphrase entered 
at the time the clip was initially created

6 Select Validate. Clip Validator displays informing whether clip is valid

Note

The clip validator also offers the ability to Validate with Key File (NVR Only)
This verification method checks for integrity using a key file generated on the NVR to verify 
exported and archived clips which were signed using a private key

- End -

Procedure 13-14  
Verify Clips in victorPlayer

Step     Action

1 Launch victorPlayer

2 Drag and drop the clip to be verified into the Surveillance window

3 Right click on the video pane

4 Select Verify Clip

Note

If the clip has been exported from an HDVR or NVR unit, you will be prompted to 
enter a Passphrase
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5 The Clip Validator dialog displays informing whether clip is valid

Note

Right clicking the video pane also offers the ability to Verify Clip Using key File 
(NVR Only)
This verification method checks for integrity using a key file generated on the NVR 
to verify exported and archived clips which were signed using a private key

- End -
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Introduction

The Maps feature provides a dynamic view of physical security objects within a visual 
representation of their environment.

Physical objects are represented by icons to form an integrated, unified view allowing monitoring 
and reaction to state changes in real time.

Real-time visualization of event activity can be achieved by linking Map actions to Events.

Map File Types/CAD Layers

Supported Image files are:

• *.dwg / *.dxf (Vector)

• *.png / *.jpg (Raster)

Note

1. victor automatically converts vector graphics to .jpg and stores them in the database.
2. CAD Layers: Only CAD Layers visible at the time of import are visible within the image in victor. 
However, once imported, new layers can be added to the converted CAD image and used to 
configure icons. The actual CAD layers do not exist in victor.
3. Map Image files can be updated without disassociating the icons which were previously placed 
on the map.
4. victor supports image files up to 20 MB
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Importing Map Images

To store an image file on the database, you need to import and save an image file. These 
procedures describes the basic steps to import and save an image file as a Map. The map then 
needs to be configured. 

Procedure 14-1  
Import a Map Image

Step     Action

1 Select Maps from the Build tab.

2 Select New from the dropdown menu. New Map editor displays.

3 Enter a name for the map in the Name textbox.

4 Enter a description for the map in the Description textbox.

5 The Enabled checkbox is selected by default, deselect to disable the map.

6 Select . Select Drawing File dialog displays.

7 Select . Browse window displays.

8 Browse to and select the required image file.

9 Select Open.

10 Select Import. File imports and displays in map editor.

11 Select Save.

- End -

Procedure 14-2  
Export CAD File

A CAD file (.dwg or .dxf) can be exported from victor as a .jpg file. This enables CAD files to be 
exported, edited as required then imported for use as a map.

Step     Action

1 Select Maps from the Build tab.

2 Select New from the dropdown menu. New Map editor displays.

3 Enter a name for the map in the Name textbox.

4 Enter a description for the map in the Description textbox.

5 The Enabled checkbox is selected by default, deselect to disable the map.

6 Select . Select Drawing File dialog displays.

7 Select . Browse window displays.

8 Browse to and select the required CAD file.

9 Select Open

10 Select Export to File. Save As dialog opens
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11 Navigate to the location you want to export to and enter a File Name

12 Select Save

- End -

Procedure 14-3  
Remove Blank Space from CAD Drawing

While importing a CAD file (.dwg or .dxf), victor can remove any vertical blank space surrounding 
your image. 

Step     Action

1 Select Maps from the Build tab.

2 Select New from the dropdown menu. New Map editor displays.

3 Enter a name for the map in the Name textbox.

4 Enter a description for the map in the Description textbox.

5 The Enabled checkbox is selected by default, deselect to disable the map.

6 Select . Select Drawing File dialog displays.

7 Select . Browse window displays.

8 Browse to and select the required CAD file.

9 Select Open

10 Hover over the imported CAD drawing and use the mouse scroll wheel to zoom in on the 
image, removing the blank space surrounding it

11 Click Refresh

12 Select Import. File imports, preserving removed blank space and displays in map editor.

13 Select Save

- End -
95



Maps  
Configure Maps

Once an image has been imported to create a map, the map can then be configured for use by 
adding map layers and icons.

Map Layers

victor Maps implement a layers feature that enables users to manage object types within one map. 

Procedure 14-4  
Add and Configure Map Layer

Step     Action

1 From the Map editor select . Map Layers editor displays

Note

The Map editor can be accessed by selecting Maps from the Build tab, then 
selecting Show All. Right click on the map to be edited and select Edit

2 Select Add . A new layer will be added to the Map Layers editor

3 To rename the new layer, select the Layer textbox and edit as required

4 Use the Show in map checkbox to select if the later is displayed on the map

- End -

Map Icons

Procedure 14-5  
Add and Configure Icons

Note

Steps 11- 17 are optional.

Step     Action

1 From the Map editor select . Icon Selector editor displays

Note

The Map editor can be accessed by selecting Maps from the Build tab, then 
selecting Show All. Right click on the map to be edited and select Edit

2 Select the icon which matches the object to be added to the map

3 Select OK. The icon displays centered on the map

4 Drag and drop the icon to the required position
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5 To resize the icon, hover on the icon until the hand cursor ( ) displays then scroll up to 
increase or scroll down to decrease

6 To resize the ellipse (the highlight area around an icon), hover on the ellipse until the scroll 
origin cursor ( ) displays then scroll up to increase or scroll down to decrease

7 To orientate the icon, hover over until the scroll origin cursor ( ) displays then click and 
drag to rotate the icon

8 To mirror the icon, right click on it and select Mirror Image. The icon image will mirror

9 When the icon, and its ellipse, are positioned, sized and orientated as required, right click 
and select Drop on Map. Icon Editor displays

10 Select Select Object, the Object Selector displays

11 Select the object you wish to link to the icon and select OK, further options open in the 
Icon Editor 

12 Select  next to Assign left-click action. A context menu displays

13 Select your required left-click action

14 Select an image from the Assign Images pane.

Note

Assign Images pane is used to specify if you want the icon to change to reflect its 
current state. By default, all images are set to show changes.

15 Select the Include icon shadow checkbox to display a shadow behind the icon

16 Select the Show Dynamic Text checkbox to display dynamic text with the icon. Select 
Font Size and Property from the drop down menus. Select the Include journal 
messages to include journal messages with dynamic text

17 In the Assign alerts section, the Annunciation and Color drop down menus can be 
edited to set how alerts are displayed by the icon

18 Click OK

19 Select Save

- End -
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Procedure 14-6  
Configure an Area

victor Maps allows for the configuration of areas in order to group icons. Should any icons related 
to an area go into Alert status, the entire area will highlight (this applies to icons where 
annunciation is set to Strobe, Pulse, Blink, Fade or Flash only.)

Note

If another Map is added as an icon and then included in an area, when an icon on the Map goes 
into alert, the area will go into alert in the same frequency and color.

Step     Action

1 From the Map editor, hold the Shift key and draw the required area using your mouse

Note

The Map editor can be accessed by selecting Maps from the Build tab, then 
selecting Show All. Right click on the map to be edited and select Edit

2 The area can be manipulated by using the grab handles

3 The drawn area can be further manipulated by right clicking and selecting from:

• Select all related icons

• Clear all related icons

• Hide this shape drawing

• Remove this shape drawing

• Send to back

• Bring to front

- End -

Viewing Maps

Once a map has been created and saved, it can be viewed directly from the Home tab.

Procedure 14-7  
View Maps

Step     Action

1 Select Maps from the Home Tab

2 Select the map you wish to view from the dropdown menu. Map opens 
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3 The map can be manipulated using toolbar buttons, as detailed below:

Note

When viewing a map, the toolbar will display green. If the toolbar displays red, this 
means that the map has been edited and saved since it was opened. Please close 
and reopen the map to see any changes.

Element Details

Zoom controls - displays current zoom level 
percentage along with Fit to Window and 
Zoom Out/In buttons

Hide Icon Types - opens the Hide Type 
editor which allows selection of icon types to 
hide, e.g. Cameras or Recorders

Show All Icons from All Layers - shows 
and highlights all icons from all visible layers.

Note: icons that are on layers that have been 
hidden using the Map Layers editor will not 
be displayed

Show All Shapes from All Layers - shows 
all configured areas from all visible layers. 
Right-click to display FoV or Shapes only.

Note: areas that are on layers that have 
been hidden using the Map Layers editor will 
not be displayed

Activity List - opens a map specific Activity 
List that displays the 100 most recent 
activities relating to objects on the map.
Icon will display with a red border when there 
are unread items in the Activity List.
Right click and select Clear to clear the 
activity list. Select the padlock icon to freeze 
the Activity List for 30 seconds

Layers - opens Map Layers editor allowing 
selection of map layers to show/hide

Hover Mode - select to enable hover mode. 
When enabled, hovering over objects will 
display additional information. For example, 
hovering over a camera will open a 
surveillance pane within the map view, 
displaying live video from the camera

Health Mode - select to enable health mode. 
When enabled, icons will be highlighted with 
their health status. When enabled with hover 
mode, hovering over icons will display the 
objects health dashboard within the map 
view
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Editing Maps

Once a map has been created and saved, its properties can be edited. 

Procedure 14-8  
Edit Maps (General)

Step     Action

1 Select Maps from the Build tab.

2 Select Show All.

3 Right Click the map to be edited.

4 Select Edit. Map editor opens.

5 Change Name, Description, Enabled status in General section as required.

6 Select Save.

- End -

Procedure 14-9  
Edit Maps (Map)

Step     Action

1 Select Maps from the Build tab

2 Select Show All

3 Right Click the map to be edited

4 Select Edit. Map editor opens. The map can be manipulated using the toolbar buttons, as 
detailed below:

Element Details

Import a map - reimport the map image

Increase/Decrease height of map window 

Fill image in window - fit map to window

Zoom Out/In 

Fill on load - when the map loads, fit map to 
window

Add Object Icon - add an object icon to the 
map
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5 Edit map elements as required

6 Select Save

- End -

Procedure 14-10  
Edit Maps (Map Icons)

Once an icon has been added to a map, its properties can be edited or copied to create a new 
map icon. The options available vary depending on the map icon type.

Step     Action

1 Select Maps from the Build tab

2 Select Show All

3 Right Click the map to be edited 

4 Select Edit. Map editor opens

5 Right click on the icon you wish to edit

6 Select required option from the right click menu

7 Make changes as required

Note

Selecting Copy from the right click menu will copy both the icon and all its 
properties (e.g. assigned object and assigned left click action)

8 Select Save

- End -

Copy Icon to Active Layer - copy an icon to 
the current active map layer

Show all icons from all layers - displays all 
icons from all layers of the map

Show all shapes from all layers - displays all 
shapes from all layers of the map. Right-click 
to display FoV or Shapes only

Active layer - the current active map layer

Layers - Show/Hide or Add/Remove layers

Hover - Enable/Disable hover in the map 
editor
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Field of View

A Field of View (FoV) can be attached to a camera icon on a map. FoV gives an indication of the 
area covered by a camera.

Procedure 14-11  
Attach Field of View to Camera Icon

Step     Action

1 Select Maps from the Build tab

2 Select Show All

3 Right Click the map to be edited

4 Select Edit. Map editor opens

5 Right click on the camera icon you wish to attach a FoV to

6 Select Field of View (FoV)

7 Select Add. The FoV editor opens

8 Edit FoV Angle value by selecting  to increase or  to decrease. You can also free 
type in the Angle field

9 Edit FoV Rotation value by selecting  to increase or  to decrease. You can also free 
type in the Rotation field

10 Edit FoV Scale value by selecting  to increase or  to decrease. You can also free 
type in the Scale field

11 Select OK to apply

12 The FoV can be further manipulated by right clicking and selecting from:

• Show FoV Control Window

• Annunciate with active alert (FoV will only annunciate if icon is set to Strobe, 
Pulse, Blink Fade or Flash)

• Hide this FoV drawing

• Remove this FoV drawing

• Send to back

• Bring to front

• Move shape when icon is moved

13 Select Save

- End -
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Copy Maps

An existing map can be copied to create a new map. The new map will be named ‘Original Map 
Name_Copy’. All map properties and object icons will also be copied.

Procedure 14-12  
Copy a Map

Step     Action

1 Select Maps from the Build tab

2 Select Show All

3 Right Click the map to be copied

4 Select Save As. A confirmation dialog opens

5 Select Yes

6 A new map will be created in the object list

- End -
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Introduction

The concept of Object Association refers to linking together otherwise unrelated objects with the 
intent of enhancing incident building capability.

The feature enables a ‘Review’ option on the context menu of associated objects. Selecting 
Review opens a guard surveillance view displaying the source object and up to 5 associated 
objects.

After associations are made, the Review feature is exposed in 3 areas of the client; Reports, Event 
Viewer and Activity List.

Note

1. Objects can reference other objects of the same type but cannot reference themselves.
2. Certain supported objects E.G doors, which do not display video, will not display the Guard 
surveillance view. In these cases, a Map view will open displaying the objects location if configured 
on Maps.
3. If a source object has no associations, selecting Review will return a view of the type.
4. If the source object is a non-video object and has no associations, the review feature will not be 
available for any related events or alerts.
5. For the feature to function properly, it is recommended all associated objects are synchronized 
to a common NTP server.

Typical Use Cases

1 Motion Alarm has been triggered and the associated Event Acknowledged. The user still 
needs to view video associated with the Alarm.
Without Object Association, reporting capabilities only show you the time of the alarm. 
The user must open a surveillance window, drag in the camera that caused the alarm and 
navigate back to the time of the alarm using the report data.
With Object Association, the user simply selects the Review option from the report item to 
perform all the above functionality automatically.

2 Building on Use Case 1, if there are more cameras associated with the alarm.
Without Object Association the user must find them and drag each camera individually 
into a surveillance window and navigate to the time of the alarm.
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With Object Association, the Review feature launches investigator mode and displays all 
associated camera views.

3 Similar to 1 and 2 but related to Non Video devices E.G. Doors. If a door is forced and an 
event activated, the feature can be used to view video from associated cameras in the 
door’s vicinity.

Review Feature

The Review option is exposed in 3 areas of the client:

• Reports: When associations are configured, the source can be accessed from report items by 
selecting Review in the item’s context menu.

• Event Viewer: When associations are configured, behavior is similar to that of Reports but the 
source is the cause of the event. The source can be accessed by selecting Review in the 
context menu of the Event Viewer item.

• Activity List: When associations are configured, the source of the activity list items can be 
accessed by selecting Review from the context menu of Activity list items.

Create Object Associations

You can associate a maximum of 5 objects with any of the classes listed:

This procedure describes how to associate a video camera with other video cameras.

Procedure 15-1  
Create Object Associations

Step     Action

1 Select Devices from the Home tab. Device list displays.

2 Select  next to Recorders to expand the selection.

3 Select  next to the specific recorder.

4 Right click the camera to be edited.

5 Select Edit. Camera editor displays.

6 Expand the Associations section.

7 Select . Object selector displays.

8 Select the object to associate using the object selector.

9 Select OK.

Video Cameras DSC Partition/Zone

Doors MZX Panel/Point

Inputs/Outputs Simplex 4100 Panel/Point

Readers Salvos
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10 Select Save.

- End -
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Introduction

Dynamic Views are generally displayed using the Show All option from an object type’s pulldown 
menu.

These lists will generally contain at a minimum Names and Descriptions of available objects. 
Depending on the type of object being displayed, more information may be available by right 
clicking the column headers and displaying extra detail.

Sort/Filter Objects within Dynamic Views

You can sort objects within Dynamic Views by selecting field names.

Procedure 16-1  
Sort/Filter Objects within Dynamic Views

Step     Action

1 Select the required object type from the Setup or Build tab.

2 Select Show All. Dynamic View displays.

3 To Sort objects:

a Select a Column Header to sort by. Objects sort alphabetically.

4 To Filter Objects:

a Select the filter icon  from the required column header for which the data is to be 
filtered.

b Select the filter criteria from the dropdown menu. Dynamic View updates to reflect the 
selected filter.

- End -
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Custom Filters

You can apply custom filters to Dynamic Views to help find specific information or limit the scope of 
a list.

Procedure 16-2  
Apply Custom Filters

Step     Action

1 Display the Dynamic View.

2 Select the filter icon  from the required column header for which the data is to be 
filtered. Dropdown menu displays

3 Select Custom. Custom Filter Selection window displays.

4 Select Add Condition.

5 Select the operator from the Operator dropdown menu.

6 Select the operand from the Operand dropdown menu.

7 Select OK. The Dynamic View updates to reflect the filter criteria.

- End -

Object List - Group by Field

You can group Dynamic Views by field names using the Group By Area.

Procedure 16-3  
Object List - Group by Field

Step     Action

1 Display the Dynamic View.

2 Select the Group By Area. This is the solid bar under the Dynamic View Controls. Group 
By Area displays.

3 Drag column headers into the area. The Dynamic View updates to reflect the grouping.

4 Use the controls in the Group By Area to manipulate the view.

- End -
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Export Lists

You can export Dynamic Views in .XPS and Excel format.

Procedure 16-4  
Export Object Lists

Step     Action

1 Display the Dynamic View. Sort and Filter as required.

2 To export as a .xps document:

a Select  Export the Grid. Save As dialog displays.

b Navigate to the Save in folder.

c Change name of file as required in the File name textbox.

d Select Save. .xps file saves in selected location.

3 To export as an Excel document:

a Select  Export the Grid to Excel. If Excel is installed, it automatically loads the file. 
If Excel is not installed, a Windows dialog displays - select from the options 
displayed.

- End -

Create/Save Dynamic Views

After configuring a Dynamic View to display as required, you can save the view for later retrieval.

Procedure 16-5  
Create/Save Dynamic Views

Step     Action

1 Configure the Dynamic View as required.

2 Select Save the current grid configuration. Create/Save dialog displays.

3 Enter a name for the view in the Name textbox (Mandatory).

4 Enter a description for the view in the Description textbox (Optional).
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5 Select the Default checkbox if you require this view to be the default for displaying the 
dynamic views of this object type.

Note

To display a dynamic view which is not set as default, select Dynamic View on 
the Build tab and select Show All. Right click on the view and select Show the 
view.

- End -
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Introduction

Operators are users of the client. Each operator is assigned a role which describes their 
capabilities and privileges.

Operators are authenticated in one of two ways:

• Windows Authentication - requires an assigned Windows principal 
(domain/workstation name and username) which relates to a Windows OS 
account.

• Basic Authentication - victor Site Manager manages users accounts without 
the need for an assigned Windows principal or Windows OS account.

Create a New Operator

New operators can be added to the system.

Procedure 17-1  
Create a New Operator (Windows Authentication)

When using Windows to authenticate operator accounts, Windows credentials are checked when 
the operator logs in to the client. As such, operators will only be able to log in if they have been 
assigned a user account on both the client and site manager machines. If a domain controller is 
not being used, these accounts must be created manually and be logged into to activate them.

It is recommended that the role level assigned to the operator account, mirrors somewhat the role 
level assigned to the Windows user account.

Step     Action

1 Select Operator from the Build tab

2 Select New from the dropdown menu

3 Enter a name for the Operator in the Name textbox

4 Enter a description in the Description textbox

5 The Enabled checkbox is selected by default, to deactivate the operator profile, deselect 
the checkbox
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6 Select Windows Authentication

7 Enter Domain/Site Manager

8 Enter Username

Note

Username should correspond to a Windows username and should not be the 
same as the name of the PC

9 Select a Role from the Roles section

Note

Only one role may be assigned to each operator

10 Select Save

- End -

Procedure 17-2  
Create a New Operator (Basic Authentication)

When using basic authentication to authenticate operator accounts, victor Site Manager manages 
user accounts without the need for corresponding Windows user accounts.

Step     Action

1 Select Operator from the Build tab

2 Select New from the dropdown menu

3 Enter a name for the Operator in the Name textbox

4 Enter a description in the Description textbox

5 The Enabled checkbox is selected by default, to deactivate the operator profile, deselect 
the checkbox

6 Select Basic Authentication

7 Enter Username

8 Enter Password

9 Select a Role from the Roles section

Note

Only one role may be assigned to each operator

10 Select Save

- End -
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Remotely Log Operator Out of Workstation

Operators can be remotely logged out of particular workstations on the network.

Procedure 17-3  
Remotely Log Operator Out of Workstation

Step     Action

1 Select Devices from the Home tab

2 Select  next to Workstations to expand the selection

3 Right click the workstation you wish to log the operator out of 

4 Select Log Operator [operator username] Out. Warning dialog opens, prompting 
confirmation of the logout

5 Select Yes to log the operator out, or No to cancel

- End -

Change Single Sign-on Value

The log-in window will display at client start up only when the Single Sign-on option is set to 
‘False’; with Single Sign-on set to ‘True’, the Login window is bypassed and the server will rely on 
the current windows identity credentials from the Windows OS to establish a client connection.
This procedure describes how to change single sign-on values between ‘true’ and ‘false’.

Note

Depending on your UAC settings on Windows 7 the following procedure may vary slightly, you 
may be notified or asked for permission to continue before making changes to the file.

Procedure 17-4  
Change Single Sign-on Value

Step    Action

1 Navigate to ACVS.Enterprise.Client.Core.Host.exe.config file on the client machine. 
The default location for this file is C:\Program Files\Tyco\victorClient.

2 Right click the ACVS.Enterprise.Client.Core.Host.exe.config file.

3 Select Open. Message displays informing Windows cannot open this file.

4 Select Select a program from a list of installed programs.

5 Select OK. Open with...dialog box displays.

6 Select WordPad from the program list.

7 Select OK. File opens as a text document.
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8 Change single signon value to ‘True’ or ‘False’ as applicable

9 Select Save.

10 Close Windows.

- End -
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Introduction

Creating and implementing system events allows you to detect, monitor and record specific activity 
on the system.

A typical use may be to alert a user of motion detection on a camera covering a sensitive area.

In this scenario, an event could be configured to:

• Alert the user by visually triggering a Video Action associated with the event displaying video 
from other cameras in the area

• Trigger a map action showing the location of the of the camera in alarm state

• Create a high priority entry in the Journal requiring operator acknowledgement

Event Types

There are 2 main event types: Sensor based and Health based.

Sensor Based Events

These events, when triggered typically display predefined Event Actions. These are system 
actions, tied to events which are set to display when events are triggered. Examples of Event 
Actions can be video Salvos or Map actions.

The following general steps are involved in configuring a Sensor based event:

1 Add a trigger to the sensor device (EG Set motion detection on a camera)

2 Create the Event Action to be executed when the Event triggers

3 Create the Event

4 Associate the Event Action with the Event

5 Associate the Event with the Trigger
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Health Based Events

System Health events do not typically involve video actions as their primary use is not security 
based. Instead they are used to warn users of potential issues with system failure. A typical use 
may be to inform a user that an alarm has been received warning of CPU overheating.

Acknowledge and Clear Options

Acknowledge and Clear options can be configured for individual events. Configuring these settings 
determines whether an event requires extra user information to be entered in order to 
acknowledge or clear the event.

Options are:

• Require a Log Message to be entered when acknowledged

• Require a Log Message to be entered when Cleared

• Username and password required to acknowledge

• Username an password required to clear

Note

These credentials can be from any user who has permission to acknowledge and clear the event.

Event Templates

A number of Event Templates are predefined within victor, these can be used as a basis for 
configuring events of the type they relate to.

Log Messages

Log messages are typically used to clear and acknowledge events but can be entered manually 
written to the journal at any time.

Log messages can also be selected from a Predefined Message Log which can contain up to 
3000 user defined messages.

Event Priority Window

The Event Priority Window is a surveillance window which is used to view camera Call Up Actions 
associated with Events. The surrounding red border distinguishes the Event Priority Window from 
standard surveillance views.

It is a 2X2 configuration. Call up video is displayed according to the priority of the event it is 
associated with. Highest priority displays in the top left pane of the window, descending in priority 
to Top right, Bottom left and Bottom right.
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New events having a higher priority than those already displayed on will ‘Bump’ the lower priority 
windows. This will lead to lowest priorities dropping off when more than four streams attempt to 
display.

Video streams cannot be viewed in the Event Priority window unless triggered by an event.

The window must be open when the event triggers in order to view the camera call up; the event 
does not cause the window to open.

Create Event Actions (Video)

Event actions are the actions triggered by victor in response to specific events. These can be 
video actions: Preset, Salvos, Call ups, External Camera Alarms or Map actions.

Procedure 18-1  
Create Event Actions (Video)

Step     Action

1 Select Video Actions from the Build tab.

2 Select Video Action type from the dropdown menu.

3 Select New. Video Action editor opens.

4 Enter a Name and Description for the video action as required.

5 Select objects as required from the left pane and drag to the right.

Note

If creating a Salvo video action, choose from Select from Existing or Create New 
Salvo.

6 Select Save. Event Video action is created.

- End -
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Create Event Actions (Maps)

Event actions are the actions triggered by victor in response to specific events. These can be 
video actions: Preset, Salvos, Call ups, External Camera Alarms or Map actions.

Map actions can be configured to display when an event triggers to show a map of the event 
location and highlight the alarming object.

Procedure 18-2  
Create Event Actions (Maps)

Step     Action

1 Select Display Actions from the Build tab.

2 Select New from the dropdown menu. Display Map Action editor opens.

3 Enter a Name and Description for the Map action as required.

4 Select a Map.

a Select  to select from existing maps. Object Selector Displays.

or

b Select  to create a new map. Refer to Maps Chapter for further information.

5 Select the required map from the object column.

6 Select OK to confirm the selection or Cancel to Exit.

7 Select  to select Monitor. Object Selector displays.

8 Select the monitor to display the Map Action.

9 Select Save.

- End -

Create Events

Events can be created and configured from within the client.

Procedure 18-3  
Create Events

Step     Action

1 Select Events from the Build tab.

2 Select New from the dropdown menu. Event editor displays.

3 Enter a name for the event in the Name textbox.

4 Enter a description for the event in the Description textbox.

5 The Enabled checkbox is checked by default, uncheck to disable the event.
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6 Expand the Properties section.

7 Select the priority of the event from the Priority Dropdown menu.

Note

Each priority level is associated with a color which is made prominent in the Event 
viewer when the event is triggered.

8 Select Event Breakthrough if required. The default setting is disabled, enabling Event 
Breakthrough assigns priority to the event viewer when the event is triggered so over rides 
anything else the user is viewing.

9 Expand the Text Section.

a Enter Activate Text in the text box. This text will display in the event viewer, If you 
have the activity list open, this text displays as the event triggers.

b Enter Instructions for the user in the Instructions text box. These will be conveyed to 
the user when the event triggers.

10 Expand the Sounds section.

a Select the Play Sound When Active checkbox if an audible alarm is required when 
the event triggers.

b Select . The Select Sound dialog displays. Navigate to and select the required 
.wav file.

c Select Open. The sound is associated with the event and will play when the event 
triggers.

d Select OK.

Note

1. Only .wav sound files are supported.
2. The files must be located in the ...\\WINDOWS\Media folder. If a custom .wav 
file is required, copy it to this location.

11 Expand the Acknowledge and Clear Options section. Select or deselect checkboxes 
depending on how you require the event to be acknowledged and cleared.

12 Select Save.

- End -
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Events - Save As

Existing Events can be used as templates to create new events. This is useful if you need to create 
an event which is similar to but not identical to an existing one. The copy of the original event 
keeps all properties.

Procedure 18-4  Events - Save as

Step     Action

1 Select Events from the Home tab

2 Select Show All

3 Right click the event to be copied

4 Select Save As. The New Event is saved with the original name appended with ‘-Copy’. 
The event can be edited as required.

- End -
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Event Viewer - (General Information)

The Event Viewer is a dynamics display of system event activity, accessible from the Home tab. It 
is a real time list displaying active and acknowledged events.

From the event viewer you can:

• Acknowledge system events

• Clear system events

• Sort events according to priority

• View event details including instructions, causes and activation time

• Review associated video

• Group events by type

Note

1. When there are 2000+ events in either the Active or Acknowledged panes, 
paging buttons are displayed.
2. When paging buttons are in use, Acknowledge All and Clear All buttons work 
on a per page basis.
3. By default, 2000 events per page are displayed, this can be changed to 500 or 
100 by selecting the Page Size dropdown.

Active
Events

Acknowledged
Events
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Event Viewer - Sorting and Grouping

Using the grouping area of the event viewer, you can ‘Multi Level Group’ on any of the columns 
displayed. This means you can sort groups by more than one priority.

Procedure 18-5  
Event Viewer - Sorting and Grouping

Step     Action

1 Select Event Viewer on the Home tab. Event Viewer displays.

2 Select the Group By area. Area expands enabling column headers to be dragged into it.
The Group By area is the solid divider under the object list controls.

3 Click and drag a column header into the Group By area. Groupings update accordingly.

4 Multi Group the items by adding more column headers.

Note

By default, events are sorted by Name.

- End -

Event Viewer - Acknowledge/Clear Events

From the Event Viewer, depending upon role permissions, you can acknowledge and clear events 
individually or by group.

Depending upon Event settings, you may be required to enter username and password or log a 
message to acknowledge and clear events.

Actions relating to various buttons on the Event viewer are detailed below.

Group By area

Button Event Viewer Area Action

Top Level List (Active Pane) Acknowledge all events

Top Level List (Active Pane) Acknowledge and clear all 
events

Top Level List (Active Pane) Freeze/Unfreeze pane

Top Level List (Acknowledge 
Pane)

Clear all events
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Manually Activate Events

An Event can be activated manually rather than be activated by a trigger.

Procedure 18-6  
Manually Activate Events

Step     Action

1 Select Events from the Build tab.

2 Select Show all from the dropdown menu. All events display.

3 Right Click on the event to be activated.

4 Select Activate. The event will activate and trigger any associated actions.

- End -

Top Level List (Active and 
Acknowledged Panes)

Print

Event Group (Active Pane) Acknowledge all activations in 
event group

Event Group (Active Pane) Acknowledge and Clear all 
activations in event group

Event Group (Acknowledged 
Pane)

Clear all activations in event 
group

Event (Active Pane) Acknowledge individual event

Event (Active Pane) Acknowledge and clear 
individual event

Event (Acknowledged Pane) Clear individual event

Button Event Viewer Area Action
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Predefined Message Log

Predefined Log Messages can be created which can then be used when required to acknowledge 
or clear an event without needing to type text.

Messages are identifiable by their labels which are assigned when they are created. 

Labels and message fields are mandatory for every message created. Labels can be up to 100 
characters in length and messages up to 3000.

The language for each message can also be assigned, this means when a user logs a message, 
the messages available are filtered to provide current language messages only. To log a message 
in a different language, you must switch language in the client.

Procedure 18-7  
Create a Predefined Log Message

Step     Action

1 Select Predefined Message Log from the Build tab.

2 Select New from the dropdown menu. New Predefined Message editor displays.

3 Select the Language dropdown.

4 Select the language in which the message is to be displayed.

5 Double click the Label textbox.

6 Enter Label text as required. Double click the Message textbox.

7 Enter message text as required.

8 Select  to add additional messages or  to remove selected messages.

9 Select Save.

- End -
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Events Configuration

Event/Action Pairing Editor

You can assign actions to events in the Event/Action Pairing editor.

Note

Event/Action association can only be made in this editor.

Procedure 18-8  Events/Action Pairing

Step     Action

1 Select Event Setup from the Build tab

2 Select Event/Action Pairing from the dropdown. Editor opens

3 Double click the Events node and use the Object Selector to select events as required

Note

Note: 
If you require batch assigning of an Action to Events, select Combined View 
after adding all required Events

4 Select  in node of the Event you have added and use the Object Selector to assign 
Actions.

Object 
Selector

Events Node
Actions
Node

Events Actions

Current
zoom
iew

Object
selector

Object
selector
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5 Repeat as required. Use  to add and remove objects

6 Select Save

- End -

Event Setup

Events Setup provides a dynamic, visual editor (See Below) which can be used to batch link 
Actions, Alerts and Devices.

Procedure 18-9  Events Setup Editor

Step     Action

1 Select Event Setup from the Build tab.

2 Select Events Setup from the dropdown. Event Configuration window displays

3 Click the Devices node and use the object selector to select the device (Or drag and drop 
from the device list)

Note

Note: 
If you require batch assigning of Alerts and Actions to Devices, select 
Combined View after adding devices

Devices 
node

Devices

Alerts

Object 
selector

Actions

node

Alerts

Actions
node

Current
view

Page scroll/jump
controls

Object 
selector

Device
selector
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4 Select  in node of the device added and use the checkboxes in the dropdown to assign 
alerts as required

5 Select Add Alerts. Selected alerts are displayed under the Alerts node

6 Select  in the Alerts node and use the Object Selector to assign Actions

7 Repeat as required. Use  to add and remove objects

8 Select Save

- End -

Views

There are various tools and views available in both the Event Configuration editor and the Event 
Action Pair editor to enable associations, filtering and viewing of configurations.

Combined View

This view displays configurations common to all displayed objects. In the Event Setup editor, this 
view is used primarily when specific alert types are to be assigned to multiple devices.This view 
can be toggled with Split View (See below)

Split View

Toggled with Combined View, Split view displays configurations specific to all displayed objects 
and allows for more granular editing of specific configurations.

Get Records

You can use ‘Get Records’ to filter the configurations displayed in the editors by selecting the 
number of items per page, Sub Types of items and item Types to filter results.

Reset View

This button resets the editor to the default view, displaying no configurations.

Navigating the Editors

Each column is colored for easy identification during zoom actions using the mouse wheel.

Dropping object(s) expands the views to show the current alert configuration as shown below. A 
default View port is also available to provide a way to pan and zoom.

New Events and Actions can be added to existing or new alerts by selecting them from a popup 
menu which lists all supported alerts, as shown below:

Cloning existing configurations

Cloning provides a quick and easy way of assigning the Event Setup properties of existing 
configured devices to new devices. 

In Event Setup, assign existing configurations to new devices by dropping the new devices onto 
the existing devices you want to clone (In Combined View only). The configurations of the current 
devices are copied to the newly dropped devices.
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External Applications

Introduction

The Add External Applications feature allows users to add shortcuts to the Home tab so external 
executable files can be launched from within victor client.

A maximum of six external applications can be added.

Add External Applications

You can add a new button to the Home tab which launches any external application already 
installed on the client.

Note

External applications are not retained unless saved as part of a layout. If they are not saved as 
part of a layout, they will not be available if the client is restarted or another layout is selected.

Procedure 19-1  
Add External Applications

Step     Action

1 Select Add on the Setup tab. Selector displays.

2 Navigate to the .exe file of the application to be added.

3 Select the .exe file.

4 Select Open. The applications icon displays on the Home tab and the program will launch 
when the icon is selected (Role dependent)

- End -
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Edit Application Name

You can change the default name of an external application.

Procedure 19-2  
Edit Application Name

Step     Action

1 Right click on the application icon on the Home tab.

2 Select Edit Properties. Name textbox displays.

3 Edit the name of the application.

4 Select OK.

- End -

Remove External Applications

You can remove external application icons from the Home tab.

Procedure 19-3  
Remove External Applications

Step     Action

1 Right Click the Icon on the Home tab.

2 Select Remove. Icon disappears from the Home tab.

- End -
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System Values

Introduction

System Values allows for configuration of various system settings. System Values is available 
from the Setup tab.

Bandwidth Configuration

Bandwidth caps can be assigned to individual operators or to roles.

Open System Values from the Setup tab, then select Bandwidth Configuration. Bandwidth caps 
can be set against each operator and role.

Clip Preferences

Clip preferences can be set in relation to default clip length and local/remote saving locations.

Edit Default Clip Duration

Open System Values from the Setup tab, then select Clip Preferences. Set Default Clip 
Duration from the dropdown menu. Available options are: 30 seconds, 1 minute, 5 minutes, 10 
minutes, 30 minutes and 60 minutes.

Edit Clip Saving Locations (Local & Remote Directories)

Open System Values from the Setup tab, then select Clip Preferences. Default Local Directory 
can be set. Default Remote Directory can be set against each role.

Note

Default remote directory can be entered as a mapped drive path, it will be automatically converted 
into UNC (Universal Naming Convention) format.
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Custom Icons

Using the custom icons feature, you can assign non-default images as object icons. The icons can 
be assigned at both Type and Object level enabling specific objects to have a different icon to the 
object type.

Supported file types: JPG and PNG.

Maximum supported file size: 2MB

Procedure 20-1  
Assign Custom Icons

Step     Action

1 Select System Values from the Setup tab. System Values editor displays

2 Select Custom Icons. Type and object selectors display.

3 To assign custom icons at type level:

a Select the type from the Type dropdown. Default icons display. Multiple icons may 
display for each object type as the icons reflect object state.

b Select Change for the relevant icon. Open dialog displays.

c Navigate to and select New icon graphic.

d Select Open. New icon displays next to the object type.

e Select Save.

4 To assign custom icons at object level:

a Select . Object Selector displays.

b Navigate to the object.

c Select OK. New icon displays next to the object type.

d Select Save.

Note

Once Custom Icons have been applied, all client areas displaying object states 
(device list, site list, maps, etc.) should be refreshed to show updated icons.

- End -
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Database Settings

Various database archive settings can be configured using System Values database settings 
editor.

Open System Values from the Setup tab. Configure Archive, Events and Swipe and Show 
database settings as required.

Note

1. Archive threshold size can only be edited when using SQL Server Express
2. UNC (Universal Naming Convention) should be used when entering Archive directory backup 
path, e.g. \\servername\folder)

Double Password Protection

Double password protection adds an additional level of security across selected victor global 
functions, or selected individual objects. When attempting to access functions or objects that have 
double password protection enabled, the user will be prompted for the Username and Password of 
a second operator.

Open System Values from the Setup tab, then select Double Password Protection. Check 
required features to globally protect or select objects using the Object Selector to protect individual 
objects.

Note

In the case of conflict, object protection will override global function protection.

Email Preferences

Email settings can be configured in order to use the send still images feature. 

Open System Values from the Setup tab, then select Email Preferences. Enter required 
information and save. 

Note

1. SMTP - Simple Mail Transfer Protocol
2. FQDN - Fully Qualified Domain Name
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Journal Filter

The Journal Filter is used to regulate the amount of data being persisted to the site manager 
database by blocking/unblocking specific alert types.

Video Camera, Recorder Unit and Storage alerts can be blocked/unblocked, everything else will 
always be written to the database.

Procedure 20-2  
Using the Journal Filter

Step     Action

1 Select System Values from the Setup Toolbar.

2 Select Journal Filter. The Journal Filter editor displays.

To Add Type Exceptions:

a Select  in the Type Exceptions section. The Type selector dialog displays.

b Select the Device Type to be filtered.

c Select OK.

d Select the Type Exception. The row highlights blue.

e Select the Alert Category.

f Block or Unblock Alerts as required.

To Add Object Exceptions:

a Select  in the Object Exceptions section. The Object selector dialog displays.

b Select the Object type as required. The type’s objects display to the right.

c Select the Object(s). Use Select All/Clear All as required for multiple selections.

d Select OK.

e Select the Object Exception. The row highlights blue.

f Select the Alert Category.

g Block or Unblock Alerts as required.

Note

1. You can use  to Remove Type/Object exceptions as required.
2. To edit exceptions, select the exception and block/unblock alert types as 
required.

3 Select Save.

- End -
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POS Settings

When POS is installed, POS Settings are available and allow for configuration of default search 
settings and database management. 

Open System Values from the Setup tab, then select POS Settings. Here, database settings can 
be configured, along with the amount of time (in seconds) to be added as padding to search 
results.

Search Preferences

Search preferences can be configured to customise which lists (Site/Device/Vault) open with the 
Search and Retrieve Wizard, and which list opens on top.

Open System Values from the Setup tab, then select Search Preferences. Select checkboxes 
under Open with Wizard to choose which lists open with the Search and Retrieve Wizard. Select 
which list to open on top using the buttons under Top Most.

Video Layout Preferences

Video Layout Preferences allow configuration of which layouts are available for selection. 

Open System Values from the Setup tab, then select Video Layout Preferences. By default, all 
layouts are selected. Layouts that are selected are available for selection from the surveillance 
pane, virtual matrix and salvo editors. 

Video Preferences

Open System Values from the Setup tab, then select Video Preferences.

Surveillance Preferences

Various surveillance preferences can be configured here, including displaying times in UTC and 
hiding of virtual PTZ controls when in Picture in Picture mode.

Fisheye Lens Default Settings

Default behavior when using Fisheye lens should be set here. Use the dropdown menus to select 
default de-warped mode - ‘Rectilinear’ or ‘Panoramic’.

Third Party Application

Set which third party application should be used to edit still images. Select  then navigate to 
the executable file (.exe) for the preferred image editor.
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Video Overlay Preferences

Set font size and color for video overlay in relation to Camera/Recorder and Date/Time 
information.
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victor site manager

Introduction

victor site manager incorporates an industry-standard relational database used to manage and 
maintain a single record of:

• Authorized users/passwords.

• Associated recorders and cameras.

• Roles and permissions.

• Alarm and event journals.

• Client license status.

Only one victor site manager is required per site regardless of the number of recorders, clients or 
cameras connected. The site manager can be installed on the same PC as the client for smaller 
sites or on a separate server for larger sites.

The victor site manager stores data, operator profiles, role information, and tracking who, what, 
device status and when operators interact with your video network.

The site manager Server provides a single point of access for users to manage multiple recording 
devices. It utilizes SQL Server’s database functionality to provide authentication for client users, as 
well as central monitoring and administration of multiple recording platforms over a Wide Area 
Network (WAN).

The default site manager record is located at the <client> section of the ‘config’ file but up to 
twenty site manager records are supported. site managers can be added, deleted and edited 
using the site manager editor on the Build tab.

Add New site manager

You can Add, Edit and Delete site manager records using the site manager editor.

Note

Each victor client installation supports up to 20 site manager records.
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Procedure 21-1  
Add New site manager

Step    Action

1 Select Site Managers from the Build tab.

2 Select Edit from the dropdown menu. site manager editor displays.

3 Select . New blank record is created in site manager list.

4 Double click the Display Name text box.

5 Enter a Name for the site manager.

6 Double click the IP Address/Domain Name text box.

7 Enter IP Address/Domain Name as required.

8 Double click the Port textbox.

9 Enter the Port number as required (Port numbers 1026-65535 are supported).

10 Select the Default radio button if the site manager is to become the default.

Note

The default site manager refers to the site manager that the client automatically 
connects to when single sign on is turned ON. This is the site manager which will 
appear first on the site manager list of the login dialog.

11 Select Save.

Refer to Save and Close options for more information.

- End -

Edit site manager

You can Add, Edit and Delete site manager records using the site manager editor.

Procedure 21-2  
Edit site manager

Step    Action

1 Select Site Managers from the Build tab.

2 Select Edit from the dropdown menu. site manager editor displays.

3 Double click in relevant textboxes to edit values.
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4 Select Save.

Refer to Save and Close options for more information.

- End -

Show all site managers

You can view a list of all available site managers.

Procedure 21-3  
Show all site managers

Step    Action

1 Select Site Managers from the Build tab.

2 Select Show All from the dropdown menu. A list of all site managers displays.

- End -

Switch Site Manager

Procedure 21-4  
Switch Site Manager

You can switch the site manager victor client is connected to.

Step    Action

1 Select  from the client title bar. Operator log out dialog opens.

2 Select Log out. The client sign in dialog opens.

3 Select or enter the Domain from the Domain drop-down menu.

4 Enter Username in the username text box. 

5 Enter Password in the password text box. 

6 Select the site manager to switch to from the Site Managers dropdown.
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7 Select OK.

- End -

Change Default site manager

Procedure 21-5  
Change Default site manager

You can change the default site manager victor client connects to.

Step    Action

1 Select Site Managers from the Build tab.

2 Select Edit from the dropdown menu. A list of all site managers displays.

3 Select the Default radio button of the site manager you wish to make default.

4 Select Save.

Refer to Save and Close options for more information.

5 Close and restart victor client. You will now connect to your selected default site manager.

- End -

Delete site manager

You can delete site manager records from the system

Note


The default site manager cannot be deleted.

Procedure 21-6  
Delete site manager

Step    Action

1 Select Site Managers from the build tab.

2 Select Show All from the dropdown menu.
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3 Right click on the site manager to be deleted.

4 Select Delete. Are you sure you want to delete the specified object warning displays.

5 Select Yes to delete or No to cancel.

- End -
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Introduction

The vault feature provides the ability to protect media items (audio and video) from VideoEdge 
NVR 4.2+ recorders.

Vaulting an item applies a rule to a specific segment of media, tagging it as protected and 
preventing it from data culling.

Media can typically be vaulted from:

• Direct Export (Clips)

• Event Viewer - via Export Clip

• Activity List - via Right Click Investigate

• Search Result List - via Clip Export

• Map Viewer - via Export Clip

Note

Vault option is disabled when non supported recorders are selected and when both non supported 
and supported recorders are selected, a warning message is displayed.
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Vault List

All vaulted items are listed in the vault list.

From the vault list you can:

• Drag items into the Search and Retrieve wizard and use the vault criteria as a basis for a search. 
This selects the camera and Date and time.

Note

1. If a subsequent vaulted item belonging to the same camera is dragged into the 
search and retrieve wizard, it replaces the original selection and changes the 
search time frame accordingly.
2. If the vault item belongs to a different camera, a Yes/No dialog displays offering 
the option to override the timeframe and have both cameras selected.
3. You can also drag cameras and/or dates from the vault list into the wizard. This 
means one camera can contain multiple vaults. In these instances the time range 
is changed to have a start time of the earliest vault time and an end time of the 
latest.

• Drag items into a surveillance pane in which the items are treated as cameras.

• Double click items to launch investigator mode, paused at the item’s start time.

Hovering on each level of item in the Vault list displays a summary of what is contained in the level 
below.

Procedure 22-1  
Display the Vault List

Step     Action

1 Select Clips from the Home tab.

2 Select Vault List from the dropdown menu.

- End -

Vault Explorer

The Vault Explorer provides a means to filter vaulted items by Recorder, camera and time range.

It lists all recorders containing vaulted items, branching for each camera with vaulted data.

Procedure 22-2  
Locate items using the Vault Explorer

Step     Action

1 Select Clips from the Home tab.
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2 Select Vault Explorer from the dropdown menu. Vault Explorer displays.

3 Recorder Filter Section - Select the checkbox for each of the recorders to filter by. 
Cameras that are associated with the selection and have vaulted media display in the 
Camera Filter section.

4 Camera Filter Section - Select the checkbox(es) for each camera to filter by.

5 Select:

a Date/Time Filter - Select either Recorder Local or UTC.

b Date/Time Filter - Select Use Filter if required.

c Select Start and End time and Dates. Results display in Results section.

- End -
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Video Wall

Introduction

The Video Wall feature uses Client to Client Communication to enable layout components to be 
sent between displays attached to different workstations.

Note

This is a licensable feature.
Because victor Express is limited to a single client connection, Client to Client communication is 
not available.

In order to send components to a receiving client, the component must be open on the sending 
client, therefore the role of the sender must allow viewing of the layout component. Similarly the 
receiver’s role must allow viewing of the component.

Typically, components are sent between workstations using the ‘Send To’ feature of an objects 
context menu.

Configure Client to Client Communication (Workstations)

Client settings for client to client communication are configured in the workstation editor. These 
settings determine how a workstation behaves when a client to client request is received and Sent.

There a four main settings:

Setting Description

Local Removal After Sending This controls whether components sent from a 
workstation remain open on the sender’s 
workstation. 
Default is On
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Procedure 23-1  
Configure Client to Client Communication

Step     Action

1 Select Devices from the Home tab. Device List displays.

2 Select  next to Workstations in the Device List. All workstations are listed.

3 Right Click on the workstation to be edited.

4 Select Edit. Workstation editor displays.

5 Expand the Client to Client Communication section.

6 Select or Deselect the Checkboxes as required to configure the workstation.

7 Select Save.

- End -

Turn Off Client to Client Communication This controls whether a workstation automatically 
accepts or rejects requests. When selected, 
receiving workstations will not automatically accept 
components.
Instead, the sender is informed that the receiving 
workstation is configured to reject and asked 
whether to force the component.
If the component is forced, the receiver is asked 
whether to accept the request and select Yes or 
No.
The Sending workstation is informed that the 
receivers client to client communication is turned off 
in 2 ways:

• A Reject Dialog displays when attempting to 
send.

• Receiver’s Name highlights Red.
Default is Off

Maximize on Primary Monitor This controls whether a received component 
displays Full Screen.
Default is On

Agent When Using the Send To feature, users need to 
navigate to displays via their attached workstations. 
Configuring a workstation as an Agent means the 
displays attached to the workstation appear as local 
displays in relation to sender’s workstations so the 
workstation level is avoided.
Default is Off
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Configure Client to Client Communication (Displays)

You can Turn off Client to Client communication for individual displays.

When selected, this option rejects all client to client requests automatically. The sender is informed 
that the receiver is configured to reject the request and asked whether to force it. In this case the 
receiver is asked whether to accept the request and is presented with a Yes/No dialog.

The sending workstation is informed if a receiving workstation is in Reject mode in two ways:

• A Rejecting’ dialog displays next to the display when attempting to send

• The receivers display name highlights red, indicating client to client communication is turned of 
for that display

Procedure 23-2  
Configure display client to client settings

Step     Action

1 Select  next to Workstations in the Device List. All workstations are listed.

2 Select  next to the workstation which is attached to the display to be edited.

3 Select  next to Monitors.

4 Right click the display to be edited.

5 Select Edit. The display editor opens.

6 Expand the Client to Client Communication section.

7 Select/Deselect the Turn off Client to Client Communication checkbox as required.

8 Select Save.

- End -
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Keyboards

Introduction

victor’s CCTV keyboard support along with Virtual Matrix, allows users to switch video in display 
panes of surveillance windows using a CCTV keyboard as if the video panes were all monitors 
attached to a traditional analog matrix.

Supported Keyboards

victor supports the following CCTV keyboards:

* Using ASCII protocol (Pelco Keyboard requires an RS422-RS-232 converter)

** See Keyboard/Matrix Switcher Manual for specific functionality

Keyboard Model

Feature

S
y

s
te

m

A
D

T
T

E

A
D

 2
08

8
/8

9

A
D

C
02

00

A
D

C
03

00

A
D

C
11

00

P
el

co
 K

B
D

30
0A

*
Camera/Monitor Call up       

Standard PTZ Control       

Keyboard Macros  

Salvos      

Tours     

Patterns  

Presets      

Focus/Iris Control      

Flip     

Keyboard Functionality**
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Note

1. When using a system keyboard, commands can only be sent if the surveillance window has 
focus. Other keyboards are not affected and will continue to operate whether the surveillance 
window has focus or not.
2. System keyboards cannot be edited from remote clients.
3. Repeat should be set to ‘Off’ for all keyboards. Refer to your keyboard’s manual for instructions. 

Add an AD/Pelco Keyboard

Any of the listed keyboards can be configured in victor.

Procedure 24-1  
Add an AD/Pelco Keyboard

Step     Action

1 Select Keyboards from the Setup tab.

2 Select New from the dropdown.

3 Enter a name for the keyboard in the Name textbox.

4 Enter a description for the keyboard in the Description textbox.

Note

The Enabled checkbox is checked by default, deselect the checkbox to deactivate 
the keyboard.

5 Expand the Keyboard section.

a Select the required Model from the dropdown.

b Select the required COM Port from the dropdown.

c Select the required BAUD Rate from the dropdown.

6 Select Save.

- End -
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Add a System Keyboard

You can add a standard Windows keyboard and use it as a CCTV keyboard.

Note

When using a system keyboard, commands can only be sent if the surveillance window has focus. 
Other keyboards are not affected and will continue to operate whether the surveillance window 
has focus or not.

Refer to’ System Keyboard Commands’ for a list of user commands.

Procedure 24-2  
Add a System Keyboard

Step     Action

1 Select Keyboards from the Setup tab.

2 Select New from the dropdown.

3 Enter a name for the keyboard in the Name textbox.

4 Enter a description for the keyboard in the Description textbox.

Note

The Enabled checkbox is checked by default, deselect the checkbox to deactivate 
the keyboard.

5 Expand the Keyboard section.

6 Select System Keyboard from the Model dropdown. The COM Port and Baud Rate 
dropdown lists disappear.

7 Select Save.

- End -
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System Keyboard Commands

When using a system keyboard, the following commands are available:

Command Action

Arrow Keys Pan/Tilt

Number Pad Arrow Keys Pan/Tilt

+/- (Number Pad) Zoom in/Out

-/= Zoom in/Out

#m Monitor (# is a number in the range 1-999)

#k Camera (# is a number in the range 1-9999)

q Rewind

w Stop

e Pause

r Play

t Fast Forward

s Jump to Date (Enter 4 digit date in month/day 
format)

d Jump to Time (Enter 4 digit time in 24 hour format)
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Keyboard Installation

The following diagrams show how to install supported keyboards AD2088, AD2089, ADTTE, 
ADCC1100 ADCC200, ADCC300.

AD2088 and AD2089

Note

To install the AD2088 and AD2089 Keyboard, you require the Keyboard PC kit (ADACKBPC2000)
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ADTTE

Note

To install the ADTTE Keyboard, you require the Keyboard PC kit (ADACKBPC2000)
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ADCC100 or ADCC0200/0300

Note

To install the ADCC100 or ADCC200/300 Keyboards, you require the Keyboard PC kit 
(ADACKBPCMPCC)

There are three Methods of connecting ADCC100 or ADCC0200/0300:
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Layouts

Introduction

The default victor unified client layout consists of three tabbed toolbars (Home, Build and Setup), 
the Device List and a 1X1 Surveillance tab. This layout can be completely customized, allowing 
you to create a workspace that better suits the requirements of individual operators and roles.

Note

The Ribbon controls are minimized by default. To show the controls, double click the Home, Build 
or Setup tab

Window Types

Various window types are supported within victor. Type changes and behavior can be accessed by 
right clicking the window title bar. victor unified client supports 3 window types:

Floating Windows

Creates a window that is independent of the client window. A floating window can be moved to 
anywhere on screen, resized and reshaped to suit your workspace.

Dockable

Creates a window that can be docked into position within the main client window. When a 
dockable window is dragged, a guide diamond is displayed (see below), allowing you to quickly 
dock it on one of the four sides of the workspace. When a docked window is undocked, it will float 
to the top of other windows.

Tabbed

Creates a window that appears in a tab. Tabbed windows are useful for organizing and switching 
between multiple open windows.
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Configure Your Workspace

You can create a custom layout to suit your individual workspace.

Procedure 25-1  
Dock Window

Step     Action

1 Right click the title bar or tab of the window.

2 Select Dockable.

3 Drag the window to the middle area of the screen. The Guide diamond displays.

4 Hover the cursor over the guide diamond arrow which corresponds with the area you want 
to dock the window in. Area highlights.

5 Release the mouse, Window docks in position.

- End -

Procedure 25-2  
Resize Windows

You can resize a docked or floating window to provide more or less area in the workspace.

Step     Action

1 If the window is tabbed, right click the title bar and select Floating or Dockable.

2 Hover the cursor over the corner side of the window. Grab Handles display .

3 Select and drag the cursor to resize the window as required.

- End -

Procedure 25-3  
Autohide Windows

Autohide is only available in dockable windows that have been docked.

When Autohide is enabled on a window, it will only be visible as a tab when it does not have focus. 
This means that the window is open and can be easily accessed, but the area it occupies is greatly 
reduced.

Step     Action

1 Right click the title bar of the docked window.

2 Select Autohide. The window will reduce to a tab view positioned according to the docked 
attribute of the window.
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3 Select the tab to view the window or remove focus to autohide.

- End -

Procedure 25-4  
Show/Hide the Ribbon

You can Minimize or maximize the ribbon controls to create more workspace. This change is not 
saved as a layout change.

Note

Default setting is minimized

Step     Action

1 Double click the Home, Build or Setup tab. Ribbon is displayed.

2 Double click the Home, Build or Setup tab. Ribbon is hidden.

- End -

Save / Switching Layouts

Save

Once your workspace has been configured to suit your requirements, you can save the layout for 
later retrieval.

Procedure 25-5  
Save Current Layout

Step     Action

1 Select Layout on the Build tab.

2 Select Save as from the dropdown menu. Name textbox displays.

3 Enter a name for the new layout.

4 Select OK. The layout is saved.

Note

The default layout cannot be deleted. 

- End -
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Switch

Procedure 25-6  
Switch to Saved Layout

Step     Action

1 Select Switch on the Home tab. List of layouts displays.

2 Select the layout from the dropdown menu. New layout displays.

- End -

Switch on Primary

The Switch On Primary feature allows you to set a new layout to be displayed on the primary 
monitor only.

Note


All tabbed, dockable and floating windows are considered part of your primary display, regardless 
of which monitor they reside on.

Procedure 25-7  
Layout - Switch on Primary

Step     Action

1 Select Switch On Primary from the Build tab

2 Select a layout from the dropdown menu. The new layout is applied to the primary monitor 
only

- End -

Layout Groups

Layout Groups allow layouts to be loaded onto client machines remotely.

Procedure 25-8  
Create Layout Group

Step     Action

1 Select Layout Group from the Build tab
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2 Select New from the dropdown menu. The Layout Group editor opens

3 Select the Name textbox and enter a name 

4 If required, select the Description text box and enter a description

5 Drag required layout to the required workstation(s)

6 Select Save

- End -

Procedure 25-9  
Load Layout Group

Step     Action

1 Select Switch Group from the Home tab

2 Select the required layout from the dropdown list. Selecting a layout will switch the 
configured layout to all workstations specified in the layout group

Note

1. Layout Groups will remain assigned to workstations until the layout is deleted or 
another layout selected
2. Layout groups override selection from Switch on Primary or Switch 

- End -

Refresh Layouts

Various options are available to refresh layouts from the Home tab.

Procedure 25-10  
Refresh Layouts

Step     Action

1 Select Refresh from the Home tab.

2 Select from dropdown options. 

• Refresh Layout

• Refresh on Primary

• Refresh Group Layout

- End -
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Rename Tabbed Window

Tabbed windows can be renamed. Any renaming will be saved when the layout is saved.

Procedure 25-11  
Rename Tabbed Windows

Step     Action

1 Right Click the tab to be renamed.

2 Select Rename. Name dialog displays.

3 Enter a new name for the tab.

4 Select OK.

- End -

Create New Tab Groups

You can create new tab groups for convenient grouping and navigation of windows. To create tab 
groups, more than one tab must be open.

Procedure 25-12  
Create New Tab Groups

Step     Action

1 Right Click on the tab to start the new group. This will be the first tab listed in the group.

2 Select New Horizontal Tab Group or New Vertical Tab Group as required. New group is 
created per the selection.

Note

1. Reorder tabs within groups by selecting and dragging tabs within the group.
2. Move tabs between groups by right clicking the tab and selecting Move to 
Previous/Next Tab Group.

- End -
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Merge Docked Windows

You can merge docked windows to create more on-screen workspace. Merged windows are 
grouped together as a single tabbed screen element.

Procedure 25-13  
Merge Docked Windows

Step     Action

1 Select the title bar of a docked window.

2 Drag to the centre of the docked window to which it is to merge. The docking icon 
displays.

3 Deselect the window in the centre of the docking icon. Windows merge. Navigate the 
windows by selecting appropriate tabs from the bottom of the merged window.

- End -

View Window In Full Screen

You can view any window in full screen mode.

Procedure 25-14  
View Window Full Screen

Step     Action

1 Right click the title bar of the window.

2 Select Send To from the context menu.

3 Select the display in which to view the full screen window.

- End -
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Save and Restore Current Layout

Selecting the save layout option saves the current layout. Once your workspace is arranged, you 
can save the layout under a descriptive name and restore it later.

Procedure 25-15  
Save Current Layout

Step     Action

1 Select Layout

2 Select Save. The Choose save location dialog opens

3 Navigate to the location you wish to save the layout to

4 Enter a File Name

5 Select Save

- End -

Procedure 25-16  
Restore Layout

Step     Action

1 Select Layout

2 Select Load. The Select layout file to open dialog displays

3 Navigate to saved layout file location and select required layout file

4 Select Open. The surveillance window updates with the restored layout

- End -  
168 victor 4.4 Installation and Configuration Guide



Workstations

Introduction

Workstations refer to the machines running victor client software. They display by default on the 
device lists of client machines and are editable via Workstation editors.

From the editor you can configure workstation descriptions and Client to Client Properties.

Context menu options specific to workstations include the ability to Logout Local Operators, 
Logout Remote Operators, Delete Workstations, Identify Monitors.

Identify Monitors

You can use the Identify Monitors feature to display the names of all monitors associated with each 
client workstation. Monitor names are displayed on screen for 3 seconds after making the 
selection.

Procedure 26-1  
Identify Monitors

Step     Action

1 Select  next to Workstations in the Device List. All workstations are listed.

2 Right Click the required workstation.

3 Select Identify Monitors. Display Names display for 3 seconds on all monitors attached to 
that workstation.

- End -
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Operator Logout (Remote)

You can use the context menu of workstations listed in the device list to remotely log out operators.

Procedure 26-2  
Operator Logout (Remote)

Step     Action

1 Select  next to Workstations in the Device List. All workstations are listed.

2 Right Click the required workstation.

3 Select Log Operator XXXX Out. Warning dialog displays.

4 Select Yes to log the operator out or No to cancel.

- End -

Rename Displays

Default display names are Display 1,2,3 etc. You can edit the default names as required.

Procedure 26-3  
Rename Displays

Step     Action

1 Select  next to Workstations in the Device List. All workstations are listed.

2 Select  next to the workstation which is attached to the display to be renamed.

3 Select  next to Monitors.

4 Right click the display to be renamed.

5 Select Rename. Textbox displays.

6 Enter a new name for the display.

7 Select OK.

- End -
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Delete Displays

You can delete displays from workstations. Deleted displays will no longer appear as options when 
using the Send To function.

Procedure 26-4  
Delete Displays

Step     Action

1 Select  next to Workstations in the Device List. All workstations are listed.

2 Select  next to the workstation which is attached to the display to be deleted.

3 Select  next to Monitors.

4 Right Click the display to be deleted.

5 Select Delete. A Warning dialog displays.

6 Select Yes to Delete or No to Cancel.

- End -
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Point of Sale 

Introduction

Point-of-Sale (POS) systems are used to facilitate and record financial transactions between 
businesses and customers. Most commonly they are used in retail environments for product sales.

victor incorporates a comprehensive set of POS integration features which are available as a 
licensed add-on.

Using the victor unified client you can import two types of POS data: raw POS transactions from 
your POS system, and POS exception reports produced by your POS exception reporting system.

Once POS data is imported into victor, a range of investigation tools are available. You can access 
video of each transaction, and use victor’s video investigation tools, such as Investigator Mode 
and Clip Export to gather video evidence. In addition victor provides advanced POS searching 
capabilities which can use to find specific transactions based on predefined POS rules.

Configuration

Before using victor’s POS features, several configuration steps should be followed: 

The most important aspect of this configuration is to identify which cameras record video of which 
POS terminals (or cash registers). This is achieved creating POS terminal objects in victor, and 
associating those with camera objects. The steps involved are:

1 Create a POS Store object

2 Create POS Terminal objects

3 Associate POS Terminals with relevant cameras

After these general steps are complete, victor is ready to import POS data. When POS data is 
imported, it is automatically synchronized with video based on Time (See POS Time Offset) and 
Terminal ID with camera associations. This means operators are not required to know or 
remember which cameras cover which terminals or are required to manually enter dates/times to 
view POS transactions or exceptions.
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Camera Region Editor

The Camera Region Editor provides a means to visually identify areas within a camera view which 
are represented by Customers, Merchandise, Employees and Terminals.

While not specifically a POS feature, making associations between cameras with defined regions 
and edge devices allows users to view pertinent regions of camera views when triggers are 
initiated from the associated items.

UnifiedPOS Data Import

Raw POS transactions are imported into victor in standard UnifiedPOS XML format. The 
UnifiedPOS XML format was developed by the National Retail Federation (NRF) Association for 
Retail Technology Standards (ARTS). The format is a public standard for exchange of POS data in 
an XML form. See your POS system documentation or contact your POS system vendor to 
determine how you can export UnifiedPOS data for use with victor.

CautionCaution

Before importing POS data into victor you should remove or securely obscure any sensitive credit 
card information. The victor unified client has not been certified for PCI DSS compliance.

This chapter details how to:

• Create a POS Store

• Create POS Terminals

• Associate Terminals with Cameras

• Define Camera Regions

• Import POS Transactions

• Search POS transactions

• View POS Transactions

• Import POS Exception Reports

• View POS Exception Reports

Create a POS Store

You can create POS store objects within victor client. These objects can be associated with 
multiple terminal objects.

Procedure 27-1  
Create a POS Store

Step     Action

1 Select Store from the Setup tab

2 Select New from the dropdown

3 Enter a Name for the POS Store in the Name textbox

4 Enter a Description for the POS Store in the Description textbox
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5 Enter the RetailStoreID

Note

The RetailStoreID must match the ID used by the POS system or no transactions 
will be imported

6 Select Save.

- End -

Create POS Terminal Objects

You can create one or more POS Terminal objects within victor. These are then associated with 
cameras which have a field of view covering the terminal.

Procedure 27-2  
Create POS Terminal Objects

Step     Action

1 Select Terminal from the Setup tab.

2 Select New from the Dropdown.

3 Enter the Store to be associated with the Terminal.

4 Enter a Name for the Terminal in the Name textbox.

5 Enter a Description for the Terminal in the Description textbox.

6 Enter the WorkstationID.

7 Select Save.

Note

The WorkstationID should match the ID used by your POS system for this terminal 
or no transactions will be imported.

- End -
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Associate POS Terminals with Cameras

Using the Associations section in the POS Terminal editor, you can associate one or more 
cameras with the terminal. These should be cameras whose field of view includes the physical 
terminal.

Procedure 27-3  
Associate POS Terminals with Cameras

Step     Action

1 Select Terminal from the Setup tab.

2 Select Show All from the dropdown.

3 Right Click the Terminal to edit.

4 Select Edit.

5 Expand the Associations section.

6 Select . The Object selector displays.

7 Use the Object selector to select cameras to associate with the terminal.

8 Select OK.

9 Select Save.

- End -

Camera Region Editor

The Camera Region Editor allows you to define color coded overlays on camera views associated 
with terminals.

Four overlay types are available: Customer Present, Merchandise, Employee and Terminal.

Assigning regions to terminal cameras in a retail environment makes them easily identifiable when 
POS video is retrieved for those terminals.

Note

The Customer Present region can be aligned with the customer present analytic available on 
VideoEdge 4.4+

Regions can be assigned from the Camera region editor in the Build tab, or alternatively you can 
access the editor by right clicking on a terminal on the device list and selecting Configure Regions.

To use the Region editor the camera must be associated with a terminal.

Procedure 27-4  
Edit Camera Regions

Step     Action

1 Select Camera Region Editor from the Build tab. The Editor displays
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2 Select click the terminal with which the camera view is associated. Camera icons display

3 Select the Camera on which to draw the Region of interest (ROI). Camera view displays 
with drawing tools

4 Select the region type to be drawn from:

• Customer Present (Analytic available)

• Merchandise (For information only)

• Employees (For information only)

• Terminal (For information only)

5 Use drawing tools to draw the required ROI

6 Select Save or continue drawing / editing as required

- End -
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UnifiedPOS Transactions

Importing UnifiedPOS Transactions

UnifiedPOS Transaction Reports can be imported into victor allowing video data to be aligned with 
transaction data.

During import, the file is validated against the UnifiedPOS standard. If the file is not in UnifiedPOS 
XML format, the import will fail.

During the import, victor examines each transaction and checks for corresponding stores and 
terminals in victor using the RetailStoreID and WorkstationID properties. Any transactions that do 
not have a corresponding store and terminal in the system are rejected. The rest will are stored in 
the victor database.

Procedure 27-5  
Import POS Transactions

Step     Action

1 Select Transactions from the Build tab.

2 Select ImportUnifiedPOS. Import File dialog displays.

3 Navigate to the file to import.

4 Select Open. 

5 Enter Time Offset if required. This is the time between the POS terminal and victor.

6 Select OK. The file import begins. The file is validated first to ensure UnifiedPOS 
requirements are met. Select More Detail to view progress and status of import.

Note

Workstation ID, and Retail Store ID must align with the corresponding object 
properties in victor.

7 Select Close when import is complete.

- End -
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POS Search and Retrieve

Using the POS Search and Retrieve wizard, you can search POS Transactions and view results 
alongside associated video data. Transaction video displays in the POS surveillance window while 
the associated transaction data displays in a separate pane.

Procedure 27-6  
Search POS Transactions

Step     Action

1 Select Search and Retrieve (POS) from the Home tab. Transaction Search Wizard 
displays.

2 Drag the required terminal or store into the terminal list area.

3 Specify the start and end time to be searched within

4 Select checkbox if Customer Filtering is required, then select the filter:

• Include All Transactions - No Customer filtering

• Include only transactions with no customers (Requires Customer present video 
Intelligence)

• Include only transactions with customers (Requires Customer present video 
Intelligence)

Note

Customer Present Video Intelligence is a VideoEdge NVR 4.4+ licensed add-on. 
In order to use this feature, a license must be purchased for each camera.

5 Apply UnifiedPOS search rules if required:

a Select  Object selector displays

b Select the POS Search property from the object selector

c Select OK Search property displays in the wizard

d Apply And/Or and Operator Values as required

e Apply Value as requires - This field may be a dropdown selection or free text 
depending on the Search property selected

6 Select Finish. Search results (video and transaction data) display in the POS surveillance 
window

- End -
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POS Terminal View

You can view POS transactions related to specific terminal objects directly from the device list. 
This action opens a transaction surveillance window displaying the cameras associated with that 
terminal.

Procedure 27-7  
POS Terminal View

Step     Action

1 Right click the required terminal on the device list

2 Select View. Transaction Viewer displays.

3 Use playback controls to navigate to the required time interval.

Note

You can use the play controls to navigate forwards and backwards through the 
video. While paused, you can drag in additional cameras or terminals that will be 
time synchronized with the others. As transactions occur on one of the terminals 
in the POS Transaction Viewer, the text of that transaction will be displayed in the 
text pane to the right of the video. The text will remain in this pane until it is 
replaced by another transaction.

If configured, overlays are displayed in this view displaying camera regions defined for 
merchandise, Customer present, Employee or Terminal. Refer to Camera Region Editor.

- End -
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POS Exceptions Reports

POS Exception Reports

In addition to raw POS transactions, victor can also import POS Exception Reports. A POS 
Exception Report typically lists transactions deemed to be exceptional in some way.

Trying to align exception data with video data manually can be very time consuming and error 
prone. The victor POS exception report feature automates much of this process.

Assuming the POS terminals are already configured (If not refer to Create POS Terminal Objects 
and Associate POS Terminals with Cameras). You can then import POS exception reports and 
align video data with the transactions.

POS Exception Reports come in many different formats from different vendors and are often 
customized by company rules and procedures. Therefore, victor has a flexible template-based 
system that can understand many different report types and formats.

POS Exception Report Requirements

At a minimum, POS exception reports must:

• Be in Row-Column Format

• Be either .csv or .xls file format

• Contain columns for Date, Time and POS Terminal ID of the transaction

• List exceptional transactions

Any other information the report may contain will be imported and displayed but is not required for 
the import.

Three types of rows are supported:

• Key row (one) - The first row of the report.This row names the columns in the 
report

• Terminal rows (one or more). Contain the transaction data

• Group rows (one or more). Used to link together terminal rows
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Import POS Exception Reports

The POS Report Import wizard guides you through the several steps required to import a new 
report and also create a report template. Templates are useful as the next time you import a report 
of that type, victor will recognize it and import it directly.

Procedure 27-8  
Import POS Exception Reports

CautionCaution

Before importing POS data into victor you should remove or securely obscure any sensitive credit 
card information. The victor unified client has not been certified for PCI DSS compliance.

Step     Action

1 Select Report from the Build tab

2 Select Import Report. Exception Report Import Wizard displays

3 Select Browse

4 Navigate to and select the exception report

5 Select Open. A Report Preview displays. Use the Report Type dropdown to select New or 
Existing. If it is a new report type, the wizard will guide you through the rest of the process, 
if you select an existing report type, the wizard will bypass report configuration and prompt 
for import.

6 Select Next. Exception Report Header screen displays. Set the report header by 
selecting the row containing the required column headers. After selecting the header row, 
you can change the column header names by selecting the name in the preview area and 
entering a new name.

7 Select Next. Mandatory Columns screen displays. Drag column headers from the 
preview datagrid into the relevant column dropboxes.

8 Select Next. Additional Info screen displays. If your exception report groups exceptions 
underneath header rows, select a header row from the preview datagrid and then select a 
property header from the property table.

9 Select Next. Save Report Template screen displays:

• Enter New Report Name (Select Save when entered) - The new template will 
save with this name

• Select Enable Customer Filtering if required. This means you can filter POS 
Exception Reports based on whether a customer was present at the time of the 
exception or not.

Note

Customer Present Video Intelligence is a VideoEdge NVR 4.4+ licensed add-on. 
In order to use this feature, a license must be purchased for each camera.

• Enter a Time offset if required

10 Select Next. Import Summary Screen displays. Review the report summary and use 
Previous and Next Buttons to make any amendments as required.

11 Select Finish.
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The report can be accessed from Build Tab > Exception Reports > Show All. Right click the 
report and select View, Send To or Delete as required.

- End -
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Introduction

You can import Generic Exception Reports which can be associated with either cameras or 
Generic Devices within victor to associate video data with report data.

Generic Edge Devices must be configured within the client before reports can be created to 
associate victor video with report data.

Generic Edge Devices

These devices are hardware objects which are added to victor for reference only. They enable you 
to associate cameras so that when generic exception reports are run, you can view video aligned 
with report data.

victor does not poll these devices for status, the only meaningful reference which links the device 
to reports is the External Identifier which maps to the report.

Associated camera views can be accessed by right clicking on the objects in the device list and 
selecting View.

Generic Exception Report Requirements

At a minimum, exception reports must:

• Be in Row-Column Format

• Be either .csv, .txt, .xls or .xlsx file format

• Contain columns for Date, Time and Generic Edge Device

• List exceptional transactions

Any other information the report may contain will be imported and displayed but is not required for 
the import to be successful.

Three types of rows are supported:

• Key row (one) - The first row of the report. This row names the columns in the 
report

• Terminal rows (one or more). Contain the transaction data

• Group rows (one or more). Used to link together terminal rows
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Import Generic Exception Reports

The Generic Exception Report wizard guides you through the several steps required to import a 
new exception report and also create report templates. Templates are useful as the next time you 
import a report of that type, victor will recognize it and import it directly.

Procedure 28-1  
Import Generic Exception Reports

Step     Action

1 Select Exception Reports from the Build tab

2 Select Import Report. Exception Report Import Wizard displays

3 Select Browse. Open dialog displays

4 Navigate to and select the exception report

5 Select Open. A Report Preview displays in the File Select screen

6 Select Generic Edge Devices or Cameras from the Type dropdown

7 Use the Report Type dropdown to select whether the report is new or uses an existing 
template. If New Report Type is selected, the wizard will guide you through the rest of the 
process, if you select an existing report type, the wizard will bypass report configuration 
and prompt for import

8 Select Next. Exception Report Header screen displays. Set the report header by 
selecting the row containing the required column headers. After selecting the header row, 
you can change the column header names by selecting the name in the preview area and 
entering a new name

9 Select Next. Mandatory Columns screen displays

10 Drag column headers from the preview datagrid into the relevant column dropboxes.

11 Select Next. Save Format screen displays:

• Enter New Report Name (Select Save when entered) - The new template will 
save with this name

• Enter an External Device Time Offset if required

Note

This setting allows you to adjust for differences between the External device Clock 
and the Video System Clock so report time data and Video data align.

12 Select Next. Import Summary Screen displays. Review the report summary and use 
Previous and Next Buttons to make any amendments as required

13 Select Finish

The report can be accessed from Build Tab > Exception Reports > Show All. Right click the 
report and select View, Send To or Delete as required

- End -
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Introduction

The Camera Region Editor provides a means to visually identify areas within a camera view which 
are represented by:

Customers

Merchandise

Employees

Terminals

Making associations between cameras with defined regions and edge devices allows users to 
view pertinent regions of camera views when triggers are initiated from the associated items.

Define Camera Regions

Camera regions can be assigned from the Camera region editor in the Build tab, alternatively, you 
can access the editor by right clicking on a terminal on the device list and selecting Configure 
Regions.

Procedure 29-1  
Edit Camera Regions

Step     Action

1 Select Camera Region Editor from the Build tab. The Editor displays

2 Select the Camera on which to draw the Region of interest (ROI). Camera view displays 
with drawing tools.

3 Select the region type to be drawn from:

• Customer Present

• Merchandise

• Employees

4 Use drawing tools to draw the required ROI
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5 Select Save or continue drawing / editing as required

- End -
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Introduction

The reporting function is used primarily to display Journal and Audit information on system objects 
and activity.

Various predefined report templates are available within the client or alternatively, you can use ‘Ad 
Hoc’ reports for more customizable reports which allow search terms to be used.

Report’s Data Visualizer tool allows users to display report data graphically using Charts, 
Timelines and Report Grids.

Journal Filter

The Journal Filter is used to regulate the amount of data being written to the database (journaled) 
by blocking/unblocking specific alert types. The feature is accessed from System Values on the 
Setup tab.

The following message types cannot be blocked and will always be journaled:

• General Purpose Interface Activity

• Operator Login

• State Change

• System Activity

• System Error

The default setting is to record, meaning messages will be written to the database unless they are 
blocked in the journal filter.

Note

Motion Detection, Light Change and Motion Exception Alerts are blocked by default.

Report exceptions are controlled at Object and Type level. Object Exceptions override Type 
Exceptions - therefore if an alert type is blocked at type level but allowed for a specific object, the 
object’s alert will be written to the database but the block on the type remains valid.
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Generate / Save Reports

Various predefined report templates are available within the report editor. These can be used to 
generate reports to retrieve Journal and Audit information on system objects and activity. From the 
reporting dialog, reports can be saved so they can be executed later.

Procedure 30-1  
Generate / Save Reports

Step     Action

1 Select Reports and Data Visualization from the Home tab.

2 Select New from the dropdown. Reports Editor displays.

3 Select the required date range using the Date Range Picker.

4 If required, select a report Category from the dropdown

5 Select a report Template from the dropdown.

Note

1. Available templates may vary depending on which integrations are installed.
2. On selection each template populates the fields below the drop down with 
relevant filters (appropriate to report type).

6 Select  and use the Object Selector to apply filters as required.

7 Select New Tab checkbox to open results in a new tab (optional).

8 Select from the following:

• Execute to run the report

• Visualize to send report results to Data Visualizer

• Save to save the report for future use (New dialog displays)

Note

The Save dialog allows the user to provide a Name and Description for the report. 
It also allows the user to specify whether the report should prompt for 
new/different filters when it is executed. If checked when the report is executed 
the standard report dialog will be presented with the saved report information 
loaded. If the user configures a report with “Custom” as the Date Range, the 
report will prompt on execution so the user can specify dates.

• Exit to exit without saving

- End -
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Ad Hoc Reports

The Ad Hoc tab contains journal message types that do not have associated report templates. The 
control that is shown for these types of reports allow you to pick an object, type or to enter a name 
to filter by.

Procedure 30-2  
Generate/Save Ad Hoc Reports

Step     Action

1 Select Reports and Data Visualizer from the Home tab. 

2 Select New from the dropdown. Report Editor displays.

3 Select the required date range using the Date Range Picker.

4 Select the Ad Hoc tab.

5 Select the Event Type from the dropdown menu.

6 Use the Object Selector or the Name textbox to enter a search term.

7 Select New Tab checkbox to open results in a new tab (optional).

8 Select from the following:

• Execute to run the report

• Visualize to send report results to Data Visualizer

• Save to save the report for future use (New dialog displays)

Note

The Save dialog allows the user to provide a Name and Description for the report. 
It also allows the user to specify whether the report should prompt for 
new/different filters when it is executed. If checked when the report is executed 
the standard report dialog will be presented with the saved report information 
loaded. If the user configures a report with “Custom” as the Date Range, the 
report will prompt on execution so the user can specify dates.

• Exit to exit without saving

- End -

Show All

You can view an object list of all saved/available reports by selecting Reports on the Home tab 
and Show All.

The saved reports are shown in a dynamic view and are by default grouped by Report Template 
type.

Right Clicking on any report offers the following options:
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• Edit: Modify the filters for the report

• Delete: Deletes the saved report

• Execute: Displays a dynamic view with the results of the report

• Visualize: Displays a data visualization control with the results of the report

Find in Journal

The Find in Journal feature allows you to search for journal records relating to specific objects of 
interest.

If the Find in Journal feature is available for an object, it is typically accessible from the object's 
context menu.

Procedure 30-3  
Find in Journal

Step     Action

1 Right click the required object.

2 Select Find in Journal. Report Selection dialog displays.

3 Select the required Report Type from the dropdown.

4 Select the date range using the From and To date controls.

Note

The Search Name will be populated by the name of the object selected. If 
required, enter the Operator Name.

5 Select OK. Reports displays.

- End -
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Log General Message

You can write a manual entry to the journal using the Log General Message feature.

As well as entering a manual message, you can select and edit any of the predefined messages 
which may be available.

General messages are available as a report type.

Procedure 30-4  
Log General Message

Step     Action

1 Select Log General Message from the Home tab. Log Message(s) dialog displays.

2 To enter a manual message:

a Enter a message as required.

b Select  to enter additional messages. Select  to remove messages.

c Select OK. Selected messages are journaled.

3 To enter a predefined message:

a Select Select Message from Predefined Message log dropdown.

b Select Predefined Message.

c Select  to enter additional messages. Select  to remove messages.

d Select OK. Selected messages are journaled.

- End -

Predefined Messages

Predefined Log Messages can be created which can then be used when required to acknowledge 
or clear an event without needing to type text.

Messages are identifiable by their labels which are assigned when they are created. 

Labels and message fields are mandatory for every message created. Labels can be up to 100 
characters in length and messages up to 3000.

The language for each message can also be assigned, this means when a user logs a message, 
the messages available are filtered to provide current language messages only. To log a message 
in a different language, you must switch language in the client.

Procedure 30-5  
Create a Predefined Log Message

Step     Action

1 Select Predefined Message Log from the Build tab.
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2 Select New from the dropdown menu. New Predefined Message editor displays.

3 Select the Language dropdown.

4 Select the language in which the message is to be displayed.

5 Double click the Label textbox.

6 Enter Label text as required. Double click the Message textbox.

7 Enter message text as required.

8 Select  to add additional messages or  to remove selected messages.

9 Select Save.

- End -
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Data Visualization

Data Visualizer can be used use to graphically chart most event data available in victor. The charts 
can be used to visualize the data over time, and to compare different events as different data 
series.

A typical use case for data visualizer could be for People or Object counting. This could be 
achieved by using Data visualizer combined with the VideoEdge Video Intelligence software add-
on to form a useful People Counting solution.

Note

The Video Intelligence software is a licensed add-on to the VideoEdge NVR product. You must 
obtain a license for each camera before the video intelligence features are available.

Report Results

Once search parameters have been entered into the Reports or Ad Hoc tab (see Generate / Save 
Reports and Ad Hoc Reports), select Visualize. Report results will display in the Data Visualizer. 

Search & Retrieve Results

Once a Search & Retrieve has been run, select  to view results in the Data Visualizer.

Using the Data Visualizer

Once data has been populated in the Data Visualizer, it can be further manipulated. 

‘Drill Down’

When results have been populated in the Data Visualizer, the X axis will display time relevant to 
search criteria and the Y axis will display the number of occurrences. In the example shown below, 
the search was carried out over a 3 day period, with each column representing 1 day:
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From this view, you can further ‘drill down’ into a time period by double clicking a column. For 
example, double clicking on the ‘Apr 08’ column will ‘drill down’ into that day, displaying columns 
for each hour, as shown below:

You can continue to ‘drill down’ into more narrow timeframes until the Drill Down Threshold of 
occurrences has been reached. The Drill Down Threshold is set from the Customise tab of the 
Data Visualizer and is the limit of number of occurrences that you can drill down to. Once the Drill 
Down Threshold has been reached, double clicking a column will open a surveillance pane 
displaying results. If no video is associated, drilling down will return a view of the type.
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Customize Tab

Buttons available on the Customize tab are outlined below:

The Series section of the Customize tab enables customizing of the color of all series displayed 
in the data visualizer, along with the ability to add a Mean line or Trendline to the chart.

The Customize section of the Customize tab enables changing of axis settings to Log Axis and 
Show Zeros, along with changing the series Type (Line, Column, Bar, Area), which Trendline 
(Linear, Logarithmic, Quadratic, Cubic) is displayed and setting of the Drill Down Threshold.

Filter Tab

The Filter tab allows for filtering of the chart by Object Type, Object Name or Alarm. Select 
required option then select Update Chart to apply.

Report Search

Selecting the Report Search tab opens the report search interface from which reports and ad hoc 
reports can be run. Refer to Generate / Save Reports for more information.

Fit Horizontal & Vertical - fits chart 
horizontally and vertically

Fit Horizontal - fits chart horizontally

Fit Vertical - fits chart vertically

Toggle Crosshairs - toggles crosshairs on 
chart on and off

Toggle Gridlines - toggles gridlines on chart 
on and off

Export to File - exports current data 
visualizer view as a .jpg file

Export to Excel - exports current data 
visualizer view and data in Microsoft Excel 
format (.xlsx)

Export to XPS - exports data as a .xps file
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Roles

Introduction

A Role is a set of access rules which is assigned to an operator to govern their authorization and 
permission levels within victor. Effective role management enables complete control over the 
resources and features users can access.

Be careful of the roles you give users on your system. If you add a user as an administrator, you 
are granting them full system permissions.

Note

Before deleting roles, ensure they are not assigned to operators

Role Types

Canned Roles

There are five predefined (canned) roles, ready for assignment to users. Each of these roles, apart 
from Administrator can be edited to refine them further. Canned roles are as follows (Descending 
permission level):

• Administrator

• Power User

• Investigator

• Guard

• Viewer

Custom Roles

As well as using canned roles, you can create custom roles. This can be done using the ‘Save As’ 
feature which allows a current role to be used as a template to build a new role, or you can build a 
completely new role manually.

Each new role created is available for selection when creating or editing operator profiles.
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Type/Object Exceptions

The level of permissions assigned to a role is controlled by exceptions. When a custom role is 
initially created, full administrative access is granted by default, the role can then be edited to add 
type and object exceptions to restrict access to resources and features.

It is important to understand the difference between Type and Object Type exceptions. Type 
relates to general groups of objects E.G Recorders, Events while Object Exceptions relate to 
specific objects E.G Recorder ‘X’ or Event ‘Y’.

Create Roles

If a canned role does not meet your requirements, you can create new customized roles.

Procedure 31-1  
Create a Role

Step     Action

1 Select Role from the Build tab.

2 Select New from the dropdown menu. Role editor displays.

3 Enter a name for the role in the Name textbox.

4 Enter a description for the role in the Description textbox.

Note

The Enabled checkbox is selected by default, deselect to disable the role.

5 To assign Type Exceptions:

a Expand the Type Exceptions section.

b Select . Type Selector dialog displays.

c Select the Object Type as required.

d Select OK. Exception ‘Allow’ list displays.

e Select the Allow checkbox next to permitted actions, deselect for non-permitted 
actions.

f Repeat as required.

g Use  to remove selected type exceptions.

6 To assign Object Exceptions:

a Expand the Object Exceptions section.

b Select . Object Selector dialog displays.

c Use the Object selector dialog to select the object as required.

d Select OK. Exception ‘Allow’ list displays.

e Select the Allow checkbox next to permitted actions, deselect for non-permitted 
actions.

f Repeat as required.
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g Use  to remove selected object exceptions.

7 Expand the Layout section.

8 Use the Object Selector to assign a layout as required.

9 Select Save.

- End -

Copy Roles

Existing roles can be used as templates to create new roles which can then be edited. This is 
useful if you need to create a role which is similar to but not identical to an existing role.

Procedure 31-2  
Copy a Role

Step     Action

1 Select Role from the Build tab.

2 Select Show all from the dropdown menu.

3 Right click the role to be copied

4 Select Save As. Really save a copy of the specified object? dialog displays.

5 Select Yes. A copy of the role is created and displays on the object list. The copied role is 
identifiable as it has the original role name appended with ‘_Copy’.

6 Right click the new role.

7 Select Edit.

8 Use the Type and Object selectors as required to edit the role.

9 Select Save.

- End -
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Analog Matrix

Introduction

MegaPower 3200 and MegaPower 48 Plus analog matrices can be added to victor site manager. 
They can be added to Virtual Matrix profiles so they can be controlled from a particular workstation 
via an attached keyboard.

A typical analog matrix configuration will have video feeds to the matrix coupled to a recorder 
which may already be part of the victor system. In this setup the virtual matrix crates mappings to 
both the recorder camera and the analog matrix input.

The camera mappings are also required to allow playback from keyboard ‘Orange Buttons’. When 
the user selects a camera associated with the analog matrix, mappings allow the virtual matrix to 
identify the associated recorder and take appropriate action to retrieve video.

Analog Matrix Editor

You edit many properties of analog matrices via victor. 

Basic properties are configured in the General and Analog Matrix Setup sections.

The Workstation Connections section is used to configure COM Port, Baud Rate and Playback 
Monitor specific settings for each workstation matrix connection. Remote workstations can be 
dragged and dropped here from the device list.

The Inputs and Analog Matrix Configuration section of the editor is used to configure camera 
mappings.

To configure camera mappings, cameras already present in victor are dragged from the device list 
on to the Camera Mapping list. The sequence of the list can be changed using the Delete, Up and 
Down buttons.
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Satellite Sites - (MP3200 only) MP3200 matrices permit satellite site configuration, permitting a 
site to access the resources of one or more remote sites.

Note

1. Before adding an analog matrix, you should ensure it is correctly configured via its supporting 
configuration application (Easy CPU for MP3200 and Easy 48 for MP48)
2. Any video stream and monitor resources configured during the victor setup are always 
considered available to the associated victor workstation.
3. victor does not poll analog matrices for status. Once added, it is always expected to be 
available.

Add Analog Matrices

You can add preconfigured analog matrices to victor.

Note

Before adding an analog matrix, you should ensure it is correctly configured via its supporting 
configuration application (Easy CPU for MP3200 and Easy 48 for MP48)

Procedure 32-1  
Add Analog Matrices

Step    Action

1 Select Analog Matrix from the Setup tab.

2 Select New from the dropdown menu.

3 Enter a name for the matrix in the Name textbox.

4 Enter a description for the matrix in the Description textbox.

5 The Enabled checkbox is selected by default, deselect to disable.

6 Expand the Analog Matrix Setup section. Use the Model dropdown menu to select the 
required model.

7 Enter the Site number in the Site textbox. (only available for MP3200)

8 Enter the number of cameras in the Camera Count textbox.

9 Enter the number of monitors in the Monitor Count textbox.

10 Enter a Username in the User Name textbox.

11 Enter a password in the Password textbox.

12 Check the Requires Authentication checkbox if you require users to authenticate before 
accessing the analog matrix.

13 Expand the Workstation Connections section.

14 Select the workstation to associate the analog matrix to. The current workstation is 
automatically populated in the list. To add further workstations, drag them from the device 
list.
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15 If required, double click the default COM Port and select an alternative from the 
dropdown.

Note

1. If a COM port is already in use by another device it will appear greyed out in the 
dropdown list. You can view which device is using the COM port from the tool tip.
2. Select Blank to have no COM port assigned.

16 If required, double click default Baud Rate and select and alternative from the dropdown 
list.

17 If required, double click the default Playback Monitor and select an alternative from the 
dropdown list.

18 To change the default value for Playback to Analog Matrix:

a Double click Playback to Analog Matrix.

b Select or deselect the Enabled checkbox to enable or disable the feature.

c Enter the Matrix Input value as required.

19 Expand the Inputs and Analog Matrix Configuration section. This section is used to 
configure camera mappings and assign pseudo numbers to analog inputs.

20 Associate video streams as required by dragging cameras or recorders from the device 
list into the Inputs Configuration list.

21 Expand the Satellites section.

22 Drag required satellite sites from the device list into the Satellites list.

- End -

Reconnect to Analog Matrix

If victor loses connection to an analog matrix you can attempt reconnection.

Procedure 32-2  
Reconnect to Analog Matrix

Step    Action

1 Select  next to Analog Matrices in the device list. All Analog Matrices display.

2 Right click the Analog Matrix to reconnect.
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3 Select Reconnect.

Note

The Reconnect option is not available if the Analog Matrix is disabled or Local 
Workstations are not configured correctly in the Workstation Connections section 
of the editor.

- End -
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Introduction

Virtual Matrix allows users to switch video in display panes of surveillance windows using a CCTV 
keyboard as if the video panes were all monitors attached to a traditional analog matrix.
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Create a Virtual Matrix Profile

You can define and add virtual matrix profiles to the system.

Procedure 33-1  
Create a VIrtual Matrix Profile

Step     Action

1 Select Virtual Matrix from the Build tab.

2 Select New from the dropdown menu. Virtual Matrix Editor displays.

3 Enter a Name and Description in the General Section.

4 The Enabled checkbox is selected by default, deselect to disable the virtual matrix.

5 Expand the Settings Section. Select checkboxes as required for:

• Monitor Number Overlay - Select if monitor numbers are to be displayed in the 
Virtual Matrix

• Override User Layout - Select if you require the activation of the Virtual Matrix 
to close any existing camera views.

6 Expand the Cameras Section. All available cameras are listed and assigned default virtual 
numbers.

7 If required, renumber cameras:

• To renumber a single camera:

a Select the camera row

b Change the virtual number in the renumber cameras textbox

c Select Selected

d Repeat as required for subsequent cameras

• To renumber a range of cameras

a Select the renumber cameras textbox

b Enter the first number of the range to be assigned

c Select All. Virtual number range updates

8 Expand the Call ups section. All available call ups are listed.

9 If required, renumber call ups:

• To renumber a single call up:

a Select Tours or Salvos tab as required

b Change the virtual number in the renumber call ups textbox

c Select Selected

d Repeat as required for subsequent call ups

• To renumber a range of call ups:

a Select the renumber textbox

b Enter the first number of the range to be assigned

c Select All. Virtual number range updates.
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10 Expand the Monitors section.

• To add monitors:

a Select . Dropdown menu displays

b Select Virtual Display or Analog Matrix as required. Selection displays in monitor 
list.

c Change Video Layout and Workstation as required by double clicking the relevant 
field and selecting from the dropdown menu.

d Repeat as required to add more monitors. (Maximum 4 virtual displays per 
workstation)

• To renumber monitors:

a Deselect the Add monitor ranges automatically checkbox. First pane field 
becomes a textbox.

b Assign numbers manually by entering values in the First pane textboxes. Last pane 
field updates according to the number of panes associated with the selected layouts.

11 Select Save.

- End -

Renumber Camera Virtual Numbers

The device list orders cameras alphabetically while the virtual matrix builds its camera list when 
first created. As new cameras become available they are appended to preserve the virtual 
numbering.

This means the virtual matrix list of cameras is not always in the same order as the device list.

Virtual camera numbers are labelled 1 through 99999 by default. Individual virtual numbers may 
be changed or whole ranges may be assigned new values.

Note

Keyboards may not be able to call all virtual camera numbers as different keyboards have limits on 
the highest number they can recognise.

Renumbering affects the command needed to call up a particular camera, so if you renumber 
cameras starting at ‘99’, then to call up the first camera you need 99M+#K.

Procedure 33-2  
Renumber Camera Virtual Numbers

Step     Action

1 Select Virtual Matrix from the Build tab.

2 Select Show all from the dropdown menu.

3 Right Click the Virtual Matrix to be changed.

4 Select Edit. Virtual Matrix Editor displays.
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5 Expand the Cameras section.

• To renumber a single camera:

a Select the camera row

b Change the virtual number in the renumber cameras textbox

c Select Selected

d Repeat as required for subsequent cameras

• To renumber a range of cameras

a Select the Renumber cameras textbox

b Enter the first number of the range to be assigned

c Select All. Virtual number range updates

6 Enter the new camera ID in the Renumber Cameras text box.

7 Select Save.

- End -

Renumber Call ups in a Virtual Matrix

You can renumber the default numbers assigned to call ups in a virtual matrix either individually or 
by range.

Procedure 33-3  
Renumber Call ups in a Virtual Matrix

Step     Action

1 Select Virtual Matrix from the Build tab.

2 Select Show all from the dropdown menu.

3 Right Click the Virtual Matrix to be changed.

4 Select Edit. Virtual Matrix editor displays.

5 Expand the Call ups section.

6 Select Tours or Salvos as required.

• To renumber a single call up:

a Select the call up row

b Change the virtual number in the renumber textbox

c Select Selected

d Repeat as required for subsequent call ups

• To renumber a range of call ups

a Select the Renumber textbox

b Enter the first number of the range to be assigned
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c Select All. Virtual number range updates

7 Select Save.

- End -

Edit Monitors (Virtual Matrix)

You can add and remove monitors from virtual matrices. A maximum of 4 virtual displays can be 
added to each workstation.

Procedure 33-4  
Edit Monitors (Virtual Matrix)

Step     Action

1 Select Virtual Matrix from the Build tab.

2 Select Show all from the dropdown menu.

3 Right click the virtual matrix to be edited.

4 Select Edit.

5 Expand the Monitors section.

• To add Monitors:

a Select . Dropdown menu displays

b Select Virtual Display or Analog Matrix as required. Selection displays in monitor 
list.

c Change Video Layout and Workstation as required by double clicking the relevant 
field and selecting from the dropdown menu.

d Repeat as required to add more monitors. (Maximum 4 virtual displays per 
workstation)

• To remove monitors:

a Highlight the monitor row.

b Select . Monitor is removed

• To renumber monitors:

a Deselect the Add monitor ranges automatically checkbox. First pane field 
becomes a textbox.

b Assign numbers manually by entering values in the First pane textboxes. Last pane 
field updates according to the number of panes associated with the selected layouts.

• To change Video Layouts:

a Double click the video layout of the display to be changed. Available video layouts 
display.

b Select the required layout. Video layout and pane numbers update.
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• To change monitor workstation:

a Double click the workstation name of the virtual display. List of available workstations 
displays.

b Select workstation as required.

6 Select Save.

- End -
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Introduction

A Site is a user definable list of folders into which you can drag devices and objects.

Sites allows users to organize and group objects into logical folder views instead of the traditional 
device driven views.

Users can create sites and folders with custom names and organize the objects within according 
to criteria relevant to that site.

For example, a folder can be named ‘East Car Park’ and that folder can be used to group objects 
related to that particular area (Cameras, Recorders etc.)

The site list is therefore used as a convenient method from where to open objects and views 
related to a particular physical location.

Create a Site

You can add new sites to victor which allow you to group and manage devices within a specific 
area.

Procedure 34-1  
Create a Site

Step     Action

1 Select Sites from the Home tab. Site window displays.

2 Right Click in the white space within the sites window.

3 Select Add Site. A new folder is created called New Site.

4 To rename the folder:

a Right click the folder

b Select Rename Site

c Enter Site Name
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d Select OK.

Note

Site list reorders alphabetically as new sites are added, deleted or renamed.

5 To Add Objects:

a Select the object to be added

b Drag and Drop into the required site folder

c Repeat as required

6 To Remove Objects:

a Right click the object to be removed

b Select Remove from the list.

Note

Delete option is also available in this context menu. Selecting Delete removes the 
object permanently.

- End -
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Introduction

The General Purpose Interface (GPI) is a programmable bi-directional communication protocol 
which enables victor to interact with third party devices.

To achieve this, the General Purpose Interface:

• Initializes communication between victor client and a third party device

• Maintains a communications channel by polling the third party device

• Defines General Purpose Actions which send messages to third party devices using victor event 
activation and supports acknowledgment messages from third party devices

• Defines General Purpose Monitoring Points which represent monitoring points in third party 
devices

• Defines General Purpose incoming message protocols which interpret incoming messages from 
third party devices and support acknowledgement for incoming messages

Terminology

GPI General Purpose Interface

Device The central third party hardware device

Monitoring Point victor data type which changes state based on 
incoming messages from the device

Protocol

Action Messages Sent to the device as a result of events triggered in 
victor

Actions Objects created in victor which are transmitted to the 
General Purpose Device based on activated events 
in victor

Input Where the input strings are sent from the device 
through the Serial/Network port to victor

Output Where the output is an action and requests a 
response from the device

Poll Where the poll is an action which requires a 
response from the device

STX Start of Text

ETX End of Text
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The General Purpose Interface can work with any device which uses ASCII code communications 
protocol for event monitoring, such as:

The third party device sends pure ASCII messages via a serial port (RS-232) or remotely via a 
TCP/IP port (Lantronix or Systech) to the General Purpose Interface Driver.

This means that you can respond to alarms from many types of third party devices as well as the 
system video and health alarms described in ‘Events’.

The General Purpose interface supports the following functionality:

• Input - Where the input strings are sent from the device through the 
Serial/Network port to victor

• Output - Where the output is an action and requests a response from the device

• Poll - Where the poll is an action which requires a response from the device

Monitoring Points

Monitoring Points are victor data types which change state based on incoming messages from the 
device. Monitoring Points can be configured to directly trigger Events.

Events can be designed to activate any victor event action.

Intercom Process Control Equipment

Burglar/Intrusion Environmental

Dome Control Lighting

Access Control Refrigeration

Elevators Wireless Communication
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You can configure a message protocol which then parses the received Monitoring Point string. You 
can also define header and trailer characters in the Protocol area of the General Purpose 
Interface.

Monitoring Points can also be annunciated at the monitoring station and written to the historical 
journal.

Monitoring Point Message Processing

When the General Purpose Driver receives the message from the device, it does the following:

1 Parses the message and looks for poll or action responses

• If it finds a poll or action response, it processes the response

• If it does NOT find a poll or action response, it continues to parse

2 Looks for a message protocol

• If it finds a message protocol, it processes the protocol

• If it does NOT find a message protocol, it continues to parse

Note

The device can delimit the message with or without header and trailer characters

Poll Command

The Poll Command, frequency of polling and expected response (Poll Command 
Acknowledgment) are all defined as part of the configuration of a specific General Purpose 
Device.

Poll Command Acknowledgement

Some protocols will include an acknowledge character returned to the device that issued the 
polling command - this is additional confirmation that the general purpose device received the 
command.

Output

Output is performed using an Action which is activated by an Event. The output sends a string of 
characters to the General Purpose Device through the serial/network port.

The optional expected response is also configured as part of the action.

Virtual Keyboard

As the ASCII characters between 0 and 32 are not visible on screen and have no equivalent 
keyboard button, the virtual keyboard is relied on to enter these values. Some common values are 
the STX (Start of Text) and ETX (End of Text) which have no keyboard button but can be entered 
via the virtual keyboard.
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When configuring some General Purpose Interface components, you will be required to use a 
Virtual Keyboard as not all characters are available on a standard keyboard. The keyboard 
displays on screen when  is selected.

The virtual keyboard is required when entering text into:

• General Purpose Device Editor - Device Information section to enter the Poll Command/Poll 
Command Acknowledgement

• General Purpose Protocol Editor - Protocols section to enter keywords

• General Purpose Action Message Editor - Action Message section to enter Outgoing and 
Acknowledgement messages

• General Purpose Monitoring Point Editor - Messages section to enter Acknowledgement 
message

ASCII Table Button
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General Purpose Interface
Procedure 35-1  
Entering Text Using the Virtual Keyboard

Step     Action

1 Navigate to the field where text is to be entered

2 Select . Virtual Keyboard is displayed

3 Select characters as required. Characters display in the text field

Note

ASCII table can be viewed by selecting ASCII Table

4 Select Save

- End -
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Create New Device

Third Party Devices can be created and configured within the client.

Field Description

Name Enter a unique name to identify the General 
Purpose Device.

Description Enter a description of the General Purpose Device.

Enabled Select checkbox to enable the General Purpose 
Device.

Vendor Click to select the name of the manufacturer of the 
General Purpose Device.

Poll Period (seconds) Enter the period in seconds during which victor 
attempts to poll this General Purpose Device. The 
default value is 10 seconds.

Poll Command Enter the poll command (command string) that victor 
sends to the General Purpose Device.

Open the virtual keyboard by selecting , 
allowing creation and editing of text strings.

Poll Command Acknowledgement Enter a poll command acknowledgement (the 
command string) that the General Purpose Device 
sends back to victor as acknowledgement of the poll 
message.

Open the virtual keyboard by selecting , 
allowing creation and editing of text strings.

Journal Unknown Message Select this option to record unknown messages 
received by victor in the historical journal

Serial Port Select Serial Port if you are using a serial 
connection. This is the default port type.

Network Port Select Network Port if you are using a terminal 
server for the connection.

IP Address Enter the TCP/IP address of the network port

Note

This option is only available if you select the 
Network Port option.

Communication Port Enter the port number:

• Serial Port - enter a port number such as COM1, 
COM2, etc.

• Network Port - enter the TCP/IP port number 
which the terminal uses to communicate with 
victor

Reconnection Period (secs) Enter the duration in seconds before trying to 
reconnect to an unresponsive network device.

Note

This field is only available if you select the Network 
Port option
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Procedure 35-2  
Create New Device

Step     Action

1 Select Device from the Setup tab

2 Select New. General Purpose Device editor displays

3 Enter a name for the device in the Name textbox

4 Enter a description for the device in the Description textbox

5 The Enabled checkbox is selected by default. To disable the device, deselect the 
checkbox

6 Select the vendor from the Vendor drop down menu

TimeOut Delay Time (1/10 secs) Enter the extra interval (in 1/10 seconds) that victor 
waits for a response from the device after sending a 
message to the switcher. 

If a response is not received in time, the message is 
retransmitted or communications failure declared.

Default value is 20 (2 seconds).

Comm Fail Delay Time (secs) Enter the time period (in seconds) after the TimeOut 
Delay Time expires that victor waits to declare an 
unresponsive device as failure. 

Default value is 300 seconds.

Header Character Enter a value (in decimal) to define the first 
character in a message from the General Purpose 
Device. Zero (0) indicates that any character can be 
the first character.

Default value is zero (0)

Trailer Character Enter a value (in decimal) to define the last 
character from the General Purpose Device. 

Default value is 13.

Note

1. The value cannot be zero (0). 
2. A Trailer Character is mandatory. 

Message Resend Count Enter the number of times victor should attempt to 
resend a message that the device has not 
acknowledged receiving.

Default value is zero (0).

Max Buffer Size Enter the maximum size of the buffer that stores the 
message from the device.

Default value is 2000.
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7 Enter Poll Period

Note

1. When configuring a non-zero Polling Period, non-zero values should be set for 
TimeOut Delay and Comm Fail Delay times
2. When configuring a zero Polling Period, zero should also be set for TimeOut 
Delay and Comm Fail Delay times

8 Enter the poll command in the Poll Command textbox. This is a stream of bytes, usually 
set by the device manufacturer, sent on a regular basis to the device to maintain 
communications

9 Enter Poll Command Acknowledge. This is the expected response from the device 
which is sent back to victor as acknowledgment of the poll message

10 The Journal Unknown Message checkbox is deselected by default. To enable, select the 
checkbox

Note

Enabling Journal Unknown Message means that any message received by the 
victor General Purpose server component that does not match an existing 
protocol will be sent to the activity viewer. When disabled, unknown messages are 
ignored

11 Select either Serial Port or Network Port

• If Serial Port is selected:

a Enter Communication Port

• If Network Port is selected:

a Enter IP Address

b Enter Communication Port

c Enter Reconnection Period

12 Enter TimeOut Delay Time in 1/10th seconds

13 Enter Comm Fail Delay time

14 Enter Header Character

15 Enter Trailer Character

Note

Trailer Character is mandatory. 

16 Enter Message Resend Count

17 Enter Max Buffer Size

18 Expand Alerts section

19 Select  to add an alert

20 Select Property from the drop down menu

21 Select Value from the drop down menu

22 Select  then select an Action from the Object Selector
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23 Select Save

- End -

Create New Monitoring Point

New monitoring points can be created and configured from the General Purpose Interface.

Each monitoring point supports up to five activated status properties which are assigned during 
configuration. Activation and deactivation messages associated with each monitoring point are 
drawn from the message protocol pool.

State changes occur depending on the interpreted incoming messages of the General Purpose 
Device. State changes are recorded in the journal logs and can trigger other actions in victor.

Procedure 35-3  
Create New Monitoring Point

Step     Action

1 Select Monitoring Point from the Setup tab

2 Select New. Monitoring Point Device editor displays

3 Enter a name for the monitoring point in the Name textbox

4 Enter a description for the monitoring point in the Description textbox

5 The Enabled checkbox is selected by default. To disable the device, deselect the 
checkbox

6 In the Device section, select  and use the Object Selector to select the required 
device

Field Description

Name Enter a unique name for the monitoring point.

Description Enter a description of the monitoring point.

Enabled Select to enable the monitoring point.

General Purpose Device Select the General Purpose Device to be monitored.

Acknowledgement Message Enter a message string that victor sends to the 
General Purpose Device as an acknowledgement 
message.

Journal Message 
(1-5)

Enter a meaningful word to identify the message 
logged in the historical journal by this device.

Activation Message
(1-5) Select  and use the Object Selector to select a 

General Purpose Incoming Message Protocol to 
trigger this monitoring point to activate.

Deactivation Message
(1-5) Select  and use the Object Selector to select a 

General Purpose Incoming Message Protocol to 
trigger this monitoring point to deactivate.
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7 Enter Acknowledgement Message

8 Enter a meaningful word or phrase in the Journal Message 1 textbox

9 Select  and use the Object Selector to select an Activation Message

10 Select  and use the Object Selector to select a Deactivation Message

11 Repeat steps 8-10 to add more journal, activation and deactivation messages, up to a 
maximum of 5

12 Expand the Alerts section

13 Select  to add an alert

14 Select Property from the drop down menu

15 Select Value from the drop down menu

16 Select  then select an Action from the Object Selector

17 Select Save

- End -

Add New Protocol

New general purpose protocols can be created and configured from the General Purpose 
Interface. This is the language used to communicate with the device.

Protocols are established via a dynamic process which combines match criteria, keywords and 
character positioning. Individual message protocols then get combined with monitoring points to 
identify state changes in the General Purpose Device.

Optionally, acknowledgement messages can be associated and transmitted with the monitoring 
point.

Field Description

Match Criteria
(1-5)

Select match criteria for the keyword:
Include - the system will expect the keyword to be 
included in a message from the General Purpose 
Device
Exclude - the system will not expect the keyword to 
be included in a message from the General Purpose 
Device
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Procedure 35-4  
Add New Protocol

Step     Action

1 Select Protocol from the Setup tab

2 Select New. General Purpose Protocol editor displays

3 Enter a name for the protocol in the Name textbox

4 Enter a description for the protocol in the Description textbox

5 Select Match Criteria from the drop down menu

6 Enter a Keyword

7 Enter the Position

8 Repeat steps 5-7 to add more protocols, up to a maximum of 5

9 Select Save

- End -

Keyword
(1-5)

Enter a keyword (max 50 characters) from this 
message protocol. 

Note

ASCII Hex 00 (Zero Zero) cannot be used in a 
keyword

Position 
(1-5)

Enter a position for the keyword:
Value >0 (Zero) - the software device receiver 
searches for the keyword only at this position when 
mapping a message
Value =0 (Zero) - the keyword can be at any 
position in the message (default)

Example: To find “CDE” in the string “ABCDE”, the 
Keyword value should be “CDE” and the Position 
value, “3”

Note

Spaces and unprintable characters such as carriage 
returns (<CR>) or line feeds (<LF>) must be 
counted
225



General Purpose Interface  
Create New Action Message

New action messages can be created and configured from the General Purpose Interface. Action 
messages are sent to the device as a result of events triggered in victor.

Procedure 35-5  
Create New Action Message

Step     Action

1 Select Action Message from the Setup tab

2 Select New. Action Message editor displays

3 Enter a name for the action message in the Name textbox

4 Enter a description for the action message in the Description textbox

5 Enter outgoing message text in the Outgoing Message textbox

6 Enter acknowledgement message text in the Acknowledgement Message textbox

7 Select Save

- End -

Create New General Purpose Action

New actions can be created and configured from the General Purpose Interface. Actions created 
in victor are transmitted to the General Purpose Device based on activated events in victor. 
Actions can be associated with acknowledgement messages.

Field Description

Name Enter a unique name for the action message

Description Enter a description for the action message

Outgoing Message Define a message for victor to send to the General 
Purpose Device

Acknowledgement Message Define the message sent by the General Purpose 
Device as acknowledgement that the outgoing 
message was received

Field Description

Name Enter a unique name to identify the General 
Purpose Action

Description Enter a description of the General Purpose Action
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Procedure 35-6  
Create New General Purpose Action

Step     Action

1 Select Action from the Setup tab

2 Select New. General Purpose Action editor displays

3 Enter a name for the action in the Name textbox

4 Enter a description for the action in the Description textbox

5 Select  next to General Purpose Device and use the Object Selector to select the 
device being monitored

6 Select  next to General Purpose Action Message and use the Object Selector to 
select the action message that this action triggers

7 Select Save

- End -

General Purpose Device
Select  and use the Object Selector to select the 
General Purpose Device being monitored

General Purpose Action Message
Select  and use the Object Selector to select the 
General Purpose Action Message that this action 
triggers
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Health Monitoring

Introduction

victor Health Dashboard displays the health status of all configured victor devices.

The dashboard uses color coding to indicate the health status of devices:

• Green - Normal

• Yellow - At Risk

• Orange - Pre-Failure (Also applies to failover VideoEdge NVRs not currently in 
use)

• Red - Device Alert

• Gray - Unknown State

Note

Intellex and ADHDVR recorders that do not use all analog ports display as red (Device Alert). If 
you prefer the recorders showed up as grey (unknown Alert) as opposed to red you can disable 
offline cameras via the victor camera editor.

The Health Dashboard supports the following items:

System Shutdown/Restart (VE) No Volume (Intellex) Unhealthy Disk (Intellex)

IP Address Volume Missing (VE) Disk Temperature (Intellex)

Software Version RAID Degradation (VE) Video Loss 

Online/Offline Failover (VE)

Number of Hard Drives Disk Full (HDVR)

Number of Cameras Overheating (HDVR)

Status of Cameras Volume Failed (Intellex)
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Using the Health Dashboard

The Health Dashboard can be launched from the Home tab:

The Health Dashboard will open displaying 2 panes: the device/site list pane and the device 
information pane. 

Various controls and filters are available to limit or expand device information by type, severity or 
device quantity per page. You can also expand/collapse device information and use pagination 
controls to scroll dashboard pages.

Device/Site List Pane

The Device/Site List Pane displays all health dashboard supported devices and sites, along with 
an indication of their health status. Devices which will display in the health dashboard are:

Device/Site 

Device 

List Pane

Pane
Information 

Show/Hide

Filter by 
Severity

Device type Page scroll/jump
selector

Show/Hide
filters controls

Expand/collapse
device information

Recorders Intellex

VideoEdge NVR

HDVR

ADTVR

Controllers iStar

apC
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Health status is indicated by highlighting at Object Type Level. Users can then navigate through 
the Device or Site List to display health status information for all devices. Double clicking a device 
in the Device/Site List Pane will display more detailed information in the Device Information Pane.

Device Information Pane

The Device Information Pane displays more detailed information of configured victor devices, 
including those selected from the Device/Site List Pane.

In addition, the Device Information Pane can also be used to navigate health status information of 
devices. For example, double clicking a recorder will open an interface like the one shown below:

This interface displays detailed device information as well as the health status of the device. To 
view all configured objects of a certain type, use the device category buttons.

ISC

Intrusion Devices DSC PowerSeries Panels

Bosch Receivers

Sur-Grad Receivers

Fire Devices Simplex 4100U Panels

MZX Panels

Doors iStar

apC

ISC

Elevators Kone

Otis

Thyssen Krupp

Device category buttons
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Health Mode in Maps

Health status information can be viewed on Maps. For more information, refer to Viewing Maps.
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Integration/Unification

Introduction

C·Cure Unification

You can manage C·Cure 9000 access control events through victor. Lock and unlock doors, check 
status of access control devices, and acknowledge events and alarms. In addition, you can arm 
and disarm inputs and deactivate and pulse outputs. You can see the status of all controllers and 
other access control devices both from the device list and through maps. Events can be 
acknowledged in either C·Cure 9000 client or the victor client as required and update real-time. 
C·Cure 9000 alarms display on victor maps, event viewer and in reports.

Integrations

As well as C·Cure, victor also extends Event Management support to:

• Sur-Gard Receivers - Standard Feature

• Bosch Receivers - Licensable Feature

• DSC Intrusion Panels - Standard Feature (C·Cure dependent)

• Minerva MZX Fire Panels - Standard (C·Cure dependent)

• Simplex Grinnell 4100 Fire Panels - Standard (C·Cure dependent)

Integration with third party add-ons enables victor’s device list to display C·Cure and Third party 
hardware. All objects support the victor privilege configuration and authorisation.

All actions and state changes related to integrated objects are written to victor’s journal database 
and display on the activity list. victor’s reports also support Access Control, Fire and Security 
modifications.

Alarms from integrated objects can be used to trigger victor Events.

Refer to the relevant victor integration manual for detailed information on integration, installation 
and operation instructions.
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Licensing

Sur-Gard, MZX and 4100 Integrations are standard, non-licensable features when C·Cure 
Integration is installed.

Bosch and C·Cure Integrations are licensable features.

C·Cure 9000 Event Unification requires a dealer code to enable system unification.

C·Cure Unification

Installation and Compatibility

C·Cure and victor applications may be installed on the same system and configures to use a 
shared database. Installation and unification of the applications does not require a specific order 
and each application can be uninstalled without affecting the other.

victor and C·Cure integration requires the following versions:

• victor v4.2+

• C·Cure 9000 v2.1+

For detailed installation instructions, refer to the victor/C·Cure integration manual.
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Appendix
Appendix A: Software Prerequisites

Installing Windows Prerequisite Software

There are several items that need to be installed on the client PC and site manager before we can 
effectively interact with them.

All items are available from the prerequisites folder on the Installation DVD and are installed as 
part of the normal installation process.

Alternatively items can be downloaded from their respective websites. The Microsoft® items can 
be downloaded through Windows Automatic Updates or manually from their website.

After navigating to the items on the installation DVD, you can simply double-click each in turn and 
follow the respective vendors instructions to complete the installation process.

Note

Correct drivers must be installed for the PC’s hardware. For instance, it’s extremely important to 
load the manufacturer’s driver for a video card. By not installing the correct drivers, you may get 
undesired effects and/or damage the PC and its hardware.

victor site manager

Prerequisite Size 
(Mb)

Win 7 Win 
XP

Win 8 Server 
2003

Server 
2008

Microsoft .NET Framework 3.5 SP1 231 N Y N Y Y

Microsoft Visual C++ 2010SP1 x64 5.41 Y Y Y Y Y

Microsoft Visual C++ 2010SP1 x86 4.76 Y Y Y Y Y

MSXML 6.0 SP1 1.45 N Y N Y N

SQL Server 2008 Management Objects 4.51 Y Y Y Y Y

SQL Server CE 3.5 SP1 (x64) 2.52 Y Y N Y Y

SQL Server CE 3.5 SP1 (x86) 2.25 Y Y N Y Y

SQL Server CE 3.5 SP2 (x64) 3.48 Y Y Y Y Y

SQL Server CE 3.5 SP2 (x86) 3.01 Y Y Y Y Y

SQL Server System CLR Types 1.42 Y Y Y Y Y

Windows installer 4.5 for windows 
server 2003 and xp (x64)

4.47 N Y N Y N
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Windows installer 4.5 for windows 
server 2008 (x64)

3.19 N N N N Y

Windows installer 4.5 for windows 
server 2008 (x86)

1.87 N N N N Y

Windows installer 4.5 for windows vista 
(x64)

3.19 N N N N N

Windows installer 4.5 for windows vista 
(x86)

1.87 N N N N N

Windows installer 4.5 update for 
windows xp sp3 and later (x86)

1.43 N Y N N N

SQL2008R2Expr 837 Y Y Y Y Y

Microsoft Database Providers v3.1 (x86) 1.32 Y Y Y Y Y

Microsoft Provider Services v2.1 (x86) 1.84 Y Y Y Y Y

Microsoft Synchronization-v2.1 (x86) 0.9 Y Y Y Y Y

Microsoft Database Providers v3.1 (x64) 1.51 Y Y Y Y Y

Microsoft Provider Services v2.1 (x64) 2.4 Y Y Y Y Y

Microsoft Synchronization-v2.1 (x64) 1.1 Y Y Y Y Y

Microsoft .Net Framework 4.0 Full 
(+dependencies)

48.1 Y Y N Y Y

Windows Installer 3.1 (x86) 2.46 N Y N Y N

Windows Installer 3.1 for Windows 
Server 2003 SP1 (IA64)

5.68 N N N Y N

Windows Installer 3.1 for Windows 
Server 2003 SP1 (x64)

4.37 N N N Y N

Windows Installer 3.1 for Windows 
Server 2003 SP1 (x86)

1.46 N N N Y N

Windows Installer 3.1 for Windows XP 
(x64)

4.37 N Y N N N

Windows Imaging Component (x64) 1.82 N Y N Y N

Windows Imaging Component (x86) 1.16 N Y N Y N

Microsoft Windows PowerShell V1.0 x86 1.61 N Y N N N

Tyco Update Server 1.59 Y Y Y Y Y

Total 
(MB)

899.8
6

1148.
02

870.2
5

1153.73 1135.9
2

victor client

Prerequisite Size 
(Mb)

Win 7 Win XP Win 8 Server 
2003

Server 
2008

DirectX10_Feb2010_Redist 107 Y Y Y Y Y

IMAPI_v2.0_x64 1.21 N Y N Y N

IMAPI_v2.0_x86_CHS 0.75 N Y N N N

IMAPI_v2.0_x86_DEU 0.75 N Y N N N

IMAPI_v2.0_x86_ENU 0.75 N Y N N N

IMAPI_v2.0_x86_ESN 0.75 N Y N N N

IMAPI_v2.0_x86_FRA 0.75 N Y N N N

IMAPI_v2.0_x86_PTB 0.75 N Y N N N

IMAPI_v2.0_x86_NLD 0.75 N Y N N N

IMAPI_v2.0_x86_KOR 0.75 N Y N N N
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IMAPI_v2.0_x86_JPN 0.75 N Y N N N

IMAPI_XP_SRV2003_x86 1.26 N Y N Y N

Microsoft .NET Framework 3.5 SP1 231 N Y N Y Y

Microsoft C++ Runtime V8.0 Sp1 2.92 Y Y Y Y Y

Microsoft C++ Runtime V9.0 Sp1 4.02 Y Y N Y Y

MSXML 6.0 SP1 1.45 N Y N Y N

VS90_PIAREDIST 1.35 Y Y Y Y Y

Microsoft .Net Framework 4.0 Full 
(+dependencies)

48.1 Y Y N Y Y

Windows Installer 3.1 (x86) 2.46 N Y N Y N

Windows Installer 3.1 for Windows 
Server 2003 SP1 (IA64)

5.68 N N N Y N

Windows Installer 3.1 for Windows 
Server 2003 SP1 (x64)

4.37 N N N Y N

Windows Installer 3.1 for Windows 
Server 2003 SP1 (x86)

1.46 N N N Y N

Windows Installer 3.1 for Windows 
XP (x64)

4.37 N Y N N N

Windows Imaging Component (x64) 1.82 N Y N Y N

Windows Imaging Component (x86) 1.16 N Y N Y N

IMAPI_v2.0_x86_POL 0.75 N Y N N N

IMAPI_v2.0_x86_CHT 0.75 N Y N N N

IMAPI_v2.0_x86_CZ 0.75 N Y N N N

IMAPI_v2.0_x86_SWE 0.75 N Y N N N

IMAPI_v2.0_x86_HUN 0.75 N Y N N N

IMAPI_v2.0_x86_ITA 0.75 N Y N N N

IMAPI_v2.0_x86_ARA 0.75 N Y N N N

IMAPI_v2.0_x86_DAN 0.75 N Y N N N

IMAPI_v2.0_x86_TRK 0.75 N Y N N N

dotNetFx40LP_Full_x86_x64ar.exe 3.49 N N N N N

dotNetFx40LP_Full_x86_x64cs.exe 3.17 N N N N N

dotNetFx40LP_Full_x86_x64da.exe 3.13 N N N N N

dotNetFx40LP_Full_x86_x64de.exe 7.06 N N N N N

dotNetFx40LP_Full_x86_x64es.exe 6.76 N N N N N

dotNetFx40LP_Full_x86_x64fr.exe 5.27 N N N N N

dotNetFx40LP_Full_x86_x64hu.exe 3.20 N N N N N

dotNetFx40LP_Full_x86_x64it.exe 3.13 N N N N N

dotNetFx40LP_Full_x86_x64ja.exe 4.14 N N N N N

dotNetFx40LP_Full_x86_x64ko.exe 3.08 N N N N N

dotNetFx40LP_Full_x86_x64nl.exe 3.16 N N N N N

dotNetFx40LP_Full_x86_x64pl.exe 3.19 N N N N N

dotNetFx40LP_Full_x86_x64pt-
BR.exe 

3.14 N N N N N

dotNetFx40LP_Full_x86_x64sv.exe 3.12 N N N N N

dotNetFx40LP_Full_x86_x64tr.exe 3.13 N N N N N
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dotNetFx40LP_Full_x86_x64zh-
Hans.exe 

3.08 N N N N N

dotNetFx40LP_Full_x86_x64zh-
Hant.exe 

3.05 N N N N N

Tyco Update Client 1.97 Y Y Y Y Y

 Total 
(MB)

173.6
7

430.4 350 425.54 404.67
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Appendix
Verifying Successful Installation of Prerequisite Software

After installing the prerequisite software, you can verify if the software has been installed correctly. 
This procedure should be carried out on the victor unified client PC as well as the victor site 
manager PC to ensure the relevant prerequisites are installed on both.

Procedure 38-1  
Verifying Successful Installation of Prerequisite Software

Step    Action

1 Select Start on the Windows Taskbar. 

2 Select Control Panel. Control Panel displays.

3 Select Classic View if not already displayed.

4 Select Programs. 

5 Select Programs and Features. All the programs that are currently installed on the client 
PC are displayed.

6 Check that each of the prerequisites appear on the list.

- End -

28Aug2013
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